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Introduction

EPiServer Commerce comes with a sample site including a complete set of page templates containing all the nec-

essary functions for setting up a website with an online store. The purpose with the sample site is to exemplify and

illustrate the code behind the templates, and to provide inspiration when building your own e-commerce solution.

The Commerce Manager module is closely integrated with EPiServer CMS. Editors and store administrators can

work with the content as well as managing the online store administration using the same interface for easy access.

The EPiServer OnlineCenter provides the overall frame for accessing the entire website and other systems inte-

grated, as well as the personalized dashboard for each user.

EPiServer Commerce Platform

The foundation of the EPiServer Commerce platform is EPiServer CMS for web publishing, and the Commerce

Managermodule for web store management with functionality for managing customers, products and orders. Cus-

tomers can register an account on the website and manage their account details, as well as create their own per-

sonal wish lists. When a shopper is ready to finalize a purchase, the Commerce Manager will provide functionality

for handling the checkout procedure with shipping and payment options and order confirmation.

Graphical Profile

The graphical profile controls the layout and appearance of the website. The graphical profile consists of predefined

fonts, colors etc. saved in a Cascading Style Sheet (CSS). The graphical profile is customized by a developer.
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Functions and Page Templates

The functionality of the web is controlled by page templates. These are linked to page types, in which the editor

enters the content of the web page. The functionality in the page template decides what will happen with the con-

tent and how it will be displayed. Page templates are built and customized by a developer. With customized page

templates the various products and shopping activities can be displayed on the website, with information collected

from the Commerce Manager module.

Access Rights

Access rights control what editors and administrators can do and what visitors to the website can see. Access

rights in an integrated EPiServer Commerce site are managed from the EPiServer CMS Admin and Edit mode, as well

as from the Commerce Manager administration interface, depending on area of permissions.

Editorial Content

Editors enter information into the page types, and the information is then stored in the database. Many of the EPiS-

erver Commerce templates contain few editor fields, since they are only used for display and most of the func-

tionality is built into the page templates.

Store Administration

The online store is administered through the Commerce Manager user interface. Store administrators can easily

access all the online store functions including customer, product and order management, as well as system con-

figuration.

Terminology

In this section we will describe some of the specific terms used in e-commerce and EPiServer Commerce.

Editorial Content

With editorial content we mean content that is created from inside the EPiServer CMS Edit mode, such as articles,

news or other information pages. Compare this to content that is displayed as pages on the website, but where the

content itself is data fetched from Commerce Manager. This type of data cannot be only be edited in Commerce

Manager.

Modes

You will work with EPiServer Commerce in different modes.

Viewmode

What will be displayed to visitors of the website.

Edit mode

Editors will work in the EPiServer CMS edit mode when creating and editing EPiServer CMS content pages of the

website.
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Admin mode

System administrators will work in the EPiServer CMS administration mode to modify system settings and access

rights.

Commerce Manager interface

Store administrators will access the Commerce Manager interface to manage online store data and activities. The

Commerce Manager interface can be reached either from inside the EPiServer OnlineCenter, or directly from View

mode when right-clicking in a page.

Roles

EPiServer Commerce has a number of different roles that are active in the editorial and online store management

activities. These are described further in the following.

Visitor

A visitor is someone using a web browser to visit the website and use available functions and services. A visitor can

register an account and become a customer when purchasing a product. Customers can update information related

to their personal account. In EPiServer Commerce, visitors use the same login procedure to the website as site

administrators, without getting access to the back-end functions.

Editor

The editor will work with website content from the EPiServer CMS Edit mode. Working with content here means

create editorial content such as news, company related information, or articles on different subjects.

Store Administrator

The store administrator works in the Commerce Manager interface, with information related to customers, orders

and products. Store administrators may also work with configuration of the Commerce Manager system settings.

SystemAdministrator

The system administrator works with the administration of the entire EPiServer Commerce platform. This is done

from the EPiServer CMS administration mode and involves setting access rights for pages, website language man-

agement and other tasks.

Commerce Manager roles

The Commerce Manager module has its own set of user roles covering the different tasks that store administrators

work with. These roles are described further in the Commerce Manager section under Customer Management.

Commerce Manager Glossary

Application Configuration

l Shipping Gateways - Under Shipping Providers, a shipping gateway is the specific class that you select

(Generic Gateway or Weight/Jurisdiction Gateway).
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l Shipping Jurisdictions - an option which allows you to define values for region-specific shipping rates;

this is only used when you select the Weight/Jurisdiction Gateway (i.e. California).

l Shipping Jurisdiction Groups - group of jurisdictions; this is required because this is a required field

when configuring the Shipping Method parameters (i.e. Southwest region).

l Shipping Method - A shipping method manages a set of information and rules that determines the ship-

ping cost and displays it on the front-end public site while a customer checks out an item from his/her shop-

ping basket. The shipping fee is added to the total price of the purchase. A shipping method is mapped to a

shipping provider visible to a back-end administrator in Commerce Manager. This allows the public site to

display friendly names such as "Ground Shipping" to the customer and this is mapped to a provider such as

UPS. Therefore, when a customer picks "Ground Shipping," he/she will be using UPS.

l Shipping Providers - A shipping provider is the class(es) that interacts directly with one or more actual

shipping services such as USPS, UPS, or FedEX. It retrieves shipping price information from the shipping

service(s) its associated with. One typical scenario would be to have a provider that represents a particular

service (e.g. USPS). A provider can also represent a particular type of shipping situation. One example is

that you could have a provider for overnight delivery. The provider could retrieve pricing for that service

to determine the lowest price given the location of the customer. A provider could also represent other

specific scenarios with one or more services such as price by weight or ground shipping.

Business Foundation

l Business Foundation Object (BF Object) - Similar to a meta class; allows end users to create custom

objects with UI presentation, business objects, and a database layer without modify code.

l Bridge - A "many to many" or N:N relationship between two business objects.

l Extension - this allows you to extend an existing meta class with extra properties. For example, you can

have a download class and you can extend it with "imagedownload" which contains width and height as extra

parameters.

l Field Type - The type of data that the data field supports. There are multiple types included with Com-

merce Manager out of the box:

l Boolean

l Currency

l DateTime

l Dictionary items

l File

l Guid

l Integer

l Referenced Field (read-only)

l String

l 1 to Many Relationship - 1 object can be associated or related with multiple object-related data. For

example, one organization can be associated with multiple contracts.

l Many to 1 Relationship - Multiple object-related data can be associated or related with a single object.

For example, multiple contacts can be related to a single organization.

l Many to Many Relationship - Multiple object-related data can be associated or related with multiple

objects. For example, different SKUS can be associated with one or more Warehouses for tracking and

storage.
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Catalog Management

l Assets - downloadable contents such as documents, links, videos, and images that can be linked to specific

products.

l Associations - one or more products can be related to or associated to another product so that these

associated products can be displayed or advertised on the public site as a product accessory, or as an upsell-

ing/cross-selling item. Associations can be made from any of the individual products (Product Entries, SKUs,

Bundles, Packages, and Dynamic Packages).

l Catalog - a catalog is a top-level container for all catalog entries such as Categories, Products and SKUs.

l Category - a category is a grouping of purchasable products.

l Node - a node is the same thing as a category.

l Product - a product represents various forms of merchandise that you can display and purchase

from the public site, including Products, Variations/SKUs, Bundles, Packages and Dynamic Packages.

l Product Entry - a product entry typically contains a product name, part number, description and

images.

l Variation/SKU - a variation or SKU corresponds to a specific type of product with specific char-

acteristics. For example, a product of Shirts will have an individual variation/SKU which includes

size, color and sleeve length.

l Bundle - a bundle is a collection of variations and SKUs allowing customers to purchase two or

more items at once.

l Package - a package is comparable to an individual SKU because the package item must be pur-

chased as a whole (i.e. computer system).

l Dynamic Package - a dynamic package is similar to the package definition above with the added

ability to configure the package during checkout.

l Tax Category - this separation of taxes by category allows you to charge a different rate of taxes depend-

ing on what is being purchased; for example, you can have one rate for "General Sales" items and another

rate for "Luxury Sales" items.

Customer Management

l Account - a user account that can be created under a Contact. Once an Account has been created, the Con-

tact can be assigned Roles and access the Commerce Manager. A user account is automatically created for a

user who registers from the front-end public website which allows a customer to login prior to checking

out. They default to the "Everyone" and "Registered" roles and permissions.

l Contacts - these are users that are created either when an external customer registers on the public site

or when a Commerce Manager admin creates them directly from the Commerce Manager; typically, users

that are internal to your organization are assigned to organizations or organization units and assigned var-

ying ?permissions based on role. For example, a user with the "Cms Admins" role will have full access to

only the Content Management system. By default, new users that are created by registering from the public

site are given the "Registered" and "Everyone" roles.

l Organizations (or organization units) - groups or sub-groups of registered users and customers. An

organizational unit is a "child" or subsidiary of a "parent" organization. Within Commerce Manager, you can

assign an organization as a parent of another organization. For example, the parent company Company X,

and the organizational units are Company XWest and Company X East. Organization units include regional

branches or departments or you could name them by business categories such as "Computer and Elec-

tronics" or "Clothing and Accessories." Organizations can be structured into a tree structure with sub-
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units with different levels of permissions assigned to each. So for example, you can set up your company as

a parent level organization while your departments such as Sales & Marketing, IT/Development, and Oper-

ations as organization units. With this scenario, you can allow users in each departments to have access to

only relevant subsystems, screens and functionality within Commerce Manager.

l Roles - these control the level of access privileges of each user account in Commerce Manager. Users can

be either granted or restricted access to an entire subsystem or a particular menu item within a subsystem

based on the role assigned to them. Different roles may be added to user accounts (i.g., store operator or

webmaster) so that they can access, edit, or process relevant information. By default, a customer who reg-

istered his/her account to make a purchase in the front-end site will have no roles assigned to them, hence

giving him/her preventing access to both the editing feature of the front-end site as well as the back-end

Commerce Manager.

Marketing

l Campaigns - a way to organize marketing activities. Campaigns must be associated with Promotions in

order to provide customer discounts. Optionally, Campaigns can also be tied to Customer Segments for tar-

geted marketing purposes.

l For example, you can create a seasonal campaign that will include different Promotions targeted for

the Spring season.

l Customer Segments - these determine the target audience for the Promotions. Customer Segments

determine the target audience for the Promotions. Within a Campaign, all Promotions will be applied to

whatever Customer Segments associated with the same Campaign. Members of the Customer Segments can

be pre-defined in static groups or you can use the Expressions Engine to create dynamic groups whenever

Promotions are run.

l For example, you can have a Customer Segment that targets all users from the Los Angeles area.

You can create an Expression that will include all the customers whose home city is Los Angeles.

Thus, when a user registers on the site he immediately becomes part of the target Customer Seg-

ment.

l Expressions - these are customizable Conditions which allow users to extend different aspects of the Mar-

keting system -- Promotions, Customer Segments and Policies all rely on Expressions. There is an Expres-

sions Engine which is a core technology behind the Marketing system.

l For example, you want to set a Promotion for "40% off Item X." The Expression or Condition to

enable this Promotion would include: Catalog ID for Item X and Reward of 40%.

l Policies - rules that are always executed when Promotions are applied. This allows a Marketing manager to

declare rules just once for the whole site.

l An example of a rule is as follows: Do not allow negative orders.

l Promotions - a way to apply various discounts to the products, order totals or shipping. A Promotion is a

marketing tool used to increase sales of certain products or product lines. Various incentives such as low-

ered pricing and other discounts can be employed as part of a Promotion.

l Promotions are always tied to Campaigns.

l Promotions can be classified into two types: 1) either you can create a Promotion that is visible

prior to checkout or 2) you can configure the Promotion to be displayed during the checkout proc-

ess.

l The most powerful aspect of the Marketing system is the Expression Engine which allows variable

conditions to be applied when creating a Promotion. These conditions vary from the number of

items, the percentage discount, shipping rates and many others.
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Order Management

l Browsing and Creating Purchase Orders

l Purchase Orders - the manual method of generating an order for a customer (rather than having

the customer checkout and complete an order from the front-end website). It allows Commerce

Manager users to generate orders directly from the Commerce Manager.

l Status - set to "NewOrder," "Submitted," "Processing," "Cancelled," "Rejected," "Shipped"

l Currency - select a Currency type from the drop-down menu

l Customer - select a Customer from the drop-down list of Contacts

l Billing Address - select a Billing Address from the drop-down menu

l Affiliate - select an Affiliate from the drop-down list. (Affiliates can be used when integrating with

other systems and can only be edited in the database. Users do not have Commerce Manager access

for managing Affiliates).

l Tracking Number - enter in a Tracking Number of the shipment

l Expiration Date - enter in a Expiration Date for the order if this order is tied to a Recurring Pay-

ment Plan for subscription-based transactions

l Parent Order Id - this can be used to relate Purchase Orders to a payment plan or other order.

When creating a Purchase Order from a Recurring Payment Plan, the Parent Order ID is auto-

matically associated with the Payment Plan ID.

l Line Items - you can associate actual Products/SKUs/Packages/Bundles to orders or Purchase

Orders

l ID - it is automatically generated

l Display Name - this can be edited and changed

l List Price - enter in the price that will appear for the item

l Discount - enter is the Discount value that will subtract from the List Price

l Shipping Address - This is automatically generated if a Shipping Address has already been

associated with the Purchase Order

l Shipping Method - This is automatically generated if a Shipping Address has already been

associated with the Purchase Order

l Creating a Recurring Payment Plan

l Recurring Payment Plans - payments that are initiated by the Commerce Manager on a regular

cycle (i.e. applicable in a subscription-based scenario)

l Plan Cycle - this determines the period of time that a payment plan will be initiated. Options

include: "No Cycle," "Daily Cycle," "Weekly Cycle," "Monthly Cycle," "Yearly Cycle."

l Cycle Length - If Cycle Length = 1, then this payment plan will be initiated once a month. If Cycle

Length = 2, then this payment plan would be initiated once every 2 months.

l Max Cycle - the maximum number of cycles that this payment plan will be initiated

l Completed Cycles - this value displays the number of times that this payment plan has been ini-

tiated

Reporting

l Best Sellers Report this report is used to determine which products sold the most in terms of quantity

and total revenue over a period of time
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l Low Stock Report - this report is used to determine which products are running low in inventory. If a

product's inventory is less than its reorder minimum quantity, it will be included in this report.

l Sales Report - this report provides an overview of a site's sales performance over a period of time

l Shipping Report - this report provides the shipping method, number of orders and total shipping cost

over a period of time

Prerequisites

This documentation is intended for website editors, and store and system administrators. The documentation

describes a standard installation based on EPiServer CMS and the demo template package of EPiServer Com-

merce. Please be aware that your specific system may differ from what is described here, since your website is

most likely customized and may be integrated with additional products.

In order for EPiServer Commerce to work properly, it is essential that you are using the specific language

culture setting "UI Culture" (ASP.NET) on your website (i.e. "en-US", e"en-GB", "nl-BE" etc.). This is cru-

cial in order for the different languages to display correctly on the site. Make sure this is set up correctly

from the start to avoid problems later on. Find out more about this topic in the Globalization section.

In this documentation you will learn about specific functions and features of the EPiServer Commerce sample site

and templates. Prior knowledge of EPiServer CMS and e-commerce procedures is required to fully understand what

is described. To find out more about other EPiServer products such as EPiServer CMS, please refer to the doc-

umentation for each specific product available on world.episerver.com.
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Getting Started

In the following sections we will describe how you can access and log on to an EPiServer Commerce website. Note

that the logon procedures may be slightly different from what is described here, depending on how your website

and infrastructure is set up.

Getting started contains the following parts:

l Logging on to the website

l Accessing the different modes

l Navigation

l Working procedures

Logging On

To access the website, open a web browser and enter the address of the website. There are different ways of log-

ging on to an EPiServer Commerce site. Often you add a path such as "epi/ui/edit" or "epi/ui/admin" to the URL of

your website, or there might be a login link as in this case.

On the EPiServer Commerce sample site, clicking on Log in in the top menu will take you to the login page of the

website. Enter your user name and password, and click Log In. Note that this login page is the same for both cus-

tomers logging on to their account, as well as for web editors and store administrators logging on to work with

content or administer the online store parts. What you are allowed to do after logging on to the website depends

on your access rights.
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Accessing the Different Modes

When you are logged on to your EPiServer Commerce website, right-clicking

on a page will display a menu with a number of options. What you see here

depends on your access rights, in this documentation we assume that you have

full permission to the different parts.

As for any EPiServer CMS based site, you will be able to access the Edit and

Admin mode, as well as the Dashboard of the EPiServer OnlineCenter. In addi-

tion to this, you will also have and option to access the Commerce Manager

module of EPiServer Commerce. Choosing this option will take you directly to

the Commerce Manager administration interface. Selecting the Edit or Admin

mode will take you to the EPiServer CMS editor or administration interface.

If you want to work with online store administration, you select Commerce

Managerin the right-click menu. Note that you might be prompted to log on

once more to access Commerce Manager. If you want to work with editorial

content of the site, you select Edit Mode . Choose Admin Mode to work

with website access rights, or system administration for the entire website.

Select the Dashboard option to access your personal website dashboard, for a quick overview of the different

website activities. For the other options available, please refer to the EPiServer CMS user documentation.

Logging on to Commerce Manager

You can access Commerce Manager through right-clicking in View mode after logging on to the website, and then

select Commerce Manager in the right-click menu. You can also select Commerce in the top menu when you

are in the EPiServer Online Center or from the EPiServer CMS Edit mode.

You may be required to provide your logon credentials once more when accessing the Commerce Man-

ager module. When you log on you will be taken to the Commerce Manager Dashboard Home page.

Navigation

EPiServer Commerce has an intuitive navigation. When logged on to EPiServer Commerce, use the right-click menu

to go directly to the Commerce Manager interface to work with web store back-end procedures. Or, choose the

EPiServer CMS Edit or Admin mode to work with content management or system administrative tasks. See also

Accessing the different modes in this documentation.

Navigating in Commerce Manager

Commerce Manager is modeled for familiarity for the user. Those who have used Microsoft Outlook will see some

similarities with the user interface.

1. Once you first login to Commerce Manager, you are directed to the Dashboard Home.

2. The Dashboard has Controls showing various information, including Alerts, News & Announcements,

Help, and a Summary.

3. More Controls can be added by clicking on Add.
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4. On the left is the Left Menu or Navigation iframe where users can switch between Commerce Manager sys-

tems and navigate folder trees of options.

5. On the top-right, you can see your Login Name, Product Version, and installed License.

6. By clicking on the top-left header, you will be directed back to the front-end site.

7. On the menu bar below header, there are additional options available to the user.

By clicking Welcome, you can adjust your Settings , Sign In As a Different User, or Sign Out of Commerce

Manager. You can also change the language used to a different one if your Commerce Manager is configured for mul-

tiple languages.

By clicking About , you can Send Feedback using a form, get information on the Database Schema for support

purposes, and open up our Online Help repository.

On the right side of the menu bar, you can click on Get Help For this Page to access the online help for EPiS-

erver Commerce.

Right next to the Get Help For This Page button is an Up-Down Arrow, which allows you to hide or unhide the

header above the menu bar to save screen space.

Customizing the Dashboard and Navigating the Left Menu Frame

The Dashboard Controls can be collapsed, rearranged, and closed by clicking on the Arrow button, clicking on the

X button, and click-dragging the title bar, respectively.

There are tabs below the left navigation frame that corresponding to a specific system of the Commerce Manager.

Clicking on each button results in a change of the top side menu.

A common navigational model is the hierarchical folder/node structure. For instance, under Content Management,

there is a MyWork and Sites folder. Click on the + node to expand the root folder and subsequent subfolders.

Click on a folder or icon directly to access its contents. If changes are made to the tree structure, such as additional

Folders or Menus under the Sites folder, you can click on the Refresh icon on the top right corner to update those

changes within that frame.

Some systems, such as Customer Management, do not have collapsable nodes. Instead, you click directly on the

menu options to access its contents.

Working Procedures

Working with EPiServer Commerce involves different tasks and roles using different parts of the system.

Commerce Manager

Web shop administrators will access the Commerce Manager module and its sub-systems to manage online store

procedures such as customer and order management, and payment and shipping procedures. This is also from

where the product data configuration and product catalog import is managed. The Commerce Manager also has a

dashboard which is displayed when you first log in. Furthermore, the Commerce Manager module has its own

access right settings for user roles working with online store administration. In the following you will find a high-

level categorization of the most common tasks for users including business managers, marketing staff and IT pro-

fessionals.
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General Configuration

Application Configuration includes various configuration tasks such as setting up Shipping and Payment Gate-

ways, your default language, currency, units, tax configuration, licensing, and search settings. Most of these con-

figuration tasks are performed in the Commerce Manager Administration area.

Users and Customers

Users and customers are managed by the Customer Management system. Users are internal to your organ-

ization and should not be confused with customers, partners and organizations. Generally, only your team of inter-

nal users will have access to the Commerce Manager and depending on their role will have varying access to the

systems and menu items within each system. Each Commerce Manager user has certain permissions as defined by

their user Role of group.

Catalogs and Product Entries

An Commerce Manager front-end site allows customers to shop for products. Products are arranged into a par-

ticular catalog. Catalogs are independent from one another and you may create as many catalogs as you need. Cat-

alogs can be structured in a number of ways and organized into Categories, Products, SKUs, Bundles, Packages and

Dynamic Packages.

The Catalog Management system provides users with the ability to manage catalogs, product categories and

products. A default B2C Sample Site along with a default electronics catalog (consisting of a Brands catalog + Every-

thing catalog) is included giving you a running demo site after you run the installer.

Online Orders, Purchase Orders and Shopping Carts

The Order Management system is where you can monitor, track, change or create New Orders, Pending Orders

or Failed Orders. Orders are highly flexible, giving internal Commerce Manager users the ability to create Purchase

Orders with various options including split Payments and split shipping addresses. In addition, Pending Sales can be

viewed by each customer's shopping cart. Recurring Payment Plans can also be monitored.

Marketing and Promotions

One area handled by the Marketing system is Promotions. A Promotion is a marketing tool used to increase sales

of certain products or product lines. Various incentives such as lowered pricing and other discounts can be

employed as part of a Promotion.

Promotions can be classified into two types: either you can create a promotion that is visible prior to checkout or

you can configure the promotion to be displayed during the checkout process. The most powerful aspect of the

Marketing system is the Workflow Engine which allows variable conditions to be applied when creating a Pro-

motion. These conditions vary from the number of items, the percentage discount, shipping rates and many others.

Marketers have the ability to target specific customer segments by region, individual customers or customer

groups.

Assets andWeb Files

The Asset Management system allows for Assets including images, mp3s, pdfs, software packages and other

downloadable files to be centrally stored, displayed on either the public site or the Commerce Manager site and ulti-

mately to be shared or purchased.
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EPiServer CMS Edit mode

Web editors will work inside the EPiServer CMS editorial interface to update content of web pages. The EPiServer

Commerce page types in the sample site do not require much editorial work, since most of these are only for dis-

play purposes fetching data fromelsewhere. Some editorial effort will be needed on content pages such as news list-

ings, privacy and shopping policies and similar.

EPiServer CMS Admin mode

The EPiServer administration interface is where you will manage the administrative tasks for the website. These

may involve working with access rights for EPiServer CMS web pages, configuration of page types, management of

scheduled jobs, and globalization settings.

EPiServer OnlineCenter

All users including business and website owners, can use EPiServer OnlineCenter to get an overview of the web-

site and activities of interest. Through the usage of customized gadgets on the personalized dashboard, you can

create your own website workspace. The OnlineCenter also has a global search function where you can search for

topics in both pages and files on the entire website.
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User Access and Roles

By default, EPiServer Commerce uses a customized role and membership provider where groups and users are

stored in the Commerce Manager database. The information is then shared between EPiServer CMS and Commerce

Manager. This means that the same users and groups will be available from the EPiServer CMS Admin mode as in

Commerce Manager. Both website administrators and customers registering on the e-commerce site will managed

by the same provider and the user account information will be saved in the same place.

Most of the user and group/role management for the e-commerce website will be done from Commerce Manager.

This includes managing user accounts and adding roles to users (contacts). Only when you need to set access rights

for editorial content management of the website, will this be done from the EPiServer CMS Admin mode.

Access Rights in Commerce Manager

In Commerce Manager, users (contacts) and roles are managed in the Customer Management part of the system.

EPiServer Commerce is built with flexibility in mind for structuring internal teams and departments as well as exter-

nal organizations, partners and customers. The Customer Management system allows for creating users and groups

with either pre-configured Roles or custom Roles which control access to different systems or individual ele-

ments within a system.

When you install EPiServer Commerce, you are provided with an administration account. This account is given

full privileges, meaning it is full access to all systems and all elements within each system. Additional accounts used

by your internal team to access Commerce Manager must have one or more Roles assigned to them. A role can be

for instance "Catalog Viewers", "Marketing Admins" or "Asset Managers".
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Commerce Manager users are internal to your organization and should not be confused with customers.

By default, customers who register from your public site are given the "Everyone" and "Registered" Roles,

but these roles do not allow access to Commerce Manager.

The specific roles used in Commerce Manager are described more in the Roles and Permissions section.

Access Rights in EPiServer CMS

In the EPiServer CMS Admin mode, you will be able to view all users and user groups under Search User/Groups.

Setting access rights for editorial content and the page tree structure is done from the Set access rights section,

just as you normally do in EPiServer CMS. Please refer to the EPiServer CMS administration documentation on

world.episerver.com, for more information on how to work with access rights for editorial content.

As with any EPiServer CMS website, you can work with role and membership providers fromWindows or SQL, or

both using the multiplexing setting. You can also build your own user and membership provider to be used with

EPiServer Commerce. Find out more about membership and role provide management in the technical doc-

umentation for EPiServer CMS on world.episerver.com.
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Globalization

With "globalization" we mean the possibility to display content in different languages to website visitor groups

with different language preferences. When a visitor to the website selects a language option, the content for that

language will be displayed. If content doesn't exist in a selected language, a fallback procedure may be applied if this

has been configured. Find out more about globalization and language management in the documentation for EPiS-

erver CMS on world.episerver.com

Globalization also means the possibility to select different language options for the user interface inside EPiServer

Commerce.

To set the user interface language for EPiServer CMS, click your user profile name in the upper right corner.

Select My Settings and then the Display Options tab. Select the language of your choice in the list, and click

Save. Note that you may need to refresh the browser window for the changes to apply.

To set the user interface language in Commerce Manager, select Change Language in the upper menu of Com-

merce Manager. Choose the language of your choice in the list and click OK to save you changes.
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For editorial content created in EPiServer CMS, you will apply the language management options available in EPiS-

erver CMS Edit mode, to create pages in different languages. For products in the product catalog, the language infor-

mation is set in the product database. EPiServer Commerce will display the product information in the language

selected by the website visitor.

Specific Language Settings

In EPiServer CMS there are three different language concepts, two which are defined by ASP.NET (Culture and UI

 Culture), and one which is the EPiServer content language. The ASP.NET Culture is referred to as "System Lan-

guage", and UI Culture as "User Interface Language". A typical culture is "en-US" which defines the language as English

(en) with the culturally defined specifics for United States (US).

In EPiServer Commerce, "UI Culture" is used and "English (United States)" is the default language used by

the system. This is due to the Commerce Manager database which uses "UI culture" in the matching. In

order for EPiServer Commerce to work properly, it is therefore essential that you are using the "UI Cul-

ture" setting on your website to make the different languages display correctly.

Make sure this is set up right from the start to avoid problems later on. It is important that users do not create EPiS-

erver CMS pages using the "wrong" language type, since changing the page language later on is somewhat difficult. It

is recommended that only "UI Culture" languages, i.e. "en-US", "en-GB", "nl-BE" etc., are enabled on the website.

Available languages for CMS pages are enabled from the EPiServer CMS Admin mode under Config and Manage

Website Languages.
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Languages for Product Catalogs

Languages for the content of a product catalog is set when you create the product catalog. Find out more about this

under Create a Catalog in the Catalog Managemnt section.
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File Management

In EPiServer Commerce, files can be stored both in the File Manager of EPiServer, and in the folder structure

under Asset Management in the Commerce Manager module.

Files such as images and documents, that are used in the editorial parts of the e-commerce website, are stored in

the File Manager of EPiServer CMS, just as for any other EPiServer CMS site. With editorial content, we hereby

mean web pages with content that is created from the EPiServer CMS Edit mode. For instance, this could be a news

section with news items, or articles related to products on the e-commerce website.

The Asset Management folder structure is intended for storing documents related to products in the product cat-

alog. This can be for instance user guides, software downloads or product sheets. Each asset file can then be

related to a product in the product catalog.
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To find out more about file management in EPiServer CMS; please refer to the EPiServer CMS user documentation.

For more information about Asset management, please refer to the Asset Management section.
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Commerce Manager

This section explains how end users can administer the EPiServer Commerce site by logging into the back-end Com-

merce Manager module. Commerce Manager includes the these sub-systems which are described in the following:

l Application Configuration

l Catalog Management

l Business Foundation

l Asset Management

l Customer Management

l Dashboard

l Marketing

l Order Management

l Reporting

Application Configuration

Application configuration includes various configuration tasks such as setting up shipping and payment gateways,

your default language, currency, units, tax configuration, licensing, and search settings. Often, these settings are not

configured by business users. Most of these configuration tasks are performed in the Commerce Manager Admin-

istration area.

System Configuration

Most of the application configuration information is stored in the database. These settings can be edited through

the Commerce Manager. In most cases, you will not need to restart the web applications and the changes should

be effective immediately.

Indexing Your New or Edited Catalog

In order to see products in a new catalog or changes to an existing catalog, you will need to index your catalog to

reflect those changes in your search results.

There are two types of indexing -- Build and Rebuild. Use Build to make a quick re- indexing of an existing catalog

where you made changes to existing products. Build is shorter than a Rebuild because it performs a reindexing of

only the items that were changed since the last Build.

If you are using a brand new catalog or you made structural changes to your existing catalog (i.e. moving categories

around, changing a product name, etc.), then you will need to perform a Rebuild. Rebuild takes longer because it

does a complete indexing.

To Build or Rebuild your catalog, go to Administration > System Settings > Search Index.

Once you perform either of these 2 operations, you will see the changes or additions reflected in your search

results.

If you have the Quartz service installed (this can be installed automatically during the SDK install), then your catalog

is reindexed every 5 minutes or whatever time interval you decide upon.



© EPiServer AB

30 | User's Guide for EPiServer Commerce 1.0

Customizing Left Menu

Prior to customizing your left menu, we advise you to read the publication section of Business Foundation to con-

figure Business Objects as individual nodes in the left navigation frame.

Adding a Left Menu Item from the Left Menu Page

To add a Left Menu item, you have two choices. You can either configure the entire menu item first within Busi-

ness Foundation or you can add an empty container by clicking the Add button and then go back to Business Foun-

dation to fill in the page contents (objects).

A new window will pop up for publication settings.

1. Select a Display Region from the navigation three on the left. Click on the node you want Contract to be

placed under. For example, Contract will be placed on the root level of Customer Management.

2. The Display Text defaults to the system name of the Business Object. You can choose to keep the name

or change it.

3. Enter in an Item Link, an URL to a page. When the object is clicked, a new window will appear on the

right based on the given link.

4. The Display Order defaults to 10000. You can keep it at that number or change the value to determine the

position of the node.

5. Access Permissions is autopopulated only when a menu is created through the Business Foundation.

When creating a new left menu from scratch, you may leave this field blank or otherwise copy in per-

missions from other existing menus. If you want to change Access Permissions, refer to the Permissions

section.

6. An Item Icon can be uploaded to represent the node. Click Browse to upload an icon.

7. Once all relevant information is entered, click on Publish.
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To verify if the object was published, go to the Display Region where you specified the object to be published to.

Click on the Refresh icon on the left navigation frame if you at first do not see the new node.

Editing, Ordering, or Deleting a Left Menu Item

To Edit a user-generated node in the left menu, click on the Notepad icon.
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If the left menu item was created via the Left Menu page, this popup window will appear.

If the left menu item node was created using Business Foundation, this popup appears.

To change the sort order of the left menu item, adjust the numerical value in Display Order. The lower the value,

the higher the position of the item within the navigation tree relative to items with a higher Display Order value.

To save changes, click OK.

To delete a left menu item, click on X icon.
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Commerce Configuration

This sections covers how to setup EPiServer Commerce with payment methods using built- in Payment Gateways

and setup the default Language, Currency, and Units.

Payment Gateways

When creating and configuring payment methods in EPiServer Commerce, there are three components that need to

be created or re-used as well as configured: Payment Types, Payment Gateways and Payment Methods.

Payment Types – Payment types are classes which contain the properties of a particular payment type. For exam-

ple, a credit card payment type contains credit card number, card expiration date, card type, etc. All payment types

inherit from the abstract class Payment. The most common payment types are already built-in to EPiServer Com-

merce:

l Credit card

l Cash Card

l Gift Card

l Invoice

In addition, a generic OtherPayment type is included in EPiServer Commerce. Payment types are meta classes.

Payment Gateways – Payment gateways provide an interface to the system which provides payment processing. A

payment type is passed to the payment gateway and the gateway executes the payment transaction with the payment

system (e.g. PayPal). One payment type is associated with each payment gateway.

Payment Methods – Payment methods contain information about the way the customer views a payment option

and has a payment gateway associated with it.
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Using a Built-In Payment Gateway

To setup payments using a built-in Payment Gateway, go to Administration -> Language (English, German, Span-

ish, etc.)

The Payment Methods window appears. By default, "Payment by Card (DIBS)", "Pay by Credit Card" and "Pay by

Phone" are already setup.

To create a new Payment Method, click onNew to open the Payment Method Edit screen.
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Here is an explanation of some of the gateway properties:

l ID – the system-assigned unique identifier for the payment gateway

l Name – the name to be displayed to the user

l Description – a description that can be displayed to the user

l SystemKeyword – the unique name for each instance of the gateway; new non-unique keywords will not

save to the database. This is not be editable after a gateway is initially created

l Language – allows a specific language to be specified for the payment gateway

l Class Name – name of the gateway class to be associated with the payment

l Sort Order – specifies the order of the payment method on the list of payment methods page

l IsActive – specify whether or not the payment method is active\

l IsDefault – specific whether or not the payment method is the default one

l Supports Recurring – specify whether this payment methods supports recurring payments, such as for

subscriptions

l Restricted Shipping Methods – Restricted shipping methods is not fully implemented
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out of the box and requires a developer to complete the functionality.

Click OK to save the Payment Method. The payment method will appear in the list of Payment Methods.

Setting up Payment Methods using nSoftware Provided Payment Gateways

EPiServer Commerce supports multiple payment gateways out of the box using nSoftware that end user can easily

setup without the need for a developer.

1. To enable nSoftware supported gateways, create a new payment method

2. Enter in aName, such as nSoftware or anything else

3. Enter in a Description

4. Enter in the SystemKeyword as "ICharge"

5. Select a Language from the dropdown menu

6. Select the Class Name "Mediachase.Commerce.Plugins.Payment.ICharge.IChargeGateway"

7. Select "Yes" for IsActive
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8. Change the Sort Order, IsDefault, Supports Recurring as needed

9. Click OK to save changes

Once created, click on the payment gateway again to go back to the Payment Method Edit page. Click on the

Parameters tab.

The Configure IBiz E-Payment Integrator Component appears and you can select from the Gateway drop-

down menu several dozen of the most popular payment gateways will appear. Depending on the gateway you select,

such as Authorize.Net, the Configuration Parameters will change. Enter in your credentials and other relevant

information to activate the gateway and click OK.
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Editing Payment Methods

To edit an existing payment method, click on the Notepad icon next to the Delete icon.

The ID is autogenerated. Every field can be changed except System Keyword. After you are satisfied with your

changes, click on OK.
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Deleting Payment Methods

To delete Payment Methods , click on the X icon next to the payment method name and click OK when the

popup appears. To delete multiple payment methods at once, check mark each payment method you want to delete,

then click onMore Actions --> Delete on the dropdown menu. Click OK when the popup appears.

Setting Your Default Language, Currency and Units

To set your default language, currency or unit, login to the Commerce Manager and go to the Administration -->

System Settings --> Common Settings and make appropriate selection.
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Out of the box, you have the following options:

l Language - English, German, Spanish, French

l Currency - US dollars, Canadian dollars, Euros, Yen, Pound sterlings and many others

l Length units - meters, feet

l Weight units - kilograms, pounds

Click OK to save your changes.

Creating Dictionary Values for Adding Languages, Countries and Currencies

This guide walks you through how to add Languages, Countries, and Currencies to EPiServer Commerce.

Adding New Languages

By default, you are given several Language options. To add a new Language, login to Commerce Manager and go to

Administration --> System Settings --> Dictionaries --> Languages.
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When you click New Language fill in the following:

l Language Code - to obtain code, go to this MSDN site: http://msdn.microsoft.com/en-us/li-

brary/ms533052%28VS.85%29.aspx (you must use the codes that contain dashes "-")

l Friendly Name - this name is displayed in the front-end public site language drop-down and various Com-

merce Manager admin pages

l Is Default - Yes/No

Click OK to save the language.

Adding New Countries

To add a new Country, login to Commerce Manager and go to Administration > System Settings > Dic-

tionaries > Countries.

Click onNewCountry and fill in the following displayed in the Overview tab:

l Country Name - this is the friendly name that is displayed in the public site during the checkout process

l Code - to obtain the code, go to this MSDN site http://msdn.microsoft.com/en-us/li-

brary/ee799297%28CS.20%29.aspx (use the ISO Short Code or ISO Long Code as long as you remain con-

sistent)

l Sort Order - enter a number starting from 0 (the lower number is listed on the top of the dropdown)

l Visible - Yes/No

http://msdn.microsoft.com/en-us/library/ms533052(VS.85).aspx
http://msdn.microsoft.com/en-us/library/ms533052(VS.85).aspx
http://msdn.microsoft.com/en-us/library/ms533052(VS.85).aspx
http://msdn.microsoft.com/en-us/library/ms533052(VS.85).aspx
http://msdn.microsoft.com/en-us/library/ee799297(CS.20).aspx
http://msdn.microsoft.com/en-us/library/ee799297(CS.20).aspx
http://msdn.microsoft.com/en-us/library/ee799297(CS.20).aspx
http://msdn.microsoft.com/en-us/library/ee799297(CS.20).aspx
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Regions refer to states, provinces or prefectures. In the Region tab, fill in the following:

l Type a Friendly Name (e.g. CA - this will be displayed in the public site during the checkout process) and

click Add. You can checkmark it either as Visible or not on the public site

When you click the Edit icon, you can change the Ordering of the region. Click Update to save those changes.

Adding New Currencies

To add a new Currency , login to Commerce Manager and go to Administration > System Settings > Dic-

tionaries > Currencies.

Click onNewCurrency. Fill in the following displayed in the Overview tab:

l Currency Name - this name is displayed in the front-end public site currency drop-down and various Com-

merce Manager admin pages
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l Code - this currency code needs to be obtained from this site http://en.wikipedia.org/wiki/ISO_

4217#Active_codes

In the Rates tab, you can Add Rates which are the foreign exchange rate when you want to convert from one cur-

rency to another.

When the Edit Currency Rate Information popup appears, enter in:

l To Currency - select from the drop-down the Currency to convert to from the current currency

l End of Date Rate - enter in the End of Day rate

l Average Rate - enter in the Average rate* *

l Currency Rate Date - enter in a Currency Rate Date

Then click on Save Changes.

Shipping

This guide will walk you through how to setup Shipping Methods, Shipping Providers and Shipping Gateways.

Shipping Method - A shipping method manages a set of information and rules that determines the shipping cost

and displays it on the front-end public site while a customer checks out an item from his/her shopping basket. The

shipping fee is added to the total price of the purchase. A shipping method is mapped to a shipping provider visible
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to a back-end administrator in Commerce Manager. This allows the public site to display friendly names such as

"Ground Shipping" to the customer and this is mapped to a provider such as UPS. Therefore, when a customer

picks "Ground Shipping," he/she will be using UPS.

Shipping Providers - A shipping provider is the class(es) that interacts directly with one or more actual shipping

services such as USPS, UPS, or FedEX. It retrieves shipping price information from the shipping service(s) its asso-

ciatedwith. One typical scenario would be to have a provider that represents a particular service (e.g. USPS). A pro-

vider can also represent a particular type of shipping situation. One example is that you could have a provider for

overnight delivery. The provider could retrieve pricing for that service to determine the lowest price given the loca-

tion of the customer. A provider could also represent other specific scenarios with one or more services such as

price by weight or ground shipping.

Shipping Gateways - Under Shipping Providers, a shipping gateway is the specific class that you select (Generic

Gateway or Weight/Jurisdiction Gateway).

There are two options out of the box for shipping gateways: 1) Generic Gateway (flat shipping rate) and 2)

Weight/Jurisdiction Gateway (base price + additional fee depending on weight and shipping location). You select

the shipping gateway in the Shipping Provider screen and then configure the actual values for that gateway/provider

in the Shipping Methods area.

Shipping Jurisdictions - an option which allows you to define values for region-specific shipping rates; this is only

used when you select the Weight/Jurisdiction Gateway (i.e. California)

Shipping Jurisdiction Groups - group of jurisdictions; this is required because this is a required field when con-

figuring the Shipping Method parameters (i.e. Southwest region)

Shipping Methods

A Shipping Method manages a set of information and rules that determines the shipping cost and displays it on

the front-end public site while a customer checks out an item from his/her shopping basket. The shipping fee is

added to the total price of the purchase.

A shipping method is mapped to a Shipping Provider visible to a back-end administrator in Commerce Manager.

This allows the public site to display friendly names such as "Ground Shipping" to the customer and this is mapped

to a provider such as UPS. Therefore, when a customer picks "Ground Shipping," he/she will be using UPS.

Customizing Shipping Methods

There are two Shipping Methods available out of the box for you to customize: Ground Shipping and Fixed Ship-

ping.

To customize the Shipping Methods, first go to Administration > Order System > Shipping > Shipping Meth-

ods > English (United States) or any other languages.
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At the Shipping Methods List screen, select the edit icon for either of the available methods. The Overview tab

screen for Shipping Method Edit will load with the below fields:

l ID - this is auto-generated after saving the new shipping method

l Name - enter in a name without spaces or special character; this name will not be displayed in the public

site, but is only for end users to manage and organize the shipping methods
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l Friendly Name - enter a friendly name which can have spaces and special character; the friendly name is

the name seen by customers who are purchasing items

l Description - enter a description (optional)

l Provider - select an available provider from the dropdown menu; the options displayed here are created in

the Shipping Providers screen (Generic Gateway is for a fixed shipping fee specified below under base price,

whileWeight/Jurisdiction Gateway is used for a shipping fee depended on the weight and shipping location)

l Language - select a language of your choice from the dropdown menu

l Base Price - the base price you specify here will become the fixed shipping fee for the Generic Gateway

option, and part of the Weight/Jurisdiction Gateway option.

l IsActive - select Yes or No under IsActive to enable is disable it, respectively

l IsDefault - select Yes or No if this shipping method is the default one

l Sort Order - enter a number for the sort order to determine its position on the list of shipping methods

The Settings tab is used to exclude any Countries, Regions, and Payments from a particular shipping method.

To exclude a selection, highlight the items on the Available boxes on the left and move them to the Chosen

Countries boxes by clicking Add.
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The Parameters tab is use to set conditions to determine the shipping fee. This screen become available only

when the Weight/Jurisdiction Gateway is select in the Provider field in the Overview tab (it will be empty with the

Generic Gateway option).
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l Jurisdiction Group - select a jurisdiction group to apply the current Shipping Method using the drop-

down menu; the options listed here are set up in the Shipping Jurisdictions and Shipping Jurisdiction

Groups screen.

l Weight - enter a numerical value for the weight; units for the weight is set in the the Common Settings

screen

l Price - enter a price to be added to the base price (Overivew tab) when the weight and jurisdiction group

conditions are met.

l Start Date - enter a start date and time for the shipping method to take effect

l End Date - enter a end date and time for the shipping method to expire

When finish entering the values above, select Add to save the condition. The condition will appear on table below.

In the above example, if the customer checks out an item that weights anywhere between 0 to 10 weight units (lbs

for example), and the customer's shipping address is in the United States, then the total shipping fee will equal $10

+ the base price you enter in the overview screen.

Click OK to save changes.

Deleting Shipping Methods

1. Check off the box that corresponds to the shipping methods you want to delete.

2. Click on the More Actions button on the upper left corner of the main window menu bar, and choose

Delete from the pull down menu.

3. Click OK when prompted. The selected methods will be deleted from the list.

Shipping Providers

 A Shipping Provider is an actual service such as USPS, UPS, or FedEX. However, a provider can also be a "type" of

shipping in order to determine shipping price. For example, one can have a "Percentage of Total Cost" provider or

"Fixed Price" provider. In this case, the shipment "types" can be associated to one of the existing providers (i.e.

USPS, UPS, FEDEX).

The Shipping Providers page manages the list of these providers/types. There are two shipping methods available

out of the box for you to customize: 1) Generic Gateway and 2) Weight/Jurisdiction Gateway.

A Generic Gateway is is used for a fixed shipping fee while Weight/Jurisdiction Gateway is used for a shipping fee

that is calculated based on the weight and shipping location.

Customizing Shipping Providers

Go to Administration > Order System > Shipping > Shipping Providers. Edit one of the two providers

listed.
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1. EditName, and Description

2. SystemKeyword (no spaces) and Classes are something that your developers need to code and pro-

vide.

3. Click OK to save changes

The revised shipping provider will appear in the Shipping Providers page.

The Parameters and Packages tabs are not fully implemented; they serve as a starting point for devel-

opers for full implementation of those features.

Deleting Shipping Providers

1. Go to the Shipping Providers page

2. Check off the box that corresponds to the shipping providers you want to delete.

3. Click on the More Actions button on the upper left corner of the main window menu bar, and choose Delete

from the pull down menu.

4. Click OK when prompted. The selected providers will be deleted from the list.
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Tax Configuration

Introduction

Taxes can be configured in the Administration subsystem so that specified rates are calculated and added to the

total price during the checkout process. Depending on your configuration, it is also possible to combine and apply

multiple taxes (such as federal, state and local tax) to a purchase.

Taxes can be set up and maintained using two methods: 1) creating/editing each tax control manually or 2) importing

all data using a CSV file. Here we will discuss both methods and also provide you with a few examples to dem-

onstrate how this works.

Method 1: Configuring Taxes Manually

To set up your taxes manually, you will need to work with the following areas in the Administration tab of the

Admin Site – Tax Categories, Tax Jurisdiction Groups, Tax Jurisdictions, and Taxes – as well as the con-

figuration pages for each of the catalog items.

The steps below summarize the process you need to follow to configure taxes.

1. Create and configure Countries and Regions (Go to Administration > System Settings > Dic-

tionaries > Countries): In Countries section create the countries you plan to sell your products in and

set the appropriate country codes. For the country codes, it is important that you use the ISO Short code

provided in the following link (http://msdn.microsoft.com/en-us/library/ms866171.aspx). Using the ISO

Long code or anything else will not correctly calculate taxes during checkout.

2. Create new Tax Categories (Go to Administration > Catalog System): In this step you will create

tax categories that will be used later to associate your catalog items with the tax rates you define. For

example you may create categories such as "General Sales," "Food," and "Luxury Items" depending on the

tax regulations for your item types. The categories you create here will become selectable on the Page

Details of your items (i.e., Variations/SKU Edit page) and on the Tax Edit page.

3. Create and configure Tax Jurisdictions (Go to Administration > Order system > Tax Con-

figuration): In this step you will specify particular Tax Jurisdictions. You can create different Tax Juris-

dictions for a particular region by specifying zip codes, country codes, etc. Tax rates will be applied to

whatever level of information you specify for each Jurisdiction. For example, if you specify only the country

code as US, all shoppers with a US address (regardless of state, county etc.) will be included in this juris-

diction. Note: Country Code and Region Code you enter in the Jurisdictions Edit page must match the

codes you used in step 1.

4. Create and configure new Tax Jurisdiction Groups (Go to Administration > Order system > Tax

Configuration): New Tax Jurisdiction Groups created here can include multiple Tax Jurisdictions.

5. Create and configure Taxes (Go to Administration > Order System > Tax Configuration): Here

you will specify tax rates and also associate the Tax Categories and Jurisdiction groups created in Steps 2

and 4.

6. Associate Catalogs to the Tax Categories created in Step 2 (Go to Order Management >

Catalogs): Now you will switch over to the Catalog Management subsystem and link specific catalog items

to the appropriate Tax Categories. This can be done on the Pricing/Inventory page within each Var-

iation/SKU Edit page.

http://msdn.microsoft.com/en-us/library/ms866171.aspx
http://msdn.microsoft.com/en-us/library/ms866171.aspx
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Method 2: Configuring Taxes Using CSV Import

Using the CSV Tax Import functionality is a convenient way to quickly setup and update tax data in bulk. Creating a

CSV tax file with a specified format (see "Example Scenarios" below) will allow you to complete steps 2 through 5

in one shot (above in Method 1). Step 6 of Method 1 can be done manually, but you can also use the CSV import

functionality in the Catalog Management subsystem to associate catalogs to tax categories. Click here to see how

CSV Catalog Import works.

Import your CSV tax file into your Commerce Manager by following the steps:

1. Select the Administration tab in the Commerce Manager.

2. In the navigation tree drill down to Taxes: Order System > Taxes Configuration > Taxes.

3. Click Import Taxes on the menu bar.

4. Choose Add New File and then Browse to select and upload your CSV tax file. The path of your chosen

file will appear in the field.

5. Click Upload File and then Save The File icon. The CSV tax file will appear under the Files Available for

Import section.

6. Select and highlight the CSV file and click the "Start Import" button.

7. Your import should begin and complete successfully in a pop-up dialog box.

8. You will now be able to view your tax setup in the Commerce Manager.

If you want to edit the existing setup, simply repeat steps 1 through 8 with your modified file.

Caution: Re-importing CSV files only edits existing information or adds new data, but nothing gets deleted. If you

delete an entire row of data in the CSV file, you must manually delete those entries in the Commerce Manager. If in

doubt, you can always delete all the tax data and perform the CSV tax import from scratch.

Sample CSV Files and Example Scenarios

Example 1: Single Tax Per Catalog Item Based on a Single Jurisdiction

For example, if your variable is State, then you can specify the tax rate on a state-level. So let's say CA is 9% and MA

is 6%. If you placed an order from California, then 9% sales tax would be applied during checkout.

Jurisdiction Jurisdiction Group Tax Rate Tax Category

California CA Tax Group 9% General Sales

Massachusetts MA Tax Group 6% General Sales

A sample tax CSV file called test.csv is available in this directory – [taxcsvsample1.zip ].

Example 2: Two or More Taxes Per Catalog Item Based on More Than One Juridiction

For example, if you have a luxury item that requires State and Federal tax to be applied, then you can specify tax

rates on a state and federal level. So let's say a luxury item purchased in CA has a 9% state tax rate and a federal tax

rate of 3%. Both taxes would be applied during checkout.

Jurisdiction Jurisdiction Group Tax Rate Tax Category

California General CA GS Tax Group 9% General Sales

Massachusetts General MA GS Tax Group 6% General Sales

California Luxury CA LX Tax Group 9% Luxury Sales
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Massachusetts Luxury MA LX Tax Group 6% Luxury Sales

US Federal Luxury US LX Tax Group 3% Luxury Sales

Warehouses

Commerce Manager users can add and track a list ofWarehouses within EPiServer Commerce. A Warehouse is a

physical place with an address from which items are shipped.

To access Warehouses, navigate to Administration > Expand Catalog System >Warehouses.

The important thing to keep in mind is that you can only associate a single warehouse for every SKU. So

when you are creating a new SKU, you will have to specify the Warehouse where the item is being

stored within the Pricing/Inventory tab.

TheWarehouse List page appears. An example warehouse called "Default Warehouse" is on the list. To create a

new Warehouse, click onNewWarehouse on the menu bar.

TheWarehouse Edit page has two tabs: Overview and Address.

1. Under the Overview tab enter in aName and Code. The Name and Code name can have spaces in

between characters.

2. Enter in a value for the Sort Order to determine the Warehouse's position on theWarehouse List.

3. Under Available select "Yes" or "No."

4. Under Is Primary select whether or not this Warehouse is the primary one. You can only have one pri-

mary Warehouse.
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5. Under the Address tab, enter all relevant information regarding this Warehouse.

6. Once you are satisfied with your entries, click onOK to save the Warehouse. Otherwise, click Cancel to

go back to the Warehouse List page. The new Warehouse will appear on the list.
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To delete a Warehouse, place a check mark on the box next to the name of the Warehouse and the click onMore

Actions on the menu bar.

Confirm deletion by clickingOK on the pop-up window. Otherwise, click Cancel to go back.

Catalog Management

An EPiServer Commerce front-end public site allows customers to shop for products. To manage products, you

can go to the back-end Commerce Manager and you will notice that products are arranged into one or more cat-

alog(s). Catalogs are independent from one another and you may create as many catalogs as you need. Catalogs can

be structured in a number of ways. For example, you may have various brands or product lines. Each brand or

product line can have its own catalog. Or, a retailer may have multiple suppliers, in which case, you can segment

each supplier into its own catalog.

A default B2C Sample Site along with a default electronics catalog (consisting of a Brands catalog + an Everything cat-

alog) is included giving you a running demo site after you run the installer.

The EPiServer Commerce Catalog Management provides full complement of tools and capabilities to create and man-

age a diverse range of products, variations, pricing strategies, languages, and related web site functions.

EPiServer Commerce allows you to easily and flexibly organize and categorize your products. All products ref-

erenced on a public site reside in a catalog created in the back-end. Multiple catalogs can be created and assigned to

one or more sites. The dates that each catalog will be available to the customer can also be defined. In this way,

future revisions to items and pricing can be prepared easily and reviewed in advance of the release date to the site.

Catalogs can be organized into Categories, Products, SKUs, Bundles, Packages and Dynamic Packages.

Catalog and Catalog Entries

l Catalogs - a catalog is a top-level container for all catalog entries such as Categories, Products and

SKUs.•Catalogs - a Catalog is a top-level container for all Catalog Entries such as Categories, Products and

SKUs

l Categories - a Category is a grouping of purchasable Products

l Products - a Product represents various forms of merchandise that you can display and purchase from the

front-end site, including Products, Variations/SKUs, Bundles, Packages and Dynamic Packages

l Product Entries - a Product Entry typically contains a Product name, part number, description and

images

l Variations/SKUs - a Variation or SKU corresponds to a specific type of Product with specific char-

acteristics. For example, a shirt Product will have an individual Variation/SKU which includes size,

color and sleeve length.

l Bundles - a Bundle is a collection of Variations and SKUs allowing customers to purchase two or

more items at once



© EPiServer AB

Commerce Manager | 55

l Packages - a Package is comparable to an individual SKU because the Package item must be pur-

chased as a whole (i.e. computer system)

l Dynamic Packages - a Dynamic Package is similar to the Package definition above with the added

ability to configure the Package during checkout

Working with Catalogs

A catalog is a top-level container for all catalog entries such as Categories, Products and SKUs. In this section, you

will learn how to browse, create, and delete catalogs. We recommend that you start with the B2C Sample Site

which came with your package -- it contains the Everything/Brands catalog. You can use the import functionality to

get this into one of your environments, edit/master the content and export it so that this polished catalog can be

used in a different environment. Also, you are given the flexibility to use a CSV file to rapidly create a new catalog

from scratch.

Browsing Catalogs

All Catalogs are managed under the Catalog Management system.

To browse the Catalog, click on Catalog Management on the left menu. Click on Catalogs to browse the list of

Catalogs.

The Catalog List page shows the following two sample nodes by default:

l Brands - this node contains information regarding different Brands.

l Everything - this node contains information on individual sales items grouped in different categories ("Dig-

ital Cameras," "Daily Specials," etc.)

Clicking on the Memo icon, located between the check box and the folder icon, will display more information and

settings of the particular Catalog in the Catalog Edit page.

Clicking on the Catalog names ("Brands" and "Everything" highlighted in blue) will take you to the Node List page,

which is the list of Sub-Categories under the selected Catalog.
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Creating a Catalog

The Catalog List page, used to organize and manage Catalogs, contains information regarding Brands and sales

items. These sets of information will either be displayed on the front-end site, or used for other purposes such as

for pricing and Promotions.

To create a new Catalog, click onNewCatalog.

l Category Name - this name will appear in the Catalog List Page (e.g., Brands, Everything)

l Catalog Owner - designate an existing user as the Catalog owner

l Available from - select the date to which the Category is activated

l Expires on - select the expiration date; once the expiration date passes, the Product will no longer appear

on the front-end site.

l Default Currency - this setting will set the Default Currency for the relevant Catalog contents

l Default Language - this will set the Default Language for the contents

l Base Weight - this assigns the weight units for the contents of the Catalog (e.g. pounds or kilograms).

More units may be added.

l Other Languages - you can also select other available Languages other than your default Language

l Sites - this determines the site/sites that the relevant Products will be displayed in. At least one site must

be highlighted, but you can highlight multiple sites to apply the catalog more than one site.

l Sort Order - the Sort Order determines the order to which the Catalog appears in the Catalog List page

l Available - select "Yes" to make the Catalog contents appear on the front end site; select "No" to hide the

Catalog from the front-end site

Once done setting up your Catalog attributes, selectOK to save the Catalog. You will be brought back to the Cat-

alog List with the new Catalog. Select Cancel to cancel out of the Catalog Edit page and back to the Catalog List.
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Importing and Exporting Catalogs

Preexisting catalog data can be imported or exported quickly to and from the Commerce Manager.

Accessing the Import & Export Functions

1. Access the Catalog List page in the Catalog Management subsystem. The Import/Export menu is located in

the upper left corner of the main window.

2. For exporting catalogs, click on the check box for the appropriate catalog nodes.

3. Click on the Import/Export pull-down menu to choose either import or export. The corresponding page

will appear in the main window.

Importing Catalogs

1. Browse and select the file to upload.

2. Click on the Upload file button. The files upload will appear in the list below.
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3. Click on the Start Import button. The progress window will show that the import is taking place.

4. When the import is 100% complete, close the progress window.

Exporting Catalogs

There are two way to export catalogs in the Export Catalogs page.

1. Export everything included in the catalog node that you've selected.

l To do this, click on the Start Export button. The progress window appears and shows the status of the

export.

l When the export is 100% complete, click on Close to close the progress window

2. Export only the desired files.

l To do this, click on the Download links highlighted in blue.

Using CSV Files to Quickly Create CustomCatalogs

Why Should I Use a CSV File?

The CSV catalog import is a feature in the Catalog Management system that enables you to import and manage cat-

alog entries (such as Products, Variations/SKUs, Packages) in bulk using an excel spreadsheet (.csv format). It is an

alternative to manually creating catalog entries directly in Commerce Manager, which can be tedious when dealing

with a large amount of catalog data.

This feature enables you to accomplish these key tasks:
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l Import your .csv spreadsheets and create new catalog entries in Commerce Manager.

l Set your catalog items into a desired category structure of your choosing

l Create entry relations to associate one entry with others (e.g., variation/SKUs will appear within a product

or a package)

l Edit or delete existing catalog items.

The CSV catalog import feature can be used for your entire catalog data, or just portions of them.

Import Overview

Here are the basic steps you can take to import and set up a new catalog using the CSV import feature. Before you

start, choose an existing catalog folder or create a new one (in the Catalog Management subsystem) to import the

CSV files to.

1. Create CSV data files (using Excel Spreadsheet, Notepad, etc.) with information about your categories,

entries, and entry relations.

2. Create necessary meta fields for the new catalog entries (in the Administration subsystem).

3. Upload the CSV data files to the CSV Import page.

4. Create a mapping file for each CSV file. A mapping file is needed to link each column of data in a CSV file to

the correct attributes in Commerce Manager.

5. Import the CSV files and their corresponding mapping files into a specific catalog.

6. Create entry relations to associate one entry with another (e.g., a Package and a Product, a Product and a

Variation/SKU, etc.).

Format for CSV Files

CSV files you create and import into Commerce Manager need to have a particular format.

l The first row should have headers that correspond to different attributes of the data you want to import

(e.g., product name, price, description, image file location, etc.).

l There are a few attributes that are in your CSV file to correctly structure your catalog:

l Code: A unique code to identify each category or entry

l Name: A unique name for each row of data

l Entry Type (for entries only): Each row must contain one of the following five words in order for the

Commerce Manager to correctly recognize its entry type --"Variation", "Product", "Package", "Bundle" or

"Dynamic Package"

l Parent & Child Entry Code (for entry relations only): A CSV file containing these codes can specify rela-

tionships between entries (e.g., display different Variations within a Product).

Although , the following attribute is useful in creating a hierarchy in your catalog:

l Action: A command to specify the action that will be taken during the import. Choose one of the three

options: Insert/Update/Delete or I/U/D.

Note: Please make sure to specify an appropriate command for each line of the CSV files. Entering "Insert"

when that data already exist, or "Update" when no data exist will give an error during import and those line

of data will not get successfully imported.

l Category Code (by comma): By assigning a category code to an entry, you can specify the category that

you want to place your entry in.

Also please note this rule:
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l SEOURL: By design, this attribute that is present in both categories and entries must be unique for each

item in your catalog. Importing files that contain more than one identical url will result in an error.

Mapping Types

Different mapping types are used to create the mapping files mentioned in step 4 above.

l Category w/ Meta Data – select this type to create a mapping file for your category files.

l Entry w/ Meta Data – select this type to create a mapping file for all the entry files (i.e., Packages, Prod-

ucts, Variation/SKUs, Bundles, and Dynamic Packages).

l Entry Relation – select this type to create a mapping file for your entry relation file that specifies the rela-

tionships between entries such as many SKUs to one Product, or SKUs and Products to a Package.

l Entry Association – select this type when creating a mapping file for entry associations (Advertizing other

items under titles such as "You may also be interested in...

l Variation w/ Inventory – select this type to create a mapping file to import your Pricing/Inventory data

located in your Variation/SKU Edit screen.

l Sale Price – Select this type to create a mapping file for Sale Price file, which specifies different currencies

for each item.

By selecting these options, the Commerce Manager will display different sets of Fields and Attributes for you to

manually assign to each data column of your CSV file. Figure 8 and 9 below shows the display of the mapping files

with the Category w/ Meta and Entry Relations Data type respectively. The items under Fields and Attributes

with superscripts 1 and/or 2 are headers that are required attributes that must exist in the CSV files you are import-

ing (1- required field for Insert, 2 – required field for Update).

Example: Importing and Setting up a New Catalog

The example below demonstrates how to use CSV import using the guidelines provided above.

Let's say you want to set up a "Baby Stuff" catalog with categories and entries as shown here in Figure 1.

Figure 1

Prerequisite: Create a new catalog

First, create a new catalog called "Baby Stuff" in the Catalog Management subsystem.



© EPiServer AB

Commerce Manager | 61

Step 1: Create CSV files containing data for your new entries

As an example, let's say that you have the following data files in .csv format with content as described below:

l BabyStuffCategories.csv

l BabyProducts.csv

l BabyPackages.csv

l BabyVariations.csv

l BabyVariationInventoryPricing.csv

l BabyEntryRelations.csv

l BabyAssociations.csv

l BabySalePrice.csv

CSV File Type 1 - Category File

This file specifies data for categories and/or subcategories within a Catalog.

The top line has column headers that will be matched with the Meta fields in the later steps. The headers can also

have different names. As you will see in later steps, Category Code in column 1 is important since it specifies

where the entry data will be stored. The code entered in under Parent Code in column 2 can be used to create sub-

categories. If the Parent Code is set to "null" or "root," then that category will be created in the root level of a cat-

alog. In this example, the "Infants" and "Toddlers" category will be created at the root level, while the "Diapering

Supplies" category will be located under "Infants" as a subcategory.

Figure 2

CSV File Type 2 – Entry Files

These files specifies data for Catalog Entries. The Products, Variation/SKUS, and Packages CSV files for this example

are shown in Figure 3, 4, and 5 respectively.

Figure 3
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Figure 4

Figure 5

CSV File Type 3 – Entry Relations File

This file is used to link one entry to others. In this example, Var1 ~ Var5 (different diaper sizes) are associated to

Prod1 "Diapers," Var9 ~ Var11 (different quantity for wipes) are associated with Prod2 "Wipes" and so forth. Also

some variations are assigned to packages. Please note that the Prod, Var and Package codes MUST BE the codes

from the entry CSV files (Figure 3, 4, and 5). If you include codes that are not defined in the entry CSV files, you will

get an error while importing them into Commerce Manager in Step 4.

Figure 6

CSV file type 4 - Associations file

This file is used to create associations between different entries. In this example, Var 10 is associated to Var 1 as an

Accessory, and Var 2 to Var 1 as a cross-sell item.

Figure 7

CSV file type 5 - Pricing/Inventory file

This file is used to specify the information for the Pricing/Inventory tab of each individual entry.
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Figure 8

CSV file type 6 - Sale Price file

This file is used to specify the information for the Pricing section of the Pricing/Inventory page.

Figure 9

Step 2: Create necessary meta fields for the new catalog entries

For this example, no additional meta fields need to be created because the sample spreadsheet uses only the default

attributes.

To create new meta fields follow these steps here.

l Go to the Administration subsystem in Commerce Manager.

l Select the "Catalog System" folder and then "Meta Classes" node located in the left navigation frame.

l Select Create New, then New Meta Class from its pull-down menu.

l Enter in a Name, Friendly Name (e.g., Baby Catalog), and some description (optional) for

the meta class, and choose "Catalog Entry" for Entry Type.

l Click OK to save the new class.

l Next Select Create New, then New Meta Field from its pull-down menu.

l Enter in a Name, Friendly Name (e.g., Baby Diaper Size), and some optional description.

l Also Choose the data type for this meta field and other properties by clicking on the check-

boxes.

l Click OK to save the new field.

l Repeat the steps to create all the necessary fields.

l Associate the new meta fields to the meta class you created.
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l Select to "Meta Classes" node on the left navigation frame again.

l For "Element" choose "Catalog Entry" in the pull-down menu.

l Under "Type" choose your meta class (e.g., Baby Catalog) you created earlier.

l Select the desired meta fields from the list displayed at the bottom of the screen.

l Select OK to save the new meta class to fields association.

l You are done with setting up your meta fields.

Step 3: Upload the CSV data files to the CSV Import page

Follow these steps to prepare the CSV files for import:

l Select the Catalog Management subsystem.

l In the upper-left detail area, click on Catalogs folder and you will see the Catalog List view in the main area.

l In the action area above the main view, click the Import/Export drop-down button and select CSV Import

Catalog.

l You will now see the CSV Import Catalog page in the main screen. The screen contains two tabs 1) CSV

Import and 2) Mapping File, which we will be talking about next.

CSV Import Tab

l In the "CSV Import" tab in the main view, click "Add New File."

l Browse for the CSV file you wish to import, then click "Upload File."

l When you get the "Uploaded File:" confirmation, click "Save the file."

l The CSV file you uploaded will be added to the "Files available for import:" list.

l Repeat the previous four steps for each CSV file you wish to upload.

Figure 10

Step 4: Create a mapping file for each CSV file

Now create a mapping file that will specify the data in the CSV file to its corresponding attributes in the Commerce

Manager.
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Mapping file tab

l Click the "Mapping file" tab in the main view. You will now see the "Mapping file" tab view of the CSV Import

Catalog view as shown in Figure 11.

Figure 11

Edit existing mapping file section

l Load mapping file: This section is used to retrieve previously created and saved mapping files. Since there

is no existing mapping file in this example, leave this section blank.

Meta Class, Language section

l Mapping Type*: Select "Category w/ Meta Data"

l Meta Class*: Select "Default Catalog Node"

l Language*: English

Data fle and CSV adjustment section

l Data File*: The drop down values presented here are dependent on the different CSV data files you

uploaded on the "CSV Import" tab in step 2.

l For this example, first choose "BabyStuffCategory.csv."Leave the rest of the field as default and move on to

the next section.

Fields and Attributes, Column headers in the data file, and Selected values section
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The values presented under the "Fields and Attributes" column are representative of the "Meta Class" selected in

the "MetaClass, Language" section above (which were either previously imported or created within Commerce Man-

ager).

The values presented in the drop-down menus under the "Column headers in the data file" column are rep-

resentative of the "Data file" selected in the "Data file and CSV adjustment" section above (which were previously

imported above).

l Select the appropriate "Column header" drop-down value to "map" with the MetaClass "Fields and Attrib-

utes" to the left; the value selected will be reflected in the "Selected values" column to the right.

Save mapping file section

l Enter a file name for the "Enter file name" textbox. For this example, save the mapping files using the same

CSV file names.

l Click the "Save" button. The browser returns to the CSV Import tab, and the mapping file in .XML format

will be added to the list in the "Choose mapping file" section.

l Repeat Step 3 to create and save a mapping file for each CSV files you wish to import.

l For CSV Entry files, select the "Entry w/ Meta Data" option under "Mapping Type."

l For CSV Entry Relations file, select "Entry Relation".

l For CSV Associations file, select "Entry Association."

l For CSV Pricing/Inventory file, select "Variation w/ Inventory."

l For CSV Sale Pricing file, select "Sale Price."

l When all the mapping files are saved, your CSV Import tab screen should look something like this.

Figure 12

Step 5. Import the CSV files and their corresponding mapping files into a specific catalog

At the "CSV Import" tab view (Figure 12), do the following:
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l Select and highlight the CSV file you wish to import in the "Files available for import" section. For this exam-

ple, select BabyStuffCategories.csv.

l Select and highlight the mapping file that corresponds to the selected CSV file in the "Choose mapping file

for import" section. For this example, select BabyStuffCategories.xml.

l Select the catalog in the "Catalog" drop-down into which you would like to import your CSV data. In this

example choose "Baby Stuff".

l Click the "Start import" button. You will see the "Importing catalog" modal dialog box which will notify you

of the percentage of completion as well as logging messages.

l Click "Close Window" at the bottom of the modal dialog to complete the operation.

l Repeat Step 4 to import all the remaining CSV & Mapping pairs.

Step 6. Verify Your Import

In the Catalog Management subsystem, expand the "Baby Stuff" folder under Catalog and verify that the contents of

your CSV file were imported into the appropriate catalog.

Deleting a Catalog

1. At the Catalog List page, check off the box to the respective Catalog you wish delete.

2. SelectMore Actions and then Delete Selected from its pull-down menu, located in the menu bar.

3. A pop up will appear to confirm your action. SelectOK to delete it. The chosen catalog will be deleted from the

list.

Categories and Nodes

A Category or a Node is a grouping of purchasable Products. In this section, you will learn how to browse, create,

clone, move, link, and delete Categories and Sub-Categories.
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Browsing Categories

The Node List (aka the Category List) is used to organize and manage nodes/categories, subcategories created

within a Catalog.

The "Brand" Catalog for example, which is available in the Commerce Manager by default, includes nodes assigned

with brand names such as "Canon", "IZOD", and "Dell". Also the Everything Catalog contains a node called "Mobile

Phones & Plans" which has subcategories called "Phones" and "Plans". Additional nodes or subcategories may be

created in the Node List page.

1. Clicking on the memo icon, located between the check box and the folder icon, will display the Catalog

Node Edit page, which contains more information and settings of that particular node. Here you can setup

the information and status that are common for all it's subcategories.

2. Clicking on any node names (highlighted in blue) will take you to the next sublevel, which shows the list of

categories under the selected node.

Menu Bar Functions

l Create New

This dropdown allows users to create different types of Categories/Nodes or Product entries as shown

below.

l Category/Node

l Product

l Variation/SKU

l Package

l Bundle

l Dynamic Package

l More Actions

l Delete Selected

l Clone Selected

l Move/Link to Folder
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Under "More Actions," cloning creates a duplicates with a unique ID that you can place in any location/hierarchy that

you choose. "Move/Link to Folder" allows you either to move a category/product to a new location/hierarchy or to

link one category/product to another category/product. So for example, you can create a category called "Featured

Products" and link it to items across various other categories. This way, if you make changes to content on the orig-

inal product page and that same product is part of the "Featured Products" category as a linked product, the changes

will be displayed in both locations. In other words, changes are bi-directional. Links can be broken if either of the

two are deleted.

Creating a Category

1. To create a new category, click on Create New and then click onNewCategory/Node.



© EPiServer AB

70 | User's Guide for EPiServer Commerce 1.0

This page will appear when creating a new category or editing an existing one. The Catalog Node Edit page will

contain information of aNode selected from the Node List page.

Overview Fields

l Name - enter a name for the product

l Available from - the date to which the product is activated
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l Expires on - the date on which the product expires; once the expiration date passes, the product will no

longer appear on the public site

l Display Template - choose a display template used to show the products in the public site from this drop-

down box; by default, the only available catalog display template is "Digital Camera". To create your custom

template, you will need some technical skills with html templates.

l Code - enter a product code here (e.g. DIGICAM)

l Sort Order - determines the order to which the product is sorted in the Node List page

l Available - select Yes to make the product appear on the public site; select No to hide the product from

the public site

l Meta Class - the choice made here dictates which the meta-fields or product attributes will appear on the

public site or Commerce Manager site

l Display Name - enter a name the way you like to be displayed in the public site with appropriate languages

l Primary Image - use the browse button to select and upload an image here

l Description - enter a description of a product with appropriate languages

Once done, click OK on the bottom of the page.

SEO

Search Engine Optimization can be achieved by entering the following information for the product.

l Title - this is the friendly name that appears in your browser's title area

l URL - this is what gets displayed in the browser URL window

l Description - this is the meta description that is used for SEO purposes by search engines

l Keywords - keywords used for SEO purposes by search engines
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Assets

Under Assets, you can associate additional files such as images, pdf, and video files all stored in the Asset Man-

agement subsystem.

Follow these three simple steps to add an asset file to the current entry.
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1. Click on the Find Assets pull-down menu to display all files available in the Asset system.

2. Choose one file at a time and type in an appropriate Group Name (see table below), depending now how

you would like it to be displayed.

3. Click on Add Asset. The asset associated to this entry will appear in the lower section of the screen.

l You can edit the Group Name or sort order by clicking on the Edit icon to the left of an existing asset.

After making any changes, make sure to click Update (ClickingOK at the bottom of the screen during the

editing mode will not save the changes made).

l You can delete any existing asset by clicking on the "X" icon.

File type Group

Names

How it gets displayed in the public site

Image Files (jpg, pgn, etc.) image Thumbnail icon will appear on the product details page

Downloadable Files (docs, pdf,

mp3s)

Downloads A "Downloads" tab will appear towards the bottom of the

details page

Specification Files (docs, pdf) Specifications A "Specifications" tab will appear towards the bottom of the

details page

Deleting a Category

1. To delete a category/node, go to the Node List.

2. Checkmark the box next to the node.

3. Click onMore Actions and then click on Delete Selected to delete the Category/Node.
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Organizing Categories

To organize a category, enter a numerical order in the Sort Order field within the Catalog Node Edit page. Cat-

egories and node will sort based on numercial order.

Creating a Sub-Category

To create a sub-category, it is similar to creating a high-level category.

1. Go to Node List and click through an existing Catalog

2. Click on Create New and click on Category Node. Specify the information under Catalog Edit (refer

to Creating a Category) and click OK to save changes.
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Cloning, Moving or Linking a Category

Under "More Actions," cloning creates a duplicates with a unique ID that you can place in any location/hierarchy that

you choose.

"Move/Link to Folder" allows you either to move a category/product to a new location/hierarchy or to link one cat-

egory/product to another category/product. So for example, you can create a category called "Featured Products"

and link it to items across various other categories.

This way, if you make changes to content on the original product page and that same product is part of the "Fea-

tured Products" category as a linked product, the changes will be displayed in both locations. In other words,

changes are bi-directional. Links can be broken if either of the two are deleted.

1. To link a category, go to the Node List and checkmark a category you want linked back.

2. Click onMore Actions and then click Move/Link folder.

3. Select link to folder and select the link destination from the dropdown menu. Click OK to create the link

to that category under that directory.
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Products, Variations and SKUs, Bundles, Packages, Dynamic Packages and Asso-

ciations

A product represents various forms of merchandise that you can display and purchase from the public site, including

Products, Variations/SKUs, Bundles, Packages and Dynamic Packages.

l Product Entries

A product entry typically contains a product name, part number, description and images.

l Variations/SKUs

A variation or SKU corresponds to a specific type of product with specific characteristics. For example, a

product of Shirts will have an individual variation/SKU which includes size, color and sleeve length.

l Bundles

A bundle is a collection of variations and SKUs allowing customers to purchase two or more items at once.

l Packages

A package is comparable to an individual SKU because the package item must be purchased as a whole (i.e.

computer system).

l Dynamic Packages

A dynamic package is similar to the package definition above with the added ability to configure the package

during checkout.

l Associations

One or more products can be associated to a product so that they can be displayed advertised on the public

site as product accessories, or upselling/cross-selling item. Associations can be made from any of the

individual products (Product Entries, SKUs, Bundles, Packages, and Dynamic Packages).
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Browsing Products

Products are created within a catalog. Products can be placed one level beneath the root of a Catalog and further

down into subfolders.

To browse products, click on a Catalog and drill down categories until you see Products such as the one high-

lighted below in the second screenshot.

Creating a Product (including Variations and SKUs, SEO, Associations, Assets)

To create a product, click through an existing catalog and click on Create New and then click on Create

Product.

Overview Tab

This is where you enter basic information about the Product.
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l Name - a name for the product.

l Available from - the date to which the product is activated

l Expires on - the date on which the product expires; once the expiration date passes, the product will no

longer appear on the public site

l Display Template - choose a display template used to show the products in the public site from this drop-

down box; by default, the only available catalog display template is "Digital Camera". To create your custom

template, you will need some technical skills with html templates.

l Code - enter a product code here (e.g. DIGICAM).

l Sort Order - determines the order to which the product is sorted in the Node List page.

l Available - select Yes to make the product appear on the public site; select No to hide the product from

the public site

l Meta Class - the choice made here dictates which the meta-fields or product attributes will appear on the

public site or Commerce Manager site.

Depending on the meta class selected, more fields are available to enter data. For instance, selecting the Digital

Camerameta class will yield digital camera meta fields and attributes.
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Variations/SKU Tab

Variations/SKUs are subcategories of a Product, which represents different "variations" of the particular product

(colors, sizes, different editions for example). Such Variations/SKUs can be grouped a chosen product from this

tabbed page. Follow these steps to group variations/SKUs.

1. Select the Variations/SKUs tab

2. Within the drop-down menu next to Find Item, select from the list variations or SKUs to associate with

the product.

3. Click on Add Item.

You can add multiple associations to the product and they will appear in a list under the column headers below.
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SEO Tab

Search Engine Optimization can be achieved by entering the following information for the product.

l Title - this is the friendly name that appears in your browser's title area

l URL - this is what gets displayed in the browser URL window

l Description - this is the meta description that is used for SEO purposes by search engines

l Keywords - keywords used for SEO purposes by search engines

If the Url field is left empty, it will be automatically filled in with a generated url (which depends on the

entry name). If the Url field is not empty (you entered some url), it will be saved as it is, and w will not be

changed automatically even if you change an entry name. If you need the url to change, leave it blank.
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Associations Tab

Different products or variations/SKUs can be linked to this product. Follow these steps to create product asso-

ciations:

1. Click on Add an Association. A pop-up window will appear that says Edit Association Information.

2. When the pop-up appears, enter an Association Name, Description, and define the Sort Order. Once you're

done, click on Save Changes.
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3. The new association will appear in the drop-down list.

4. You can also choose to Edit Details, which will allow you to edit associated items. The Pick Item drop-down

appears below Modify Existing Association.

5. Click onModify Association and you can edit the name, description, and sort order of an existing association.
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You can also Delete an association if needed.

6. Pick an item or items to add to the association. Click Add Item to do so.

7. Once you click on Add Item, the item will appear in a list just below. You can have more than one item tied to

an association.

You can Edit an item on the list. You can change the Sort Order and the Type. Once you're done modifying the

values, click on Update to save your changes. Otherwise select Cancel to navigate away without saving.
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Assets Tab

Assets are downloadable contents such as documents, links, videos, and images that can be linked to specific prod-

ucts. Assets are uploaded and managed in the Asset Management subsystem.

1. Under Find Assets, select from the drop-down list and click Add Asset.

2. Enter aGroup Name.

By default EPiServer Commerce offers three options with names that will allow the associated assets to be cor-

rectly displayed on the product details page of the public site.

l Image - (type as "image," all lowercase) thumbnail icon(s) will appear on the product details page

l Downloads - a "Downloads" tab will appear towards the bottom of the details page

l Specifications - a "Specifications" tab will appear towards the bottom of the details page

3. Once an asset is added to the list below, you can choose to edit specific assets, such as their Group name and

Sort Order.
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4. Once done, click OK and the new category/node will be created. You will be redirected to the Node List. Other-

wise, select Cancel to go back to the Node List without saving any changes.

Editing Product Tabs

When creating a Product, options are divided by tabbed navigation.

Overview Tab

This is where you enter basic information about the Product.

l Name - a name for the product

l Available from - the date to which the product is activated

l Expires on - the date on which the product expires; once the expiration date passes, the product will no

longer appear on the public site

l Display Template - choose a display template used to show the products in the public site from this drop-

down box; by default, the only available catalog display template is "Digital Camera". To create your custom

template, you will need some technical skills with html templates.

l Code - enter a product code here (e.g. DIGICAM1, DIGCAM2,...)

l Sort Order - determines the order to which the product is sorted in the Node List page

l Available - select Yes to make the product appear on the public site; select No to hide the product from

the public site

l Meta Class - the choice made here dictates which the meta-fields or product attributes will appear on the

public site or Commerce Manager site
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Depending on the meta class selected, more fields are available to enter data. For instance, selecting the Digital

Camera meta class will yield digital camera meta fields and attributes.

Variations/SKU Tab

Variations/SKUs are subcategories of a Product, which represents different "variations" of the particular product

(colors, sizes, different editions for example). Such Variations/SKUs can be grouped a chosen product from this

tabbed page. Follow these steps to group variations/SKUs.

1. Select the Variations/SKUs tab
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2. Within the drop-down menu next to Find Item, select from the list variations or SKUs to associate with the

product.

3. Click on Add Item.

You can add multiple associations to the product and they will appear in a list under the column headers below.

SEO Tab

Search Engine Optimization can be achieved by entering the following information for the product.

l Title - this is the friendly name that appears in your browser's title area

l URL - this is what gets displayed in the browser URL window

l Description - this is the meta description that is used for SEO purposes by search engines

l Keywords - keywords used for SEO purposes by search engines

If the Url field is left empty, it will be automatically filled in with a generated url (which depends on the

entry name). If the Url field is not empty (you entered some url), it will be saved as it is, and w will not be

changed automatically even if you change an entry name. If you need the url to change, leave it blank.
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Associations Tab

Different products or variations/SKUs can be linked to this product. Follow these steps to create product asso-

ciations:

1. Click on Add an Association. A pop-up window will appear that says Edit Association Information.
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3. The new association will appear in the drop-down list.

4. You can also choose to Edit Details, which will allow you to edit associated items. The Pick Item drop-down

appears below Modify Existing Association.

5. Click onModify Association and you can edit the name, description, and sort order of an existing association.

You can also Delete an association if needed.

6. Pick an item or items to add to the association. Click Add Item to do so.
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7. Once you click on Add Item, the item will appear in a list just below. You can have more than one item tied to

an association.

You can Edit an item on the list. You can change the Sort Order and the Type. Once you're done modifying the

values, click on Update to save your changes. Otherwise select Cancel to navigate away without saving.

Assets Tab

Assets are downloadable contents such as documents, links, videos, and images that can be linked to specific prod-

ucts. Assets are uploaded and managed in the Asset Management subsystem.

1. Under Find Assets, select from the drop-down list and click Add Asset.
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2. Enter aGroup Name.

By default Commerce Manager offers three options with names that will allow the associated assets to be correctly

displayed on the product details page of the public site.

l Image - (type as "image," all lowercase) thumbnail icon(s) will appear on the product details page

l Downloads - a "Downloads" tab will appear towards the bottom of the details page

l Specifications - a "Specifications" tab will appear towards the bottom of the details page

3. Once an asset is added to the list below, you can choose to edit specific assets, such as their Group name and

Sort Order.
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4. Once done, click OK and the new category/node will be created. You will be redirected to the Node List. Other-

wise, select Cancel to go back to the Node List without saving any changes.

Creating a Variation or a SKU

1. Click on Catalogs. The Catalog List appears on the main window.

2. Click on an existing catalog name highlighted in blue. The Node List window appears.

3. Click on Create New pull-down menu located in the upper left part of the main window.

4. On the drop-down menu, selectNew Variation/SKU. The New Variation/SKU Edit page appears.

Overview Tab

This is where you enter basic information about the Product.

l Name - a name for the Variation/SKU

l Available from - the date to which the Variation/SKU is activated

l Expires on - the date on which the Variation/SKU expires; once the expiration date passes, the Var-

iation/SKU will no longer appear on the public site

l Display Template - choose a display template used to show the Variation/SKU in the public site from this

dropdown box; by default, the only available catalog display template is "Digital Camera". To create your cus-

tom template, you will need some technical skills with html templates.

l Code - enter a Variation/SKU code here (e.g. DIGICAM).

l Sort Order - determines the order to which the Variation/SKU is sorted in the Node List page.

l Available - select Yes to make the Variation/SKU appear on the public site; select No to hide the product

from the public site

l Meta Class - the choice made here dictates which the meta-fields or Variation/SKU attributes will appear

on the public site or Commerce Manager site

Pricing/Inventory Tab

l Display Price - the price that will be displayed in public site

l Min Quantity - this forces your customer to purchase a minimum number of items as set here (this

number gets displayed as the lower range in the dropdown during the checkout process)

l Max Quantity - this is the maximum allowable number of items that can be purchased at one time (this

number gets displayed as the upper range in the dropdown during the checkout process)

l Merchant - (optional) if you use many merchants on your site, this provides another way to add more

information for a product; this can only be added/edited directly in the database so please contact your site

administratior/developer to make any changes

l Weight - based on your shipping configuration, the weight you enter here will affect the total shipping

cost

l Package - this value is based on width/length/height dimensions; the options for this dropdown are con-

figured in the Administration area

l Tax Category - this separation of taxes by category allows you to charge a different rate of taxes depend-

ing on what is being purchased; for example, you can have one rate for "General Sales" items and another

rate for "Luxury Sales" items

l Warehouse - the details on the available selections are maintained in the Administration Subsystem
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l Track Inventory - Yes/No. If this is set to "Yes," then the quantity value of In Stock, Preorder, and Back-

order fields will be deducted each time a purchase is made. If this is set to "No," then those values will not

change.

l Inventory Status - Enable/Disable. If this is Enabled, then the number of units of a product being pur-

chased cannot exceed the inventory value. In other words, the check out procedure cannot be completed if

you exceed the number in the inventory -- instead the quantity you can purchase will default to the actual

number of remaining units. For instance, if you have Tracking Inventory = Yes, and Inventory Status = Dis-

abled/Ignored, then the available quantity will be monitored, but it will not limit the number of units that

can be checked out. If you only have a quantity of 5 and you order 6 items, the checkout will still complete

and the inventory number will become -1.

l In Stock - you can enter the quantity of a particular product available for sale

l Reserved - The quantity you set here allows you to reserve a specified number of inventory "In Stock" and

prevent them from being used. So for instance, if you set the In Stock = 10 and Reserved = 5, then the In

Stock count will not go below 5.

l Reorder Min Qty - If the inventory falls below the value specified here, then this item will appear in the

"Low Stock Report" in the Dashboard or Reporting subsystem.

l Allow Preorder/Backorder - Yes or No; you need to set Allow Preorder/Backorder status to Yes to

turn either of these features On.

l Preorder/Backorder Avail - When you turn on either of the two and specify a quantity, the count will

begin to decrease after the In Stock count reaches its limit. For example, if you set In Stock = 10, Reserved

=3, and Backorder =10, then the Backorder qty will start to decrease after In Stock count reaches 3. So if

you place an order for 10 units, then the final count will be In Stock = 3, Reserved =3, and Backorder = 7.

l Backorder Qty - The quantity you set here will determine the backorders that can be made by customers

even when the item is out of stock.

Pricing

l Sale Type - you can select All Customers, a single Customer or a Customer Price Group

(the Customer Price Group gives you the ability to create tiered pricing)

l Sale Code - (optional) enter code to give special pricing for a group of Customers (i.e.

Dealers)

l Unit Price - discounted price per unit

l Currency - enter currency using the correct currency code (i.e. USD); you can create dif-

ferent prices depending on the currency that is selected

l Min. Quantity - minimum number of units you must purchase to get the discounted bulk

rate

SEO Tab

Search Engine Optimization can be achieved by entering the following information for the product.

l Title - this is the friendly name that appears in your browser's title area

l URL - this is what gets displayed in the browser URL window

l Description - this is the meta description that is used for SEO purposes by search engines

l Keywords - keywords used for SEO purposes by search engines

Associations Tab

Different products or variations/SKUs can be linked to this Variation/SKU. Follow these steps to create asso-

ciations:
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1. Click on Add an Association. A pop-up window will appear that says Edit Association Information.

2. When the pop-up appears, enter an Association Name, Description, and define the Sort Order. Once

you're done, click on Save Changes.

3. The new association will appear in the drop-down list.

4. You can also choose to Edit Details, which will allow you to edit associated items. The Pick Item drop-

down appears below Modify Existing Association.

5. Click onModify Association and you can edit the name, description, and sort order of an existing asso-

ciation.

You can also Delete an association if needed.

6. Pick an item or items to add to the association. Click Add Item to do so.

7. Once you click on Add Item, the item will appear in a list just below. You can have more than one item tied

to an association.

You can Edit an item on the list. You can change the Sort Order and the Type. Once you're done modifying the

values, click on Update to save your changes. Otherwise select Cancel to navigate away without saving.

Assets Tab

Assets are downloadable contents such as documents, links, videos, and images that can be linked to specific prod-

ucts. Assets are uploaded and managed in the Asset Management subsystem.

1. Under Find Assets, select from the drop-down list and click Add Asset.

2. Enter aGroup Name.

By default Commerce Manager offers three options with names that will allow the associated assets to be correctly

displayed on the product details page of the public site.

l Image - (type as "image," all lowercase) thumbnail icon(s) will appear on the product details page

l Downloads - a "Downloads" tab will appear towards the bottom of the details page

l Specifications - a "Specifications" tab will appear towards the bottom of the details page

3. Once an asset is added to the list below, you can choose to edit specific assets, such as their Group name and

Sort Order.

4. Once done, click OK and the new category/node will be created. You will be redirected to the Node List. Other-

wise, select Cancel to go back to the Node List without saving any changes.

Creating a Package

1. Click on Catalogs. The Catalog List appears on the main window.

2. Click on an existing catalog name highlighted in blue. The Node List window appears.

3. Click on Create New pull-down menu located in the upper left part of the main window.

4. On the drop-down menu, selectNew Product Package. The Product Package Edit page appears.

Overview Tab

This is where you enter basic information about the Product Package.

l Name - a name for the Product Package

l Available from - the date to which the Product Package is activated
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l Expires on - the date on which the Product Package expires; once the expiration date passes, the Product

Package will no longer appear on the public site

l Display Template - choose a display template used to show the Product Package in the public site from

this dropdown box; by default, the only available catalog display template is "Digital Camera". To create

your custom template, you will need some technical skills with html templates.

l Code - enter a Product Package code here (e.g. DIGICAM).

l Sort Order - determines the order to which the Product Package is sorted in the Node List page.

l Available - select Yes to make the Product Package appear on the public site; select No to hide the prod-

uct from the public site

l Meta Class - the choice made here dictates which the meta-fields or Product Package attributes will

appear on the public site or Commerce Manager site

Pricing/Inventory Tab

l Display Price - the price that will be displayed in public site

l Min Quantity - this forces your customer to purchase a minimum number of items as set here (this

number gets displayed as the lower range in the dropdown during the checkout process)

l Max Quantity - this is the maximum allowable number of items that can be purchased at one time (this

number gets displayed as the upper range in the dropdown during the checkout process)

l Merchant - (optional) if you use many merchants on your site, this provides another way to add more

information for a product; this can only be added/edited directly in the database so please contact your site

administratior/developer to make any changes

l Weight - based on your shipping configuration, the weight you enter here will affect the total shipping

cost

l Package - this value is based on width/length/height dimensions; the options for this dropdown are con-

figured in the Administration area

l Tax Category - this separation of taxes by category allows you to charge a different rate of taxes depend-

ing on what is being purchased; for example, you can have one rate for "General Sales" items and another

rate for "Luxury Sales" items

l Warehouse - the details on the available selections are maintained in the Administration Subsystem

l Track Inventory - Yes/No. If this is set to "Yes," then the quantity value of In Stock, Preorder, and Back-

order fields will be deducted each time a purchase is made. If this is set to "No," then those values will not

change.

l Inventory Status - Enable/Disable. If this is Enabled, then the number of units of a product being pur-

chased cannot exceed the inventory value. In other words, the check out procedure cannot be completed if

you exceed the number in the inventory -- instead the quantity you can purchase will default to the actual

number of remaining units. For instance, if you have Tracking Inventory = Yes, and Inventory Status = Dis-

abled/Ignored, then the available quantity will be monitored, but it will not limit the number of units that

can be checked out. If you only have a quantity of 5 and you order 6 items, the checkout will still complete

and the inventory number will become -1.

l In Stock - you can enter the quantity of a particular product available for sale

l Reserved - The quantity you set here allows you to reserve a specified number of inventory "In Stock" and

prevent them from being used. So for instance, if you set the In Stock = 10 and Reserved = 5, then the In

Stock count will not go below 5.

l Reorder Min Qty - If the inventory falls below the value specified here, then this item will appear in the

"Low Stock Report" in the Dashboard or Reporting subsystem.
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l Allow Preorder/Backorder - Yes or No; you need to set Allow Preorder/Backorder status to Yes to

turn either of these features On.

l Preorder/Backorder Avail - When you turn on either of the two and specify a quantity, the count will

begin to decrease after the In Stock count reaches its limit. For example, if you set In Stock = 10, Reserved

=3, and Backorder =10, then the Backorder qty will start to decrease after In Stock count reaches 3. So if

you place an order for 10 units, then the final count will be In Stock = 3, Reserved =3, and Backorder = 7.

l Backorder Qty - The quantity you set here will determine the backorders that can be made by customers

even when the item is out of stock.

Pricing

l Sale Type - you can select All Customers, a single Customer or a Customer Price Group

(the Customer Price Group gives you the ability to create tiered pricing)

l Sale Code - (optional) enter code to give special pricing for a group of Customers (i.e.

Dealers)

l Unit Price - discounted price per unit

l Currency - enter currency using the correct currency code (i.e. USD); you can create dif-

ferent prices depending on the currency that is selected

l Min. Quantity - minimum number of units you must purchase to get the discounted bulk

rate

Package Items Tab

In the dropdown, you can search through your entire inventory and select items to add to your Package by clicking

Add Item. Clicking the Edit icon beside the item you just added will allow you to specify the Quantity , the

Group Name and the Sort Order.

SEO Tab

Search Engine Optimization can be achieved by entering the following information for the product.

l Title - this is the friendly name that appears in your browser's title area

l URL - this is what gets displayed in the browser URL window

l Description - this is the meta description that is used for SEO purposes by search engines

l Keywords - keywords used for SEO purposes by search engines

If the Url field is left empty, it will be automatically filled in with a generated url (which depends on the

entry name). If the Url field is not empty (you entered some url), it will be saved as it is, and w will not be

changed automatically even if you change an entry name. If you need the url to change, leave it blank.

Associations Tab

Different products or variations/SKUs can be linked to this Product Package. Follow these steps to create asso-

ciations:

1. Click on Add an Association. A pop-up window will appear that says Edit Association Information.

2. When the pop-up appears, enter an Association Name, Description, and define the Sort Order. Once

you're done, click on Save Changes.

3. The new association will appear in the drop-down list.
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4. You can also choose to Edit Details, which will allow you to edit associated items. The Pick Item drop-

down appears below Modify Existing Association.

5. Click onModify Association and you can edit the name, description, and sort order of an existing asso-

ciation.

You can also Delete an association if needed.

6. Pick an item or items to add to the association. Click Add Item to do so.

7. Once you click on Add Item, the item will appear in a list just below. You can have more than one item tied

to an association.

You can Edit an item on the list. You can change the Sort Order and the Type. Once you're done modifying the

values, click on Update to save your changes. Otherwise select Cancel to navigate away without saving.

Assets Tab

Assets are downloadable contents such as documents, links, videos, and images that can be linked to specific prod-

ucts. Assets are uploaded and managed in the Asset Management subsystem.

1. Under Find Assets, select from the drop-down list and click Add Asset.

2. Enter aGroup Name.

By default Commerce Manager offers three options with names that will allow the associated assets to be correctly

displayed on the product details page of the public site.

l Image - (type as "image," all lowercase) thumbnail icon(s) will appear on the product details page

l Downloads - a "Downloads" tab will appear towards the bottom of the details page

l Specifications - a "Specifications" tab will appear towards the bottom of the details page

3. Once an asset is added to the list below, you can choose to edit specific assets, such as their Group name and

Sort Order.

4. Once done, click OK and the new category/node will be created. You will be redirected to the Node List. Other-

wise, select Cancel to go back to the Node List without saving any changes.

Creating a Bundle

1. Click on Catalogs. The Catalog List appears on the main window.

2. Click on an existing catalog name highlighted in blue. The Node List window appears.

3. Click on Create New pull-down menu located in the upper left part of the main window.

4. On the drop-down menu, selectNew Bundle. The Bundle Edit page appears.

Overview Tab

This is where you enter basic information about the Product Package.

l Name - a name for the Bundle

l Available from - the date to which the Bundle is activated

l Expires on - the date on which the Bundle expires; once the expiration date passes, the Bundle will no

longer appear on the public site
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l Display Template - choose a display template used to show the Bundle in the public site from this drop-

down box; by default, the only available catalog display template is "Digital Camera". To create your custom

template, you will need some technical skills with html templates.

l Code - enter a Bundle code here (e.g. DIGICAM).

l Sort Order - determines the order to which the Bundle is sorted in the Node List page.

l Available - select Yes to make the Bundle appear on the public site; select No to hide the product from

the public site

l Meta Class - the choice made here dictates which the meta-fields or Bundle attributes will appear on the

public site or Commerce Manager site

Bundle Items Tab

In the dropdown, you can search through your entire inventory and select items to add to your Bundle by clicking

Add Item. Clicking the Edit icon beside the item you just added will allow you to specify the Quantity, the Group

Name and the Sort Order.

SEO Tab

Search Engine Optimization can be achieved by entering the following information for the product.

l Title - this is the friendly name that appears in your browser's title area

l URL - this is what gets displayed in the browser URL window

l Description - this is the meta description that is used for SEO purposes by search engines

l Keywords - keywords used for SEO purposes by search engines

If the Url field is left empty, it will be automatically filled in with a generated url (which depends on the

entry name). If the Url field is not empty (you entered some url), it will be saved as it is, and w will not be

changed automatically even if you change an entry name. If you need the url to change, leave it blank.

Associations Tab

Different products or variations/SKUs can be linked to this Bundle. Follow these steps to create associations:

1. Click on Add an Association. A pop-up window will appear that says Edit Association Information.

2. When the pop-up appears, enter an Association Name, Description, and define the Sort Order. Once

you're done, click on Save Changes.

3. The new association will appear in the drop-down list.

4. You can also choose to Edit Details, which will allow you to edit associated items. The Pick Item drop-

down appears below Modify Existing Association.

5. Click onModify Association and you can edit the name, description, and sort order of an existing asso-

ciation.

You can also Delete an association if needed.

6. Pick an item or items to add to the association. Click Add Item to do so.

7. Once you click on Add Item, the item will appear in a list just below. You can have more than one item tied

to an association.
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You can Edit an item on the list. You can change the Sort Order and the Type. Once you're done modifying the

values, click on Update to save your changes. Otherwise select Cancel to navigate away without saving.

Assets Tab

Assets are downloadable contents such as documents, links, videos, and images that can be linked to specific prod-

ucts. Assets are uploaded and managed in the Asset Management subsystem.

1. Under Find Assets, select from the drop-down list and click Add Asset.

2. Enter aGroup Name.

By default Commerce Manager offers three options with names that will allow the associated assets to be correctly

displayed on the product details page of the public site.

l Image - (type as "image," all lowercase) thumbnail icon(s) will appear on the product details page

l Downloads - a "Downloads" tab will appear towards the bottom of the details page

l Specifications - a "Specifications" tab will appear towards the bottom of the details page

3. Once an asset is added to the list below, you can choose to edit specific assets, such as their Group name and

Sort Order.

4. Once done, click OK and the new category/node will be created. You will be redirected to the Node List. Other-

wise, select Cancel to go back to the Node List without saving any changes.

Creating a Dynamic Package

1. Click on Catalogs. The Catalog List appears on the main window.

2. Click on an existing catalog name highlighted in blue. The Node List window appears.

3. Click on Create New pull-down menu located in the upper left part of the main window.

4. On the drop-down menu, selectNewDynamic Package. The Product Dynamic Package Edit page

appears.

Overview Tab

This is where you enter basic information about the Product Package.

l Name - a name for the Dynamic Package

l Available from - the date to which the Dynamic Package is activated

l Expires on - the date on which the Dynamic Package expires; once the expiration date passes, the Product

Package will no longer appear on the public site

l Display Template - choose a display template used to show the Dynamic Package in the public site from

this dropdown box; by default, the only available catalog display template is "Digital Camera". To create

your custom template, you will need some technical skills with html templates.

l Code - enter a Dynamic Package code here (e.g. DIGICAM).

l Sort Order - determines the order to which the Dynamic Package is sorted in the Node List page.

l Available - select Yes to make the Dynamic Package appear on the public site; select No to hide the prod-

uct from the public site

l Meta Class - the choice made here dictates which the meta-fields or Dynamic Package attributes will

appear on the public site or Commerce Manager site
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Package Items Tab

In the dropdown, you can search through your entire inventory and select items to add to your Dynamic Package by

clicking Add Item. Clicking the Edit icon beside the item you just added will allow you to specify the Quantity, the

Group Name and the Sort Order.

SEO Tab

Search Engine Optimization can be achieved by entering the following information for the product.

l Title - this is the friendly name that appears in your browser's title area

l URL - this is what gets displayed in the browser URL window

l Description - this is the meta description that is used for SEO purposes by search engines

l Keywords - keywords used for SEO purposes by search engines

If the Url field is left empty, it will be automatically filled in with a generated url (which depends on the

entry name). If the Url field is not empty (you entered some url), it will be saved as it is, and w will not be

changed automatically even if you change an entry name. If you need the url to change, leave it blank.

Associations Tab

Different products or variations/SKUs can be linked to this Dynamic Package. Follow these steps to create asso-

ciations:

1. Click on Add an Association. A pop-up window will appear that says Edit Association Information.

2. When the pop-up appears, enter an Association Name, Description, and define the Sort Order. Once

you're done, click on Save Changes.

3. The new association will appear in the drop-down list.

4. You can also choose to Edit Details, which will allow you to edit associated items. The Pick Item drop-

down appears below Modify Existing Association.

5. Click onModify Association and you can edit the name, description, and sort order of an existing asso-

ciation.

You can also Delete an association if needed.

6. Pick an item or items to add to the association. Click Add Item to do so.

7. Once you click on Add Item, the item will appear in a list just below. You can have more than one item tied

to an association.

You can Edit an item on the list. You can change the Sort Order and the Type. Once you're done modifying the

values, click on Update to save your changes. Otherwise select Cancel to navigate away without saving.

Assets Tab

Assets are downloadable contents such as documents, links, videos, and images that can be linked to specific prod-

ucts. Assets are uploaded and managed in the Asset Management subsystem.

1. Under Find Assets, select from the drop-down list and click Add Asset.

2. Enter aGroup Name.
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By default Commerce Manager offers three options with names that will allow the associated assets to be correctly

displayed on the product details page of the public site.

l Image - (type as "image," all lowercase) thumbnail icon(s) will appear on the product details page

l Downloads - a "Downloads" tab will appear towards the bottom of the details page

l Specifications - a "Specifications" tab will appear towards the bottom of the details page

3. Once an asset is added to the list below, you can choose to edit specific assets, such as their Group name and

Sort Order.

4. Once done, click OK and the new category/node will be created. You will be redirected to the Node List. Other-

wise, select Cancel to go back to the Node List without saving any changes.

Creating Product Associations

Product Associations help you to highlight certain products in your public site. For example, one or more prod-

ucts can be related to or associated to another product so that these associated products can be displayed or adver-

tised on the public site as a product accessory, or as an upselling/cross-selling item. Associations can be made from

any of the individual products (Product Entries, SKUs, Bundles, Packages, and Dynamic Packages). (Product Entries,

Variations/SKUs, Bundles, Packages, and Dynamic Packages).

To create product associations go to the edit screen of any type of product entry listed above and select the Asso-

ciations tab.

Select theAdd an association button to enter an association name, an optional description and sort order

number. Click Save Changes to save and exit the screen. The new association should be added to the drop-down

menu.

To edit the details, click the Modify Association button and the same screen will reappear.

Next select the new association that you just created from the drop-down menu and click on Edit Details. The

association name and a new drop-down menu titled Pick Itemwill appear below.

Use the drop-down menu to add one more products and select Add Item to save the association. By this you will

have created a new association to the existing product.

Managing Assets

Assets are downloadable contents such as documents, links, videos, and images that can be linked to specific prod-

ucts. Assets are uploaded and managed in the Asset Management subsystem and then these assets can be associated

with catalog entries.

Associating Additional Digital Materials with Catalog Entries

Assets are downloadable contents such as documents, links, videos, and images that can be linked to specific prod-

ucts. Assets are uploaded and managed in the Asset Management subsystem.

1. Under Find Assets, select from the drop-down list and click Add Asset.
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2. Enter aGroup Name.

By default Commerce Manager offers three options with names that will allow the associated assets to be correctly

displayed on the product details page of the public site.

l Image - (type as "image," all lowercase) thumbnail icon(s) will appear on the product details page

l Downloads - a "Downloads" tab will appear towards the bottom of the details page

l Specifications - a "Specifications" tab will appear towards the bottom of the details page

3. Once an asset is added to the list below, you can choose to edit specific assets, such as their Group name and

Sort Order.
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4. Once done, click OK and the new category/node will be created. You will be redirected to the Node List. Other-

wise, select Cancel to go back to the Node List without saving any changes.

Searching for Entries in Your Catalog

The Catalog Search function enables you look for specific sales items stored in the Commerce Manager.

1. Click on Catalog Management and then Catalog Entry Search.

2. To do a basic search for catalog entries, enter a one keyword or more into the Search by Keywords(s) field,

such as "canon digital cameras". The search will return entries that match either of those keywords.

3. If you input keywords around quotation marks ("canon digital cameras"), then search will only fetch entries that

have those exact three keywords.

Catalog Search Filters

To narrow entry search results, there are Additional Filters available. Click search once those filters are set.

l Filter by language: Pull-down menu will show the available language choices

l Filter by catalog(s): Pull-down menu will show the available catalog choices
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l Search by code/id: Instead of text, you can search by code or ID

Deleting and Cloning Entries

Users can Delete and Clone entries. To delete or clone an entry:

1. Select an entry or entries by checkmarking the box next to it.

2. Click onMore Actions.

3. Click on Delete Selected or Clone Selected .

The entry will either be deleted or a clone (copy) of it appears.

Paging and Sorting Results

Users can sort results by clicking on Name , ID , Available From, Expires , and Status in either ascending or

descending order.
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Users can also change the Page Size ranging from 10 entries to All entries.

To page through multiple entry results, users can click on the paging controls on the lower-right corner of the main

window.

Updating Multiple Catalog Entries at Once

This area gives you the ability to quickly make mass changes to your catalog. You can sort by Entry Type, Meta

Class, Field , Language, Catalog and Keyword(s) . Once you apply one or more of these filters, the search

results will appear in the bottom half of the screen.

If you make changes to the entry, click Save All to save all of your catalog updates.

Clicking on a result, such as the example below, will direct you to the entry's edit page.

Asset Management

The Asset Management system allows for assets including images, MP3s, PDFs, software packages and other down-

loadable files to be centrally stored, displayed on either the front-end site or the Commerce Manager site and ulti-

mately to be shared or purchased.

Browsing, Editing, and Deleting Folders and Assets

The Asset List page categorizes and manages downloadable Asset files. The default list of Asset folders are: Video,

Presentations, Specifications, Software, Downloads, User Guides, and Images. These folder names can be

changed.

To access the Asset List, click on Asset Management > Root or any other folder below Root.
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The Asset List shows folders and assets. The Asset List shows the total Size of the Assets and the Created

date.

Folder and Asset names can be edited by clicking on the Edit icon next to the Name.

This brings you to the Folder Item page, allowing you to edit the Name.



© EPiServer AB

Commerce Manager | 107

If you are editing an Asset such as an image, the File Item page appears, allowing you to edit the name as well.

Copying/Moving and Deleting Folders and Assets

Users can also copy/move and delete Folders and Assets.

To copy or move an Asset or Folder to another location, place a check mark in the box next to the Folder or

Asset name and then click onMore Actions > Move/Copy.

The Move/Copy to Folder pop-up appears. You can select to "move" or "copy to folder." From the drop-down

menu, select the destination. Click onOK to confirm.
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To delete a Folder or Asset, place a check mark in the box and click onMore Actions > Delete Selected.

Creating Folders and Uploading Files (Assets)

Users can create their own Folders and upload files.

Creating Folders

To create a new Folder, go to the Asset List by clicking Asset Management > Root (or any Folder underneath

Root). Then click on Create New > New Folder.
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Enter in a name for the Folder and click Create.

The Folder will be created in whichever folder you are currently in. In this example, the Folder "Audio" was

created underneath Root.

To see the Folder in the left navigation frame, click on the Refresh icon and the new Folder "Audio" will appear.

You can create additional subfolders underneath Audio (or any other existing Folder).

Uploading Individual Files

To upload a single File, navigate to the Folder you want to upload the File to and then click on Create New >

New File.
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Click on Browse or enter in the file path into the field. Once done, click on Upload.

A progress bar appears below. Once the upload is complete, the FolderElement form appears, allowing you to

edit the name of the File, if you wish. Once done, click OK.

The File is now visible on the Asset List of the destination folder.
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Uploading Multiple Files at One Time

To upload multiple Files to a Folder, click on Create New > Upload Multiple Files.

The Add Files pop-up window appears. Click on Browse to add Files. An additional field will appear below, allow-

ing you to add more. You can upload up to five Files at one time. One done adding Files, click Upload.

A progress bar window will pop-up, showing you the progress of the uploads. Once complete, the Files will appear

in the Asset List.
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Customer Management

The Customer Management system is where you can add individual Organizations, Contacts, and Commerce Man-

ager users.

l Organizations - groups or sub-groups of Contacts.

l Contacts - individuals with a certain set of personalized information (name, address, email, etc.). Contacts

can be customers or users with Commerce Manager permissions to manage one or more systems.

l Commerce Manager User - this is a user with an assigned role which provides access to the Commerce

Manager site.

Organizations

In the Organizations section, Commerce Manager users can create new Organizations or Organization Units, which

are basically groups or sub-groups of assigned Contacts.

Organizations can be categorized into different types such as Organization or Organization Units (i.e., regional

branches, departments) and also business categories such as "Computer and Electronics" or "Clothing and Acces-

sories." Organizations can be structured into a tree structure with sub-units with different levels of permissions

assigned to each. For example, you can set up your company as a Parent level organization while your departments

such as Sales & Marketing, IT/Development, and Operations as Organization Units. With this scenario, you can

allow users in each departments to have access to only relevant systems, screens and functionality within Com-

merce Manager.

The Organizations section also comes with a new customizable filtering feature to display Organizations and sub-

units based on any of their attributes such as Name, Organization Types, Business Categories, etc.

Browsing Organizations

Organizations are one of the major function areas of the Customer Management system. You can browse and view

existing Organizations.

To browse Organizations, go to Customer Management > Organization on the left navigation frame.
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This will open the Organization List page.

Viewing Organization Details

You can click through the name of the Organization to view more details about it.

Searching for Organizations

You can also use the search field on the Organization List to find specific Organizations by name. To conduct a

search, enter in your search terms and click on the Search button (magnifying glass).

To conduct a new search, click on the Reset button (eraser) to reset the form and enter your new search terms.
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Printing a List of Organizations

If you want to generate a printer-friendly list of Organizations, click on Printer Version. A new window will pop-

up and render a simple table suitable for printing. Click on the Print button on the upper right corner of the page.

Creating or Customizing Views for Browsing Organizations

As anOrganization List gets longer, users can create and customize views to filter the list.

To create a new view, click on the View drop-down menu and select "New View."

A pop-up form appears above the Organization List. This form gives users the ability to customize which columns

appear and apply a variety of filters.
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The default tab is General. Enter in a Title for the custom View. Click the check-box Show this view for all

users, if you want other users to see this custom View.

Click on the Fields tab to select which columns you want to appear in the custom View. Select the columns you

want to have appear by clicking and highlighting the column name and moving it over to the Visible columns list by

clicking on the Right Arrow icon.

To deselect a column, click and highlight a column name from the Visible columns list and then click on the Left

Arrow icon.

To change the ordering of the Visible columns list, click and highlight a column name and click on the Up and

Down Arrow icons on the right of the list to reposition the column.

Click on the Filters tab to set the View filters. Users are given precise controls over filters for setting up rules for

their custom View. Clicking on the + icon allows you add an additional filter.
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Click on Save to save the settings and return to the Organization List screen.

To edit an existing View or a View you just created, select the View from the drop-down menu and click on the

Edit icon next to it. The View Editing form pops up and you are able to edit all properties.

To delete a custom View, click on the X icon next to the Edit icon.

There are a multitude of options available for customization, but here are some examples to get you started.

Example View Filter Setups

The examples here will start off with the following list of sample Organizations, Organization Units, and Divisional

Units:
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Example 1: Creating a View to Only Show Organizations that Match a Business Category and Organ-
ization Name

1. In this example, we will create a filter condition that display Organizations with a Business Category that

equals "Business & Professional Services" and an Organization Name that equals "Company X."

2. Click on the + icon and from the drop-down select "Business Category." Two fields, which default to

"Equals" and "Arts & Entertainment," automatically appear. Click on "Equals" and a drop-down appears. Keep

the field as "Equals." Click the field to the right of it and select a "Business Category" name (such as "Busi-

ness and Professional Services").

3. Since we want to add another filter so that the Organization not only matches this "Business Category," but

also a specified name, click on the following + icon and then on the drop-down select "Name."

4. In the next field, select "Equals" and then on the field that says "Text" enter in the name of the Organization

(such as "Mediachase").

5. Once done, click Save to save the View.

Applying and Editing a View

Once a View is created and saved, it appears in the View drop-down box.

To apply the View, select it from the drop-down. Based on the columns and filters you applied for the custom

View, your Organization List will reflect those options.
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Example 2: Creating a View to Display Companies with Specific Business Category or Organization
Name

In this example, we will create a filter condition that display Organizations with a Business Category that equals

"Computer & Electronics" or an Organization Name that contains "X."

Example 3: Creating a View to Display Companies with Specific Business Category and/or Name

In this example, we will create a filter condition that displays Organizations with a "Business Category" that equals

"Computer & Electronics" and/or an Organization Name that contains "X."
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Creating an Organization

To create an Organization, click onNewOrganization.

The Organization Edit page appears. The only required field is Name.

1. Enter in aName, which can have spaces and special characters (just like a Friendly Name).

2. Enter in a brief Description of the Organization.

3. Select a Type using the drop-down menu.

4. Select a Business Category from the drop-down menu.
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You can set the Organization as a "child" or Organizational Unit of a Parent company. For example, if your com-

pany or Organization has Divisional Units or subsidiaries, then you can attach this Organization to a Parent com-

pany listed in the drop-down menu.

If you do not see the the Organization listed on the dropdown menu, click on "More..."

A pop-up form appears to show all available Organizations.
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Once you have entered all relevant information, click onOK. The Organizational Info View Form of the Organ-

ization appears.

From here, you can view Information about the Organization you just created. Out of the box, you can also see

associated Contracts, Organizations, Addresses, and Credit Cards . You can further edit the Organization by

clicking the Edit button. To go back to the Organization List, click onOrganizations on the menu bar next to

Edit.

Creating an Organization Unit

An Organizational Unit is a "child" or subsidiary of a Parent organization. Within Commerce Manager, you can

assign an Organization as a Parent of another Organization. For example, the Parent company "Company X," and the

Organizational Units are "Company XWest" and "Company X East."

To create an Organization Unit, either create aNewOrganization or Edit an existing one.

1. Enter in aName and Description.

2. From the drop-down, select the Type as "Organization Unit."

3. Select a Business Category.

4. Select a Parent Organization from the drop-down menu. Selecting a Parent Organization will designate

this Organization as a unit (or in other words, a division, sub-organization, subsidiary, etc.)

5. Click OK to save the changes.

You will see in the Organization Info View form that the Organization is now a child or Organization Unit of the

Parent Organization you selected.
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Creating an Organizational Hierarchy

You can create Organization Hierarchies by assigning a Parent Organization to a "child" Organization and then

another Organization to the child. Permissions can be set to determine which users can view certain Organizations

in the hierarchy.

Create an Organization Unit by assigning a Parent with a child Organization. For example, "Company X" is the Par-

ent Organization and "Company XWest" is the Organization Unit.

Assign another Organization with the child Organization ("Company XWest"). Click OK.

In the Organization Info page, the Organization becomes the child to the Organization Unit you selected.
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Repeat the steps above to create further subunits of the Parent Organization.

Creating and Editing Dictionary Entries

Bydefault, when creating or editing anOrganization, there is a default list of Types and Business Categories avail-

able to the user. More options can be created by editing the Dictionary within the Organization Edit page. (Dic-

tionaries are related to Business Foundation and can be extended by the user.)

To edit the Dictionary, open the Organization Edit page by creating a new Organization or editing an existing

one. Click on the Dictionary icon next to the Type or Business Category drop-down button.

The new window appears allowing you to edit the existing Dictionary of either Business Category or Type. To

add a new item to the Dictionary, click onNew Item.
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1. Select the order of the item from the drop-down on the left.

2. Enter in a name of the item on the field next to the drop-down.

3. Click the Save icon to save the dictionary item or click Close to go back to the Organization Edit page.

The Dictionary item is now available in the Type or Business Category drop-down.

Contacts

Contacts are individuals with a certain set of personalized information (name, address, email, etc.).

l Contacts with Accounts - a customer who registers on the public site. If this customer chooses, he/she

can login to his/her Account from the public site and access his/her order history and other personalized

information. He/she cannot access the Commerce Manager.

l Contacts with User Permissions - someone internal to your team who has varying levels of access to

the systems within Commerce Manager

Contacts consisting of users who will be accessing the Commerce Manager can be assigned Roles based on varying

permissions. For example, a user with the "Cms Admins" role will have full access to only the Content Management

system. In addition, notes regarding the Contact's registration source can be recorded.

The Contact section also comes with a new customizable filtering feature to display contacts based on any of their

attributes such as Name, Last Order Date and Customer Group.

Browsing Contacts

To browse Contacts, go to Customer Management > Contacts.

Viewing Detailed Contact Information

The Contact List page shows a list of existing Contacts.
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You can click through the name an existing Contact to view more information.

From within the Contact Info form, you can view other recorded information about the Contact. For example,

you can view Addresses andOrder History related to this Contact.

More objects or metadata can be added to the default View Form via Business Foundation.

Searching for Contacts

On the Contact Info page, you can use the search form above to search for a particular Contact using key terms.

Conduct the search by clicking on the Search icon (magnifying glass). Contacts that match the search terms will

appear on the list.
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To clear the search and revert back to show all Contacts, click on the Reset icon (eraser) next to the Search icon.

Generating a Printer Friendly List of Contacts

To generate a printer friendly layout of the Contact List, click on Printer Version from the menu bar on the Con-

tact List page.

A new browser window opens showing a printer- friendly version of the Contact List. Click on Print on the far

right corner of the browser window.

Creating or Customizing Views for Browsing Contacts

LIke Organizations, users can create or customize Views when browsing objects.

Creating a New View

On the Contact List page, click on the View drop-down menu and selectNew View.
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A pop-up appears, very similar to the one found in Organizations. This form gives users the ability to customize

which columns appear and apply a variety of filters.

The default tab is General. Enter in a Title for the custom View. Check the box Show this view for all users if

you want other users to see this custom View.

Click on the Fields tab to select which columns you want to appear in the custom View. Select the columns you

want to have appear by clicking and highlighting the column name and moving it over to the Visible columns list by

clicking on the Right Arrow icon.
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To deselect a column, click and highlight a column name from the Visible columns list and then click on the Left

Arrow icon.

To change the ordering of the Visible column list, click and highlight a column name and click on the Up and

Down Arrows on the right of the list to reposition the column.

Click on the Filters tab to set the view filters. Users are given precise controls over filters for setting up rules for

their custom View. Clicking on the + icon allows you add an additional filter.

There are a multitude of options available for customization.
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Applying and Editing a View

Once a View is created and saved, it appears in the View drop-down box.

To apply the View, select it from the drop-down. Based on the columns and filters you applied for the custom

View, your Contact List will reflect those options.

To edit an existing View or a View you just created, select the View from the drop-down menu and click on the

Edit icon next to it. The View Editing form pops up and you are able to edit all properties.

Creating a Contact

To create a new Contact, from the Contact List page, click onNewContact.

The Contact Edit page appears where you can enter all relevant information about the contact. The only required

fields to complete are Full Name, First Name, Last Name, and Email. The rest of the fields are optional but are

recommended.

1. Select a Parent Organization from the drop-down menu to associate the Contact with a single Parent

Organization.

2. Assign the Contact to a Customer Group. More Customer Groups can be added by editing the Customer

Group Dictionaries. Customer Groups become useful when setting specific permissions and targeted Mar-

keting Campaigns.
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3. Select a Preferred Currency for the contact. If the Contact is in France, you may want to associate the

Euro currency. Available currency options are based on settings in Administration > System Settings >

Dictionaries > Currencies.

4. Select a Preferred Language to associate with the Contact. Languages are populated based on the lan-

guages set under Administration > System Settings > Dictionaries > Languages.

5. The Registration Source field is a text field for entering in notes about the Contact. For instance, you

may want to reference which website the Contact is currently registered under.

The Registration Source field is automatically filled when a user creates a new Account from the public

website.

Click OK to save the Contact. The Contact Info View Form, where you can enter in additional information

about the Contact as well as go back and edit the Contact again.

The screenshot belows shows the default layout of the Contact Info form. This can be customized using

Business Foundation.



© EPiServer AB

Commerce Manager | 131

To go back to the Contact List, click Cancel or the Contacts button next to the Right Arrow icon.

Creating an Account

An Account can be created with a Contact. Once an Account has been created, the Contact can be assigned per-

missions using Roles and access the Commerce Manager.

A customer Account is automatically created for a customer who registers from the front-end public web-

site, allowing them to login and view personalized information.

To create an Account for an existing Contact, click on a Contact name from the Contact List. On the Contact

Info page, click on Create Account.

A pop-up appears to enter in their user account credentials. A User Name and Password are required to create

the Account.

1. Enter in aUser Name, which can include spaces and special characters.

2. Enter in a Password, which must be four or more characters.

3. Enter in a Description and Email Address, which are both optional.

4. To enable the account, select "Yes" under Approved. Otherwise, select "No" to keep the account inactive

and inaccessible by the user.

5. Click OK to save the account.
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User account information appears under the Account section of the Contact Information form.

Fields Explained:

l Last Activity - last time the user logged in or made any changes to the site

l Last Lockout - last time a user was locked out due to too many failed login attempts

l Last Login - last time the user logged into his or her account

l Last Password Changed - last time the user account password changed

Editing an Account, Changing an Account Password, and Removing Accounts

To edit an Account, click on Edit Account . The same pop-up will appear. You cannot change the User Name

unless you remove the Account and recreate the same Account.

To change the password, click on Change Password . A password pop-up appears with an editable field that

allows you to enter in the new password.

To delete or remote the account, click on Remove Account.
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Roles and Permissions

In the Roles section, Commerce Manager users can be either granted or restricted access to an entire system or a

particular menu item within a system. Each Role is defined by a set of Permissions that can be added or changed

based on user selection. Existing Roles can be customized; new Roles can also be created to suit your unique busi-

ness needs.

Roles control the level of access permissions of each user account in Commerce Manager. Different Roles may be

added to user accounts (i.e., store operator or webmaster) so that they can access, edit, or process relevant infor-

mation.

There are three main categories that determine the different levels of permissions: Admin, Manager, and Schema

Manager.

l Admin Role - allows users to fully access and administer a particular Commerce Manager system.

l Manager Role - allows users to manage (View/Create/Edit/Delete) existing aspects of a particular Com-

merce Manager system .

l SchemaManager - allows users to access only the administrative side of an Commerce Manager system

(e.g. setting up Meta Data).

Definitions of Roles

Selecting Roles in the navigation frame opens a Roles List page with the default Roles shown below. The Roles List

page allows Commerce Manager administrative users to add new or delete these existing Roles.

Here is a listing of some of the Roles followed by a brief high-level description of what a user with this Role can

access:

l Admins - allows users to fully administer most areas of the Commerce Manager with the exception of Busi-

ness Foundation and a few other administrative functions

l Asset Admins - allows user to fully administer the Asset Management system

l Asset Managers - allows user to manage (View/Create/Edit/Delete) but not fully administer the Asset Man-

agement system (to fully administer, you need access to the Administration area)

l Catalog Admins - allows users to fully administer the Catalog Management system

l Catalog Managers - allows users to manage (View/Create/Edit/Delete/Others) Catalogs, Nodes, and

Entries within the Catalog Management system

l Cms Admins - allows user to fully administer the Content Management system

l Cms Editors - allows user to view existing Sites and manage (View/Create/Edit/Delete/Others) Fold-

ers/Pages, and Menus

l Cms Managers - allows user to manage (View/Create/Edit/Delete/Others) Sites, Folders/Pages, and

Menus but not fully administer the Content Management system (to fully administer, you need access to the

Administration area)

l Customer Managers - allows users to manage (View/Create/Edit/Delete/Others) customers within the

Customer Management system as well as various elements in Business Foundation

l Everyone - one of the default Roles which is assigned when a customer registers an account from the

front-end public site

l Management Users - allows users access to the Commerce Manager

l Marketing Admins - allows users to fully administer the Marketing system
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l Order Admins - allows users to fully administer the Order Management system

l Order Managers - allows users to manage (View/Create/Edit/Delete/Others) elements within the Order

Management system

l Security Admins - allows users to manage (View/Create/Edit/Delete) Roles within the Customer Man-

agement system

l Registered - one of the default Roles which is assigned when you register from an Account from the

front-end public site

These Roles are only suggestions and you can easily modify these existing roles or consolidate roles. In

addition, custom Roles can be created depending on your business needs.

Creating, Editing, and Deleting Roles

Out of the box, Commerce Manager includes a list of pre-existing Roles that can be assigned to Accounts. Users

can also create their own Roles based on a set of Permissions. Roles allow Administrators to restrict users from

accessing different systems or folders depending on their needs.

Creating a Role

To create a new Role, go to Customer Management > Roles to see the Role List.

Click onNew to open up the Role Edit page.
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There is a wealth of Permissions options Administrators can set for a Role.

Enter in a Role Name.

Checkmark the boxes to give Permissions to the Account for this particular function or action. For example, if you

want an Account to only View and Edit Assets, you will need to expand Assets > Manage and checkmark View

and Edit.
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Once done defining the Role, click onOK. The new Role will appear on the Role List.

Editing Existing Roles

All existing Roles, including the ones included out of the box with Commerce Manager, can edited and customized.

It is also a recommended reference to how each pre-existing Role works.

To edit a Role, click on the Edit icon.

The Role Edit page appears. You can customize the Permissions settings for the Role. Once done, click OK.

Deleting Roles

To delete any Role on the list, there are two ways:

Click on the X button next to the name of the Role to delete one at a time.

To delete multiple Roles, checkmark each box and on the menu bar, click onMore Actions > Delete Selected.

Click OK when the pop-up appears.
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Assigning Roles to Individual Accounts

Roles are designed to allow and disallow certain functionality and folders to individual accounts. When a Contact

logs into his or her account, that Account is bound by the Roles it was assigned.

To assign one or more Roles to an account, go to Customer Management > Contacts and click on an existing

Contact with an Account.

Under Security, click on Roles. The Security section only appears after an Account was created for the Contact.

The Roles form appear, allowing you to assign Roles to the Account. By default, an Account is already assigned the

"Registered" and and "Everyone" roles.
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Click on Assign Role to assign a new Role to the Account. A pop-up appears allowing you to assign a specific Role

from the drop-down menu.

Select a Security Role from the drop-down to assign to the Account.

Optionally, you can assign an Organization to the Account, which enables the Inheritance drop-down menu below.

If specific permissions are set for an Organization, you can set to "Inherit from Parent" (inherit permissions from

the Parent organization) or "Overwrite parent."

Click Save to assign the role. Repeat these steps to assign more roles to the Account.
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Dashboard

The Dashboard is an aggregated view of a site's status. Typically, the Dashboard > Home is the first screen seen

that a user sees when he/she logs into Commerce Manager. This is the area that a user can get a quick overall snap-

shot of his ecommerce site, including notifications and alerts, an overall summary of products, categories, orders,

customers, and promotions, sales performance graphs, customizable news and announcements, and a search field

for help.

Customizing the Dashboard

The user can customize the Dashboard by re-arraging the layout of the Controls, remove or add Controls, or

adjust the page template. The five Controls available are: Help , Summary, News & Announcements , Alerts,

and Performance.

To access the Dashboard, click on Dashboard > Home from the left navigation frame.

The screenshow below shows the Controls available to the user.
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The Help Control allows users to search for help topics in the EPiServer Commerce documentation site. Enter

key terms into the Search field and then click on Search Help. Other frequenly asked questions (FAQs) are listed

underneath the Search field.

The Summary Control displays the total number of Products , Categories , Orders , Customers , and Pro-

motions.

The News & Announcements Control displays a feed of the latest news articles.

The Performance Control displays a Sales Graph and a graph for the Total Sales of the year.

Rearranging, Collapsing, and Removing Controls

To rearrange Controls, hover the mouse cursor over the title bar and drag the Control to another "space" in the

Dashboard.

To collapse Controls, click on the Up-arrow icon. To expand a collapsed Control, click on the Down-arrow.
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To remove a Control, click on the X icon.

Adding Controls and Adjusting the Page Template

Click on Add on the Dashboard page. The Information form pops up above the Dashboard page.

The Controls Set tab allows you to select which Controls you want to add to the Dashboard. Check the boxes

and then click on Add and Close. The Controls you selected will appear on the Dashboard.

To reset the Dashboard back to the default state before any customizations were made, click on Set to Default.

On the Page Template tab, you can adjust the Dashboard page layout to aOne column template, Two columns

template (first twice bigger than the second), Two columns template (2nd twice bigger than the 1st),

and Two equal columns template. Click on the layout you want and then click on Add and close.
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The screenshow below is an example of how aOne column template looks.

Marketing

The Commerce Manager Marketing system consists of the following components:

l Campaigns - a way to organize marketing activities. Campaigns must be associated with Promotions in

order to provide customer discounts. Optionally, Campaigns can also be tied to Customer Segments for tar-

geted marketing purposes.

l For example, you can create a seasonal campaign that will include different Promotions tar-

geted for the Spring season.

l Promotions - a way to apply various discounts to the products, order totals or shipping. A Promotion is a

marketing tool used to increase sales of certain products or product lines. Various incentives such as low-

ered pricing and other discounts can be employed as part of a Promotion.

l Promotions are always tied to Campaigns.

l Promotions can be classified into two types: 1) either you can create a Promotion that is

visible prior to checkout or 2) you can configure the Promotion to be displayed during the

checkout process.



© EPiServer AB

Commerce Manager | 143

l The most powerful aspect of the Marketing system is the Expression Engine which allows

variable conditions to be applied when creating a Promotion. These conditions vary from

the number of items, the percentage discount, shipping rates and many others.

l Customer Segments - these determine the target audience for the Promotions. Customer Segments

determine the target audience for the Promotions. Within a Campaign, all Promotions will be applied to

whatever Customer Segments associated with the same Campaign. Members of the Customer Segments

can be pre-defined in static groups or you can use the Expressions Engine to create dynamic groups when-

ever Promotions are run.

l For example, you can have a Customer Segment that targets all users from the Los Angeles

area. You can create an Expression that will include all the customers whose home city is

Los Angeles. Thus, when a user registers on the site he immediately becomes part of the

target Customer Segment.

l Expressions - these are customizable Conditions which allow users to extend different aspects of the Mar-

keting system -- Promotions, Customer Segments and Policies all rely on Expressions. There is an Expres-

sions Engine which is a core technology behind the Marketing system.

l For example, you want to set a Promotion for "40% off Item X." The Expression or Con-

dition to enable this Promotion would include: Catalog ID for Item X and Reward of 40%.

l Policies - rules that are always executed when Promotions are applied. This allows a Marketing manager to

declare rules just once for the whole site.

l An example of a rule is as follows: Do not allow negative orders.

Campaigns

Campaigns provide a way to organize marketing activities. Campaigns must be associated with Promotions in order

to provide customer discounts. Optionally, Campaigns can also be tied to Customer Segments for targeted mar-

keting purposes. For example, you can create a seasonal Campaign that will include different Promotions targeted

for the Spring season.

Browsing Campaigns

To browse Campaigns, go to Marketing > Campaigns to open the Campaign List.

From the Campaign List, you can create aNewCampaign or edit existing ones.



© EPiServer AB

144 | User's Guide for EPiServer Commerce 1.0

Creating a Marketing Campaign

Sales promotions are tied to specific Campaigns. A Campaign could be related to seasonal sales, such as Easter or

Christmas. Campaigns are the first step to deploying targeted marketing efforts.

To create a new Campaign, click onNewCampaign on the Campaign List page.

This opens up the Campaign Edit page.

1. Enter in a Campaign Name, such as "Christmas Campaign" or "Back to School Sale."

2. Enter in anyComments as notes about the Campaign.

3. Enter in a date directly (or click on the Calendar icon to select a date) and time into the Available From

field. This will indicate when the Campaign is expected to start.

4. Enter in a date and time in the Expires On field.

5. Select the Target Segments from the list. Target segments are created under the Customer Segments

section

6. Indicate whether or not the Campaign is Active, "Yes" or "No."

7. Indicate whether or not to Archive the Campaign, "Yes" or "No."

8. Once done, click onOK.
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Promotions

Promotions provide a way to apply various discounts to the products, order totals or shipping. A Promotion is a

marketing tool used to increase sales of certain products or product lines. Various incentives such as lowered pric-

ing and other discounts can be employed as part of a Promotion.

Promotions are always tied to Campaigns . In addition, Promotions can be classified into two types: 1) either you

can create a promotion that is visible prior to checkout or 2) you can configure the promotion to be displayed dur-

ing the checkout process. The most powerful aspect of the Marketing system is the Expressions Engine which

allows variable conditions to be applied when creating a Promotion. These conditions vary from the number of

items, the percentage discount, shipping rates and many others.

Browsing Promotions

To view and browse Promotions, click on Promotions on the left navigation bar.
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The Promotion List page opens, displaying a list of existing Promotions.

You can click through the name of a Promotion to view its properties.

Deleting a Promotion

On the Promotion List page, checkmark the box next to the name of the Promotion and then click on More

Actions > Delete Selected on the menu bar.

Creating an Entry Level Promotion

Out of the box, users can build these Catalog Entry Promotion Types:
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l Catalog Entry: Build Your Own Discount

l Catalog Entry: Buy Catalog entry X, get catalog entry Y at a discount

l Catalog Entry: Buy X Get $ Off Discount

l Catalog Entry: Buy X, get N quantity of Y at a Discount

The following are examples of how to create each type of Promotion.

Example: Build Your Own Discount - "40% Off Canon PowerShot S5"

Once you have selected "Build Your Own Discount" from the Promotion Type drop-down menu, enter in a Pro-

motion Name, such as "40 % Off Canon PowerShot S5"

Under the Display Name section, enter in the display name for each language type.

Promotion Properties:

l Under the Campaign drop-down, select an existing Campaign created earlier

l Promotion Group is grayed out because the Promotion Type is specified

l From the Combination with other promotions drop-down, select which degree to which multiple Pro-

motions can be combined. There are two other options: "Exclusive within select groups" and "Exclusive

within all groups."

l Enter a numerical value into the Priority field (Promotions with a higher priority will be evaluated first)

l Optionally, enter in a Coupon Code that customers can redeem from the front-end public site to get

receive the discount. Otherwise, leave the field blank.

l Set the Status of the Promotion either as "Active", "Inactive," "Suspended," or "Deleted" from the drop-

down menu. Select Active to enable the Promotion.

Purchase Condition and Reward:
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Here you can set your own Purchase Condition to receive the discount Rewards . To apply a 40% discount for

Canon digital cameras, use the following settings in the screenshot.

Redemption Limits:

Under this section, you can specify the redemption limits of this Promotion.

l Next to Max. Total Redemption, enter in the maximum number of times the Promotion can be

redeemed.

l Next to Max. Redemptions Per Order, enter in the maximum number of times the Promotion can be

redeemed per customer order.

l Next to Max. Redemptions Per Customer, enter in the number of times a Promotion can be by a single

customer.

Schedule:

Enter the date and time when the Promotion is Available and when it Expires.

Click OK to save the Promotion. The Promotion will appear in the Promotion List.

When the Promotion is applied, the price on the front-end should change.
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Buy catalog entry X, get catalog entry Y at a discount

The steps to create this discount are similar to creating a custom discount. The difference is the the Purchase Con-

dition and Reward.

1. Under the Select catalog entry X drop-down menu, select a specific catalog entry.

2. Under the Select catalog entry Y drop-down menu, select another specific catalog entry.

3. Enter in a value for the Quantity of "X" needed to qualify for the promotion. For example, the cus-

tomer must purchase 2 of Catalog Entry X as a prerequisite for the discount.

4. Enter in a value for the Quantity of "Y" needed to quality for the promotion. For example, the cus-

tomer must purchase 3 of Catalog Entry Y as a prerequisite for the discount.

5. In the Amount field, enter in a number and select from the drop-down to indicate that the Promotion is

Percentage Based or Value Based. For example, if you enter 40 and select Percentage Based, the Pro-

motion will take off 40%. If Value based, it will be 40 off the total price.

Buy X Get $ Off Discount

This type of Promotion gives a discount per item by purchasing the minimum quantity specified under these Pur-

chase Conditions.

1. Enter in aMinimum quantity that the customer needs to purchase in order to receive the discount.

2. Enter in the Amount of the Promotional discount, whether Percentage Based or Value Based.

3. Select any number of Variations from the drop-down menu and click on "add variation." Repeat to add

more Variations to this Promotion. Click on the redX button next to the Variation to delete it.

Buy X, get N quantity of Y at a discount

This type of Promotion allows a customer to be eligible to buy a designated number of items at a reduced price.
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1. Select an Entry X variation from the drop-down menu and click on "add variation." (What does "Exclude"

do?)

2. Select catalog entry Y from the drop-down menu. A certain number of "Y" entries will be discounted

based on the Purchase Conditions.

3. Enter in aMax quantity Y for the maximum number of Y entries eligible for a discount.

4. Enter in the Amount of the Promotional discount, whether Percentage or Value based.

Creating an Order Level Promotion

Order Level Promotions are discounts applied if the overall Order satisfies the conditions specified by the Pro-

motion.

There are two types of Order Level Promotions available to the user:

l Order Sub Total Volume Discount - if the order subtotal minimum is met, then the customer receives

the discount

l Build Your Own Discount - can create a custom Order Level promotion based on a range of Purchase

Conditions and Rewards (similar to creating a custom catalog entry discount)

Order Sub Total Volume Discount

Enter in the Minimumorder amount into the field. For example, if the order amount was set to $200, then the

customer must have $200 or more in his shopping cart to qualify for the discount.

Enter in the Amount of the discount. It can either be "Percentage Based" or "Value Based." If Percentage Based,

then the customer gets a percentage off the price. If Value Based, the customer gets a fixed amount discounted off.

Example: Build Your Own Discount - "20% Off for a Shopping Cart Subtotal of $100 or More"

Like a custom Catalog Entry discount (add link here), users can create their own custom Order Level discount

based on a list of Purchase Conditions and Rewards. This means that there is a wide range of Order Level dis-

count possibilities.

The follow Condition and Reward example shows how to create a Promotion that gives 20% off for a shopping cart

subtotal of $100 or more.
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The discount should reflect on the shopping cart on front-end public site.

Creating a Shipping Level Promotion

Shipping Level Promotions are Promotions that give shipping discounts, such as free shipping for an order over

$50.

There are two types of Shipping Level Promotions available to the user:

l Buy X Get $ Off Shipment Discount

l Buy X Get Y Fre

Buy X Get $ Off Shipment Discount

This Promotion type applies shipping discount if the specified Variations total the MinimumQuantity set or

more.

1. Enter in aMinimumQuantity.

2. Enter in an Amount of the discount Reward, and select from the drop-down whether it is "Percentage

Based" or "Value Based."

3. Select the Variations from the drop-down list that qualify for the discount. Click on Add Variation to add

the Variation to the list.
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Buy X Get Y Free

This shipping discount allows a user to set two Catalog entries for X and Y. If X is in their shopping cart, then the

customer receives the Y item at no cost.

Customer Segments

Customer Segments determine the target audience for the Promotions or Campaigns . Customer Segments deter-

mine the target audience for the Promotions. Within a Campaign, all Promotions will be applied to whatever Cus-

tomer Segments associated with the same Campaign. Members of the Customer Segments can be pre-defined in

static groups or you can use the Expressions Engine to create dynamic groups whenever Promotions are run.

For example you can have a Customer Segment that targets all users from the Los Angeles area. You can create an

Expression that will include all the customers whose home city is Los Angeles. Thus, when a user registers on the

site he immediately becomes part of the target Customer Segment.

Creating a Customer Segment

Customer segments specify which group of Customers a user wants to specifically target with? their Campaigns.

Creating a Customer Segment Assigned to Contacts

Go to Marketing > Customer Segments.

Click onNew Segment on the menu bar to open the Segment Edit page.
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1. Enter in a Segment Name, such as "Company X Team."

2. Enter in a Display Name, which will appear to users when associating this Customer Segment when Cre-

ating a Marketing Campaign.

3. Enter in a Description.

4. Select from a list of contacts from the Members drop-down to assign them to this Customer Segment.

Select the name from the drop-down and then click add member. You can choose to Exclude member by

clicking on the checkbox and then clicking add member.

5. Once done, click OK to save the Customer Segment.
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Creating a Customer Segment with Conditions

Instead of assigning members manually to a Customer Segment, you can use Conditions to apply rules. If a cus-

tomer satisfies the Conditions, then the customer is part of the Customer Segment.

To add Conditions to the Customer Segment, click on NewCondition on the Segment Edit page. This example

will show how to specify Mediachase or Techarts emails as part of this Customer Segment.

Enter in an Expression Name, such as "Mediachase or Email Addresses."

Setup the Conditions based on the screenshot below.

Click OK to save the Conditions.
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Creating Expressions

Expressions are customizable Conditions which allow users to extend different aspects of the Marketing system --

Promotions, Customer Segments and Policies all rely on Expressions. There is an Expressions Engine which is a

core technology behind the Marketing system.

Users can create Expressions under Promotion, Segment, or Policy.

To access and create Expressions, click on Marketing > Expand Expressions > Either Pro-

motions/Segment/Policy to view the Expression List page.

To create a new Expression, click onNew Expression. The Expression Edit page appears.

In order to create an Expression, knowledge of XML is required. Non-technical users may want to skip

this section.

Enter in an Expression Name, such as "ShippingCustomDiscount."

Enter in a Description of the Expression.

Enter in the Expression Xml.
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Under Category, select from the drop-down whether this Expression is for a "Promotion," "Segment," or "Policy."

Depending on your selection, the Expression will appear under those respective folders. Click OK to save changes.

Creating Policies

Policies are rules that are always executed when Promotions are applied. Promotion policies determine whether a

conflict situation will arise when a particular promotion is applied in addition to any previously applied promotions.

If no conflict is detected, this promotion is added to the list of applicable promotions; otherwise it is eliminated

and will not be applied to the order.

Policies are the business rules on how to eliminate similar promotions for the same order or same product. Pol-

icies are preconfigured for each store. Policies can be optionally associated with one or more promotion groups.

l Local Policy - If a policy is associated with a promotion group, it is considered a local policy, and applies

only to those promotions in the group to which this policy is associated. If a policy is not associated with a

promotion group, it is considered a global policy which applies to all promotions.

This allows a Marketing manager to declare rules just once for the whole site. For example, you can create a Policy

such as this: Do not allow negative orders.

Creating Policies, like creating Expressions, is meant for advanced users. Most non-technical users will

want to skip this section.

To create a new Policy, go to Marketing > Policies to open the Policy List.
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Click onNew Policy to open the Policy Edit page.

Policy Status and Policy Is Local has not been fully implemented. Therefore, all policies will be global

(meaning it cannot be limited to a Promotion Group) until this feature becomes available in a future

release.

1. Enter in a Policy Name.

2. Enter the Status of the Policy.

3. Select "Yes" or "No" to set the Policy Is Local.

4. l Policy Is Local is No - this is the default behavior. This means that this Policy is not part of a Pro-

motion Group and is available for all Promotions.

l Policy Is Local is Yes - this means this Policy is part of a Promotion Group and is applicable only

for that Promotion Group

5. Select an existing Policy Expression from the drop-down menu.

6. Select from the Groups list to place the Policy under.

7. Click OK when done.
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Order Management

TheOrder Management systemprovides Shopping Carts, order capture, order fulfillment, and payment function sup-

port. Orders can be generated as purchases are made from the public site. Alternatively, Purchase Orders can be

manually created by a Commerce Manager user with the appropriate Roles and Permissions.

All orders, whether they were generated from the front-end site or from Commerce Manager, will appear in the

Order Management > Purchase Orders area.

Items that are in a customer's Shopping Cart will appear in the Order Management > Carts area until the order

has been completely processed, at which time the item moves from the Carts area to the Purchase Orders area.

Orders that are placed on the front-end or manually created as a Purchase Order via the Commerce Manager

appear on the front-end Account Dashboard. To access your Account Dashboard from the front-end site, click

Log In to Your Account located on the top bar.

l Purchase Orders - the manual method of generating an order for a customer (rather than having the cus-

tomer checkout and complete an order from the front-end site). It allows users to generate orders directly

from the Commerce Manager.

l Status - set to "NewOrder," "Submitted," "Processing," "Cancelled," "Rejected," "Shipped"

l Currency - select a Currency type from the drop-down menu

l Customer - select a Customer from the drop-down list of Contacts

l Billing Address - select a Billing Address from the drop-down menu

l Affiliate - select an Affiliate from the drop-down list. (Affiliates can be used when inte-

grating with other systems and can only be edited in the database. Users do not have Com-

merce Manager access for managing Affiliates).

l Tracking Number - enter in a Tracking Number of the shipment

l Expiration Date - enter in a Expiration Date for the order if this order is tied to a Recur-

ring Payment Plan for subscription-based transactions

l Parent Order Id - this can be used to relate Purchase Orders to a payment plan or other

order. When creating a Purchase Order from a Recurring Payment Plan, the Parent Order

ID is automatically associated with the Payment Plan ID.

l Line Items - you can associate actual Products/SKUs/Packages/Bundles to orders or Pur-

chase Orders

l ID - it is automatically generated

l Display Name - this can be edited and changed

l List Price - enter in the price that will appear for the item

l Discount - enter in the Discount value that will subtract from the List

Price

l Shipping Address - this is automatically generated if a Shipping Address

has already been associated with the Purchase Order

l Shipping Method - this is automatically generated if a Shipping Address

has already been associated with the Purchase Order

l Recurring Payment Plans - payments that are initiated by the Commerce Manager on a regular cycle (i.e.

applicable in a subscription-based scenario)
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l Plan Cycle - this determines the period of time that a payment plan will be initiated.

Options include: "No Cycle," "Daily Cycle," "Weekly Cycle," "Monthly Cycle," "Yearly

Cycle."

l Cycle Length - If Cycle Length = 1, then this payment plan will be initiated once a month.

If Cycle Length = 2, then this payment plan would be initiated once every 2 months.

l Max Cycle - the maximum number of cycles that this payment plan will be initiated

l Completed Cycles - this value displays the number of times that this payment plan has

been initiated.

Searching for Orders

Users can search for existing Orders made by customers on the front-end public site as well as orders created in

Commerce Manager.

To search for Orders, go to Order Management > Order Search.

Under Order Search, search fields include: Class Type, Status, Date Range, ID, and Customer. Class Type,

Status, and Date Range each have a drop-down menu to select various filter options.

Class Type Options: "Purchase Order," "Shopping Cart," "Payment Plan."

StatusOptions: "NewOrder," "Submitted," "Processing," "Cancelled," "Rejected," "Shipped"

Date Range: "All," "Today," "This Week," "This Month"

To conduct a search, click on the Search button and results based on the filters will appear in the frame below or

return no results (or null).

Search Example

Here is an example search using a "Purchase Order" Class Type , "NewOrder" Status , Date Range of "This

Week". The ID and Customer fields are left blank. The results are in the screenshot below.
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Browsing and Creating Purchase Orders

Creating Purchase Orders allows Commerce Manager users to generate orders directly from the Commerce Man-

ager. It is the manual method of generating an order for a customer (rather than having the customer checkout and

complete an order from the front-end site).

Browsing Orders

To begin generating Purchase Orders, click onOrder Management > Purchase Orders to view the Order List.

Optionally, you can click on Today, This Week, or This Month underneath Purchase Orders to filter the list

of existing Orders.

You can view the details of an existing Purchase Order by clicking on the ID number.
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Existing Purchase Orders can be deleted by clicking on the checkbox next to the ID number and then clicking on

More Actions > Delete Selected.

Creating a New Purchase Order

To create a new Purchase Order, click on Create New > New Purchase Order.

The Purchase Order New page appears.

Fields Explained

l Status - set to "NewOrder," "Submitted," "Processing," "Cancelled," "Rejected," "Shipped"

l Currency - select a Currency type from the drop-down menu
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l Customer - select a Customer from the drop-down list of Contacts

l Billing Address - select a Billing Address from the drop-down menu

l Affiliate - select an Affiliate from the drop-down list. (Affiliates can be used when integrating with other

systems and can only be edited in the database. Users do not have Commerce Manager access for managing

Affiliates).

l Tracking Number - enter in a Tracking Number of the shipment

l Expiration Date - enter in a Expiration Date for the order if this order is tied to a Recurring Payment

Plan for subscription-based transactions

l Parent Order Id - this can be used to relate Purchase Orders to a payment plan or other order. When

creating a Purchase Order from a Recurring Payment Plan, the Parent Order ID is automatically associated

with the Payment Plan ID.

On the right of the Purchase Order form is the Order Summary.

To save the Purchase Order, click onOK. The name of the Purchase Order will be based on the CustomerName.

There are tabs below the Purchase Order form to add more details including Line Items, Addresses, and Ship-

ping information.

Adding Line Items to the Purchase Order

On the bottom of the form are three tabs: Line Items, Payments, and Addresses.

Under Line Items , users can select from the drop-down menu Line Items, or items that exist in a particular cat-

alog, to add to the Purchase Order. You can enter in the keyword of the Line Item into the field and the drop-down

menu will auto-populate with items that match that keyword. For example, if you enter in "Apple," all items with

the name Apple will appear in the drop-down menu as a selection. To add the Line Item to the Purchase Order,

click on Add Line Item.

The Edit LineItem Information pop-up appears after clicking on Add Line Item.

l ID - it is automatically generated

l Display Name - this can be edited and changed
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l List Price - enter in the price that will appear for the item

l Discount - enter is the Discount value that will subtract from the List Price

l Shipping Address - This is automatically generated if a Shipping Address has already been associated with

the Purchase Order

l Shipping Method - This is automatically generated if a Shipping Address has already been associated with

the Purchase Order

Click Save Changes to add the Line Item.

Adding a Payment to the Purchase Order

Click on the Payments > New Payment in the Payments tab. The Edit Payment Information pop-up form

appears. This allows you to attach a Payment Type to the Purchase Order, such as a credit card or gift card.

Depending on your selection, the available form fields will change. The following five screenshots show the dif-

ferent forms available for each Payment Type.
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Example: Adding a Credit Card Payment to the Purchase Order

l Select the Payment Type as "Credit Card Payment."

l Select the Payment Method, either "Pay by Phone" or "Pay by Credit Card."

l Enter in a PaymentName, such as "Visa Credit Card" or "Mastercard Debit."

l Enter in the Amount to be charged.

l Enter in the Status of the Payment. Select as "Pending," "Failed," or "Processed."

l Enter in the Card Type, such as "Visa Debit."

l Enter in the Expiration Month (required field). Enter in this format: "MM."

l Enter in the Expiration Year (required field). Enter in this format: "YY."

l Enter in the Card Security Code of the card.
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l Enter in the Credit Card Number.

l Click Save Changes to attach the Payment to the Purchase Order.

Adding Addresses to a Purchase Order

Click on Addresses > New Address to add an Address to the Purchase Order. The pop-up Edit Address Infor-

mation form appears. Enter all relevant information pertaining to that customer.
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Addresses in the Addresses tab become selectable under the Billing Address drop-down menu on the Purchase

Order form. Click on Save Changes.
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Adding Shipment Information to a Purchase Order

After a Purchase Order is created and saved, the Shipments tab appear next to the Addresses tab once the user

goes back to edit the Purchase Order. Here the user can add Shipment information to the Purchase Order.

To add Shipment information to a Purchase Order, click on Shipments > New Shipment. The Edit Shipment

Information pop-up form appears.

1. Select a Shipping Method from the drop-down menu, such as "Fixed Shipping Rate" or "Ground Shipping."

Shipping Methods can be further customized under Shipping Methods within Administration.

2. Enter in the Method Name, such as "Standard Shipping."

3. Select an Address from the drop-down. Available addresses are based on the information under the

Addresses tab.

4. Enter in the Tracking Number of the package given from the Shipping Provider.

5. Enter in the Total cost of shipping.

6. Enter in the Discount (if necessary) for shipment. The value in this field will subtract from the Total cost.

For example, if the total cost of shipping is $10, and the discount is $2, then the total cost of shipping will

be $8.

7. Enter in the Status of the Shipment, any relevant information.

8. Place a check mark in the boxes next to the Items to Ship that apply to this Shipment. The items in this

form will only appear if there are Line Items already added under the Line Items tab.

9. Once done, click Save Changes.
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Sending Notifications, Calculating Totals, and Processing Payments

Within a Purchase Order, users can then send notifications to the customer, calculate the overall total of the Pur-

chase Order, and process Payments.

l To send email notifications to the Customer, click onMore Actions > Send Notifications.

l To calculate the total of the Purchase Order, click onMore Actions > Calculate Totals. The Order

Summary will change based on the charges attached to the Purchase Order.

l To process the Purchase Order, click onMore Actions > Process Payments. The order Status changes

to "Processing."

Managing Orders

Once Purchase Orders are created, either from Commerce Manager or the front-end site, they can be managed by

users. To manage existing Purchase Orders, go to Order Management and click on Purchase Orders or Pur-

chase Orders by Status.

Optionally, you can click on the filters below Purchase Orders and Purchase Orders by Status and you will be

able to filter Purchase Orders by either the time range it was created or its current status. For example, by clicking
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on Purchase Orders by Status > NewOrder, you will see Purchase Orders on the Order List that match the

NewOrder status.

To manage an existing Purchase Order, click on the associated ID number.

Users can then manage the Purchase Order and add additional information, calculate the total, process the order,

and other options.
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Creating a Recurring Payment Plan

Users can create recurring (subscription) Payment Plans that will regularly charge a customer on a daily, weekly,

monthly, yearly, or custom basis. Individual Purchase Orders can be created and linked to the Payment Plan.

To view and create Payment Plans, go to Order Management > Payment Plans (recurring) to access the Pay-

ment Plan List.

By clicking on Today, ThisWeek, This Month, you can filter the Payment Plan List based on those time ranges.

On the Payment Plan List, you can view and browse through existing Payment Plans.

To create a new Payment Plan, click on Create New > New Payment Plan .

You can also create New Payment Plans from the Order List page, Orders by Status page, or Shopping Cart

List page.

The Payment Plan New page is similar to the Purchase Order New page. The difference is that this form gives

users options to set transaction cycles based on the type of recurring Payment Plan the customer ordered or

requested. Please refer to Browsing and Creating Purchase Orders document for generational information on fill-

ing an order form.
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Creating a Daily, Weekly, Monthly, or Yearly Payment Plan Cycle

Select the Plan Cycle of the Payment Plan, such as "Monthly Cycle," "Yearly Cycle."

Let's say you choose "Monthly Cycle."

l If Cycle Length = 1, then this payment plan will be initiated once a month. If Cycle Length = 2, then this

payment plan would be initiated once every 2 months.

l Max Cycle - the maximum number of cycles that this payment plan will be initiated

l Completed Cycles - this value displays the number of times that this payment plan has been initiated

Enter in a Start Date and End Date of the Payment Plan by entering the date directly into the field or clicking on

the Calendar icon. You can enter in a custom time into the field on the right of the Calendar icon. The time

defaults to 12am.

Select either "True" (to enable) or "False" (to disable) for Is Plan Active.

Enter in the Last Transaction Date and time for the last payment transaction. Or leave blank and this will be

updated once the first payment cycle has been initiated.

Add any Line Items, Payment Types, Addresses, and Shipments (the tab appears after saving and revisiting the

Payment Plan form) to associate with the Payment Plan in the tabs below.

Click OK to save the Payment Plan.
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Creating a CustomRecurring Payment Plan

End users can ignore the custom payment plan options. To create a custom Payment Plan, a developer

will need to create a custom service and implement code to associate it with either the "Custom1 Cycle"

or "Custom2 Cycle" option shown in the drop-down.

Sending Notifications and Creating a Purchase Order from Payment Plan View

To send email notifications about the Payment Plan to the customer, click onMore Actions > Send

Notifications.
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Users can also create a Purchase Order from this Payment Plan. The Purchase Order will appear in the Order List

page; the Payment Plan will be the Parent Order ID noted in the Purchase Order View.

Viewing, Editing, and Creating Shopping Carts

As customers add items to their Shopping Cart from the front-end site, Commerce Manager users can dynamically

view all current shopping carts from the Commerce Manager.
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Under the Shopping Carts List, the Shopping Cart appears along with other active Shopping Carts (including unreg-

istered anonymous customers) that have not checked out and completed the order.

To view Shopping Carts, go to Order Management > Carts. Click on Today, This Week, or This Month to

view only Shopping Carts Last Modified within those time ranges.

The Shopping Cart List allows Commerce Manager users to view existing and active Shopping Carts.
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Editing an Existing Shopping Cart

Commerce Manager users also have the ability to edit Shopping Carts within Commerce Manager. This is useful for

completing orders manually.

To edit an existing Shopping Cart, click on the ID number of the Shopping Cart.

The Cart View page opens showing the details of the pending Shopping Cart, very similar to the Purchase Order

New form. The screenshot below shows that the Line Items represent the customer's Shopping Cart. Additional

details such as Payments, Addresses, Shipments, and Billing Address can be edited in the Cart View.
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By adding a Line Item, the Shopping Cart on the front-end site should render appropriately.

The Shopping Cart can be converted to a Purchase Order by clicking onMore Actions > Convert to Purchase

Order.
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The Purchase Order appears as aNewOrder in the Order List for further processing.

Creating a Shopping Cart

Users can also create a Shopping Cart for registered customers (it is not possible to create a Shopping Cart for

anonymous customers).

Click on Create New > New Shopping Cart to view the Shopping Cart New page.
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Enter in any Line Items , Payment Types, and Addresses to associate with the Billing Address drop-down

menu. Select the Status, Currency, Customer, and optionally an Affiliate.

Click OK when done.

To edit Shipments from the Shipments tab, go back to edit the Shopping Cart. The Shipments Tab

appears next to the Addresses tab.

The Line Items appear in the customer Shopping Cart on the front-end site.
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Reporting

Various reports are included out-of-the-box to help management and other personnel to make informed decisions.

The default reports include:

l Sales Report - this report provides an overview of a site's sales performance over a period of time

l Shipping Report - this report provides the shipping method, number of orders and total shipping cost

over a period of time

l Best Sellers Report this report is used to determine which products sold the most in terms of quantity

and total revenue over a period of time

l Low Stock Report - this report is used to determine which products are running low in inventory. If a

product's inventory is less than its reorder minimum quantity, it will be included in this report.

The display of these reports can be generated by Start and End date/time and filtered by Day/Month/Year. In addi-

tion, they can be exported to Excel or PDF format, or printed.

SQL Reporting Services

Since the Commerce Manager utilizes SQL databases, custom reports can be created usingMicrosoft SQL Server

Reporting Services. Reporting Services provides a complete, server-based platform designed to support a wide

variety of reporting needs enabling organizations to deliver relevant information where needed across the entire

enterprise. Read through the resources below to get familiarized with Reporting Services and how you can create

custom SQL reports to display data from your EPiServer Commerce site.

l Reporting Services Features

l Using SQL 2008 Reporting Services and Report Builder 2.0 to Create Custom SQL Reports

l Download Report Builder 2.0

l Reporting Services and ReportViewer Controls in Visual Studio

l Reporting Services Components and Tools

l Reporting Services Configuration How-To Topics

Generating and Customizing Reports

By default, users can generate Sales, Shipping, Best Sellers, and Low Stock Reports about the site. Reports can

be customized/filtered and exported to suit the needs of the user.

http://technet.microsoft.com/en-us/library/ms159273.aspx
http://technet.microsoft.com/en-us/library/ms159273.aspx
http://technet.microsoft.com/en-us/library/ms159273.aspx
http://www.microsoft.com/sqlserver/2008/en/us/reporting.aspx
http://www.microsoft.com/sqlserver/2008/en/us/reporting.aspx
http://www.microsoft.com/sqlserver/2008/en/us/reporting.aspx
http://www.microsoft.com/sqlserver/2008/en/us/reporting.aspx
http://www.microsoft.com/sqlserver/2008/en/us/reporting.aspx
http://www.microsoft.com/sqlserver/2008/en/us/reporting.aspx
http://www.microsoft.com/sqlserver/2008/en/us/reporting.aspx
http://www.microsoft.com/sqlserver/2008/en/us/reporting.aspx
http://www.microsoft.com/sqlserver/2008/en/us/reporting.aspx
http://www.microsoft.com/sqlserver/2008/en/us/reporting.aspx
http://www.microsoft.com/sqlserver/2008/en/us/reporting.aspx
http://www.microsoft.com/sqlserver/2008/en/us/reporting.aspx
http://www.microsoft.com/sqlserver/2008/en/us/reporting.aspx
http://www.microsoft.com/sqlserver/2008/en/us/reporting.aspx
http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=dbddc9b6-6e19-4d4b-9309-13f62901b0d5
http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=dbddc9b6-6e19-4d4b-9309-13f62901b0d5
http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=dbddc9b6-6e19-4d4b-9309-13f62901b0d5
http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=dbddc9b6-6e19-4d4b-9309-13f62901b0d5
http://technet.microsoft.com/en-us/library/ms345248.aspx
http://technet.microsoft.com/en-us/library/ms345248.aspx
http://technet.microsoft.com/en-us/library/ms345248.aspx
http://technet.microsoft.com/en-us/library/ms345248.aspx
http://technet.microsoft.com/en-us/library/ms345248.aspx
http://technet.microsoft.com/en-us/library/ms345248.aspx
http://technet.microsoft.com/en-us/library/ms345248.aspx
http://technet.microsoft.com/en-us/library/ms345248.aspx
http://technet.microsoft.com/en-us/library/ms155792.aspx
http://technet.microsoft.com/en-us/library/ms155792.aspx
http://technet.microsoft.com/en-us/library/ms155792.aspx
http://technet.microsoft.com/en-us/library/ms155792.aspx
http://technet.microsoft.com/en-us/library/ms155792.aspx
http://technet.microsoft.com/en-us/library/ms157412.aspx
http://technet.microsoft.com/en-us/library/ms157412.aspx
http://technet.microsoft.com/en-us/library/ms157412.aspx
http://technet.microsoft.com/en-us/library/ms157412.aspx
http://technet.microsoft.com/en-us/library/ms157412.aspx
http://technet.microsoft.com/en-us/library/ms157412.aspx
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To generate a report, click on Reporting > Sales > Sales Report/Shipping Report or Reporting > Products

> Best Sellers Report/Low Stock Report.

Customizing/Filtering and Exporting Reports

Users can select the Start Date and End Date ranges and time as well as group the Report data by "Day," "Month" or

"Year." Once done, click on Apply Filter.

An example Sales Report with a date range from 5/1/2010 at 6am to 6/7/2010 at 12pmGrouped By Month is in

the screenshow below.

Users can also change the zoom size of the report by clicking on the drop-down menu with "100%." Also, paging

controls are available next to the zoom drop-down menu. Users can also reload the report by clicking on the

Refresh icon.

To Export a report to a file format for sharing with others, click on the drop-down that says "Select a format."

Select a format from the drop-down menu, such as Excel or PDF. Click on Export andOpen or Save the file once

the prompt appears.

Business Foundation

It is a new generation of Meta Data Engine that allows no-code customization of the Data Model. We enhanced our

Meta Model in this new version. In the previous version you could only add fields to the existing meta objects and

now you can define new objects and relations between them.
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The form is fully customizable so you can define layout and specify which fields you want to display. You can also

work with system fields which was previously impossible.

The current implementation of Business Foundation only supports the Customer Management and Asset Man-

agement systems. Support for other subsystems such as Order and Catalog management is planned for the future.

Customizing Existing Business Objects

Out of the box, Commerce Manager includes Business Objects that can edited and customized. Customizing exist-

ing business objects is a good starting point for end users to model business objects for their needs. However,

pre-existing business objects such as "Address" and "Organization" cannot be deleted, only edited.

The current implementation of Business Foundation only supports the Customer and Asset Management

subsystems. Support for other subsystems such as Order and Catalog are planned for future releases.

Fields in the Business Foundation

This section covers how to add or edit different types of data fields within an existing business object.

Adding Fields to Business Objects

Existing Business Foundation Objects can be customized to have additional data entry fields. For example, you can

add fields to the New Credit Card form built-in to Commerce Manager.

To add new fields to Business Object, click on Administration, expand System Settings, and click on Business Foun-

dation to access the list of Business Foundation Objects.

In this example, the CreditCard Business Object is used.
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If you want to add a new field to this CreditCard Business Object (or any other Business Object), click onNew

Field.

The New Field form allows you to specify the type of data field you want created for the Business Object.

1. Enter in a Field Name, which is the system ID or name of the field. The Field Name that is entered auto-

populates the Friendly Name field.

2. Since the Friendly Name is autopopulated based on the Field Name, you can either keep the name the

same or change it. The Friendly Name is what appears on a form (such as the Credit Card form)

3. You can optionally enter in a Description that appears below the data entry field to explain the field to the

user.

4. Checkmark on or off to AllowNulls for this field

5. You can choose to Add Field To an existing Form. Checkmark all that apply.

6. Enter in a Field Type. For further explanation of each Field Type, refer to the Reference Section on the

bottom of this page. In this example, a String field type is used.



© EPiServer AB

184 | User's Guide for EPiServer Commerce 1.0

a. The Format drop down menu and options depend on your Field Type selection. In this example, Text

is selected as the field format, with aMaximumLength of 100. Unique value is left unchecked.

7. Once done, click Save. The new field appears on the list of fields.

To verify if the new field appears, check the form associated with that new field. Since this example customized the

NewCredit Card form, you will see that the new field appears.

Editing Fields of Business Objects

Fields created by the user can be edited. To edit a field, click on the Edit icon.

Fields that are locked cannot be edited.

The only attributes that can be changed are Friendly Names and Descriptions. Once those changes are made, click

Save.
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Relations in the Business Foundation

In order to track and record relevant data, business objects must be related to other objects, whether they are "1

to many," "many to 1","many to many." Currently, business objects only affect the customer and asset management

subsystems.

l 1 to Many Relationship - 1 object can be associated or related with multiple object-related data. For

example, one organization can be associated with multiple contracts.

l Many to 1 Relationship - Multiple object-related data can be associated or related with a single object.

For example, multiple contacts can be related to a single organization.

l Many to Many Relationship - Multiple object-related data can be associated or related with multiple

objects. For example, different SKUs can be associated with one or more Warehouses for tracking and

storage.

Adding a 1 to Many Relation

Business Foundation objects allow a user to specify "1 to many" relationships. For example, if you have one organ-

ization, you can relate many types of data to that organization, such as multiple contacts, addresses, or organ-

izational units or divisions within an organization. Within a 1:N relationship, the business object you selected will

be "1."

In the example below, 1 = Organization and N = related objects such as Address, Contact, CreditCard, etc.

To add a 1 to many relationship to a business object, you will need to create a new business object or use an exist-

ing one. On the Business Object Customization page, click on 1:N Relations.

Click onNew Relation "one to many" to create a new relation.

Under General Info, the Primary Object Organization is automatically set to Organization.
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1. Select a Related Object to relate an the Organization object in the dropdown.

2. The Object section below General Info will have a different title based on Related Object you selected. For

example, if you selected "Address," the title would be "Object 'Address'".

3. Enter in a Field Name and Friendly Name. They are autopopulated already using the system name of the

business object.

Both names must be unique and not be the same as an existing field. The Field Name cannot contact

spaces or special characters, only letters, numbers, and underscores.

4. Checkmark the box AllowNulls if you do not want this to be a required field the user fill in while editing a

form. Otherwise, uncheck the box to make it a required field.

5. Under Add Field To, checkmark the Forms you want the field to render in, such as the Edit Form (to

enter and submit information) or View Form (read information only).

6. Under the Object "Name of Primary Object" section, select a Display region in the dropdown box. Addi-

tional options such as Display Text and Display Order will appear based on your dropdown menu selec-

tion.

7. Once all the relevant information is entered, click on Save.

The Related Object will have the Primary Object appear under the opposite relationship (N:1) on its con-

figuration form. For instance, if organization is the Primary Object and the Related Object is Address, the

relationship is automatically generated under the N:1 tab in Address.

Adding a Many to 1 Relation

Users can also relate business objects via a "Many to 1" relationship. For example, you can relate multiple contacts

to a single organization or unit.

In the example below, N = Organization and 1 = related objects such as ParentId, PrimaryContactId etc.

To create Many to 1 relationships, click on a business object and click on the N:1 Relations tab.
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Click onNew Relation "Many to one" to create a new relationship.

The Relation N:1 form is very similar to the Relation 1:N form, except you can select the Primary Object from the

dropdown, whereas the Related Object defaults to the name of the Business Object.

Under General Info, the Primary Object Organization is automatically set to Organization.

1. Select a Primary Object to relate an the Organization object in the dropdown.The Object section below

General Info will have a different title based on the Related Object name.

2. Enter in a Field Name and Friendly Name. They are autopopulated already using the system name of the busi-

ness object.

Both names must be unique and not be the same as an existing field. The Field Name cannot contact

spaces or special characters, only letters, numbers, and underscores.

3. Checkmark the box AllowNulls if you do not want this to be a required field the user fill in while editing a

form. Otherwise, uncheck the box to make it a required field.

4. Under Add Field To, checkmark the Forms you want the field to render in, such as the Edit Form (to

enter and submit information) or View Form (read information only).

5. Under the Object "Name of Primary Object" section, select a Display region in the dropdown box. Addi-

tional options such as Display Text and Display Order will appear based on your dropdown menu selec-

tion.

6. Once all the relevant information is entered, click on Save.
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Like an 1:N relationship, if you setup a N:1 relationship with a Primary and Related Object, a 1:N rela-

tionship is automatically generated for the Primary Object under the 1:N tab.

Adding a Many to Many Relation

Users can also create Many to Many relationships with business objects. For example, many to many relationships

help to track different SKUs and their inventory levels with different warehouse locations. Another example is mul-

tiple contacts a part of multiple organizations. A Many to Many relationship between two objects is also referred to

as a Bridge.

In the example both Organization and Organization_Contact = N.

To create aMany to Many relationship, click on a business object and then click on the N:N Relations tab.

Click onNew Relation "many to many" to create a new N:N relationship.
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The Relation N:N is much different compared to the Relation 1:N/N:1 forms.

The Current Object defaults to the name of the Business Object you are editing

Select a Related Object from the dropdown menu

The Relation Name is autopopulated by (Current Object Name_Related Object Name). Change this name if you

wish, but you cannot have spaces or special characters, only letters, numbers, and underscores.

Enter in a Friendly Name , which can have special characters and spaces. Make sure both Relation and Friendly

Names are unique do not already exist.

Under Current Object, select a Display Region where the field will appear

Under Related Object, select a Display Region where the field will appear

Once all the relevant information is entered, click on Save.

A many to many relationship is automatically generated for the related object when you click on its N:N

tab under its configuration form.
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Forms in the Business Foundation

Forms dictate how fields are presented to the user when view and editing information. This section shows you can

customize forms for viewing and editing by end users.

Customizing an Existing Form

Every field is associated with a Form. Each Business Object is associated with one or more types of forms. The com-

mon types of forms found in Commerce Manager are the Edit Forms, Short Info Forms , and View Forms . For

example, the New Credit Card form looks like this:

By editing the form, you can change the layout, add new fields and sections, and more.

To edit an existing form, click on a Business Object and click on the Forms tab to see the list of associated forms.

Click on the Edit icon next to the form you want to make changes to. The form customization window pops up.
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There are various functions available to edit and customize a form.

Editing the Layout of a Form

You can change the layout and the fields that appear on the form.

1. Click on Edit Form.

a. Select a View Type (or the layout of the form). You have a choice between a Two Column (1:1, 1:2,

2:1), or Three Column (1:1:1) layout.

b. Enter in a pixel value for the Cell Padding, or spaces between each cell.

2. Click Save to confirm your changes.

This example uses a Two Column (1:1) layout.

Adding Sections and Fields

Once your layout is set, you can add additional sections and/or additional fields.

1. Click on Add --> Add Section to add a new section. Adding sections allows you to separate and divide

groups of fields on a form with their own header and border.

2. Enter in a Title for the section.

3. Checkmark the box next to "Show border line for this section" if you want to show the border around sec-

tion. Otherwise, uncheck the box to hide the border.

4. Checkmark "Show the name of this section on the form" if you want to show the title of the section on the

form. Otherwise, uncheck the box to hide the title.

5. Select a View Type or layout of the section: One Column, Two Columns (1:1), Two Columns (1:2), Two

Columns (2:1)

6. Enter a numeric pixel value for Cell Padding or amount of space between each cell in the section.

7. Click Save to save your changes.
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You can edit a section by clicking on a section and click on Edit.

Within each section are fields. You can add new fields to a specific section by highlighting the section and then by

clicking Add --> Edit.
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Select an existing associated field in the dropdown menu.

a. Checkmark the "Field is Read Only" box if you want the field to be unavailable for edit. When you see the ren-

dered form, the field will be grayed out.

1. Select the "Item label showing on the form."

2. l Hide Label:No label appears next to the text box

l System Label: Shows the system name next text box

l Custom Label: Enter in a custom label

3. Enter in a LabelWidth numerical value. Default is 120px.

4. Tab Index: enter an index for the tab.

5. Select a View Type, either a One Column or Two Column. In the dropdown, enter in the number of text

box rows, up to 3.

6. Click Save to add the field to the section.
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To edit a field, click and highlight the field and click on Edit to change your previous settings.

You can re-arrange fields on a form but using the arrow controls on menu bar. Highlight the field and then click on

the directional arrow you want the field to move to.
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In this example, the "Security Code" field is moved to the right where the "Customer Service Phone Number" field

is placed by clicking on the right directional arrow. Fields are moved from cell to cell within a section.

Deleting Sections and Fields

To delete a section or field, highlight either one and click on Remove. A popup will appear. Click OK to confirm

deletion. Otherwise, click Cancel.
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Recreating a Form

Recreating a form allows a user to create a form from scratch with a single field rather than customize a form with

all fields already in place. Click on Recreate Form on the upper right corner of the window.

A popup will appear. Click onOK to recreate the form. Otherwise, click Cancel. Once you confirm, the fields will

clear from the form except for the required field.

Saving a Customized Form

Once you are done with your changes, click on Save on the upper right corner of the window. To save and close

the window at the same time, click the down-arrow next on the Save button and on the dropdown click Save and

close.
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Once those changes are saved, the form you edited will render based on your configuration. For example, here is

the customized Credit Card edit form an end user sees.

Creating a New Business Object

Creating new business objects allows users to extend customer and asset forms for tracking and relating different

types of data. Business Objects could be related in a "one to many," "many to one," or "many to many" relationship.

This section covers an example of how to create and publish a Contract business object using a "many to one" rela-

tionship.

Scenario - Creating and Publishing a Contract Business Object

This is a basic step-by-step guide on how to create and publish a simple Contract Business Object for relating mul-

tiple contracts to a single organization.

Creating a New Contract Object

New Business Objects can be created to suits a multitude of business purposes. This example shows you how to

create a Contract business object.

To add new fields to Business Object, click on Administration, expand System Settings, and click on Business

Foundation to access the Business Foundation Configuration page.
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Click on Create New and on the dropdown click on New Business Object. The New Business Object form

page appears. Enter all relevant information.

Base Info

l SystemName: name of the Business Object (once you input a name, the Friendly Name and Plural Name

fields are autopopulated)

l Friendly Name: alternative to the System Name

l Plural Name: plural version of the system/friendly name (e.g. inventories)

l Supports Extensions: this allows you to extend an existing meta class with extra properties. For exam-

ple, you can have a download class and you can extend it with "imagedownload" which contains width and

height as extra parameters.

Field Info

l SystemName: enter in a system name

l Friendly Name: enter in a friendly, front-end name

l MaximumLength: maximum number of characters allowed in this field

Click Save to save changes.
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Add fields to the Contract business object as needed. Refer to Adding New Fields to Business Object section

for instructions on how to add new fields to a business object.

Click Save to save changes.

Connecting a Contract to an Organization Using a "Many to One" Relationship

The next step is to create a relationship between this contract with an organization. In this example, the "Many to

one" relationship will be used because multiple contracts can be tied to a single organization.

1. To add a relationship, click on the N:1 tab and click New Relation "Many to one" .

2. On the Relation N:1 form, select the primary object as "Organization." The Related Object will be the Contract

object (the friendly name appears as opposed to the system name)

3. Enter in a Field Name, such as "Organization."

4. Enter in a Friendly Name that will render next to the field in a user view.

a. Checkmark the box next to Allow Nulls if you want the user to be able to submit the form without having to

enter any data into the field. Otherwise, an unchecking this box means that this becomes a required field that the

user must enter data in.

5. Checkmark the boxes you want the field to render in, such as the Edit Form, View Form, and Short Info Form.

To learn more about forms, go to Customizing an Existing Form.

6. Lastly, set the Display Region using the dropdown menu. The display region determines which section the field

will appear within the business object--in this case, the Organization object. Note: Depending on your selection,

you may have additional options below the dropdown menu, such as Display Text and Display Order. An exam-

ple is below.

7. Click Save to save your changes and go back to the Business Object Customization form.
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So now that the Organization business object is tied to Contract, you will see that Contract now appears under

the Information section or the Organization Info view page.

Since this example ties many contracts to a single organization, the organization business object is auto-

matically related to the contracts object as a "1:N" relationship.
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Publishing a Contract

Another feature of Business Foundation is the ability to publish objects within the left navigation frame as a node.

You can essentially add more functionality to a specific subsystem without modifying code.

Now that the Contract object has been created and related to another object, you can publish it as a node.

To publish a business object, click on Publish under the Business Object Customization form.

A new window will pop up for publication settings.
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1. Select a Display Region from the navigation three on the left. Click on the node you want Contract to be

placed under. For example, Contract will be placed on the root level of Customer Management.

2. The Display Text defaults to the system name of the Business Object. You can choose to keep the name

or change it.

3. The Display Order defaults to 10000. You can keep it at that number or change the value to determine the

position of the node.

4. The Client Script is autopopulated and can be left as is for most users. However, you can change Client

Script if necessary.

5. Access Permissions is autopopulated and can also be left as is. If you want to change Access Permissions,

refer to the Permissions section.

6. An Item Icon can be uploaded to represent the node. Click Browse to upload an icon.

7. Once all relevant information is entered, click on Publish.

To verify if the object was published, go to the Display Region where you specified the object to be published to.

Click on the refresh icon on the left navigation frame if you at first do not see the new node.

Always refresh your browser after publishing a business object.

Adding Contracts to an Organization

Now that the contract business object has been published, you can add multiple contracts to a single organization

using a form. Click on the Contract node to bring up the list of contracts. Click onNew to add a new contract.

Enter in a Contract Name (friendly name of the contract object) and select an Organization from the dropdown

menu to associate the contract with. This functionality is in harmony with the "N:1" relationship between contract

and organization.
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Click OK to save the contract. The View Form appears.

To learn how to edit forms, go to the Customizing and Existing Form section.

You can make further edits to the details of the Contract by clicking Edit or delete the entry. Otherwise, click on

Back to list to go back to the list of contracts.

By going to the Organization Info page for the particular organization you assigned multiple contracts to, you will

see the list contracts you assigned.

You may need to make sure the Display Region is set for the related object (i.e. organization) or else

you will not see the business object in the Edit Form.
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Publishing Business Objects

A user-created business object can be published as a node anywhere in the left navigation frame to extend func-

tionality under that particular subsystem.

You must refresh your browser after a business object has been published.

Permissions

When publishing Business Objects to place on a node on the left Navigation Frame , you can set permissions

before publishing a Business Object.

Click on Publish on the Business Object Customization page.

You can set permissions by customizing Access Permissions. This string is auto-generated. To change, you can

copy and paste string values from other objects.
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Deleting Published Business Objects

Once a business object has been published, you can delete all customized business object by going to Admin-

istration > System Settings > Business Foundation . To remove from the Left Menu, you have to perform an

additional step of going to Administration > System Settings > Left Menu and clicking the Delete icon.
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EPiServer Commerce Sample Site

The EPiServer Commerce sample site provides a set of demo templates to illustrate the functionality of EPiServer

Commerce. The sample template package is intended to be used as inspiration when you build your own e-com-

merce site based on EPiServer Commerce. In the following the templates included in the package are described in

more detail, explaining the possibilities with EPiServer Commerce to both developers and end-users. The sample

site provides an entrance to the world of e-commerce with EPiServer Commerce.

Importing the Display Templates

To be able to display different products on the e-commerce site you need to define the display templates to be

used. These can be different for different language groups on the site. Importing display templates is done under

Administration in Commerce Manager. Normally the templates are set up during installation, but you may want to

add new templates or modify existing ones.

In this example we describe how you import the three display templates used in the EPiServer Commerce sample

site.
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Do the following to import the Digital Camera display template:

1. In Commerce Manager, select Administration, System Settings, Sites, Site Templates and then Eng-

lish (United States).

2. In the Name field, enter "DigitalCameraTemplate".

3. In the Friendly Name field, enter "Digital Camera".

4. In the Type field, enter "entry".

5. In the Path field, add the path:

~/T-

emplates/Ev-

erything/BusinessControls/CatalogBrowseControls/EntryTemplates/DigitalCameraTemplate.ascx

Repeat the procedure for the other templates, and use the following settings:

Node Info Template
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l Name:NodeInfoTemplate

l Friendly Name:Node Info Template

l Type: node

l Path: ~/Templates/Everything/BusinessControls/CatalogBrowseControls/NodeTemplates/NodeInfo.ascx

Entries Template

l Name: EntriesTemplate

l Friendly Name: EntriesTemplate

l Type: node

l Path:

~/Templates/Everything/BusinessControls/CatalogBrowseControls/NodeTemplates/EntriesFiltered.ascx

Importing the Sample Catalog

The product catalog contains information regarding brands and sales items. This information will either be displayed

in the public site, or used for pricing and promotions. Product catalogs needs to be imported into EPiServer Com-

merce. There are different ways of doing this, and in this example we describe how you import the sample catalog

used in the sample site, using the import/export function in Commerce Manager. When product catalogs have been

imported, they also need to be indexed, in order for the product search function to incorporate any changes.

Additional information on how to import product catalogs can be found in the Catalog Management section.

Import the Sample Catalogs

The sample site includes two product catalogs providing the "everything" and the "brand" view.

1. In Commerce Manager, select Catalog Management and then Catalogs.

2. Click on Import/Export and then Import Catalog, this takes you to the Import Catalog screen.

3. Select "CatalogExport-BG2C-Everything.zip" and click Start Import.
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4. When the import has completed, click Close Window.

5. Select "CatalogExport-B2C-Brands.zip" and click Start Import.

6. When the import has completed, click Close Window.

Indexing the Sample Catalog

After importing a product catalog, at also needs to be indexed.

1. In Commerce Manager, select Administration, System Settings and then Search Index.

2. Click Rebuild Index to index the catalog for the first time. The Build Index option is used for future

updates when you import the same catalog again and only want to index the changes.
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Page Templates

The EPiServer Commerce product package is based on EPiServer CMS for managing content, and the e-commerce

module Commerce Manager. The EPiServer Commerce package includes a sample website with a set of display

templates. The page templates provide an example of how you can work with EPiServer Commerce to create your

own web publishing and online store platform. Use the page templates as inspiration and adapt them to your own

online store environment.

The sample site contains sample product data stored in a product database. The template package in EPiServer CMS

contains a set of templates for displaying content and providing other typical e-commerce functions. The "engine"

behind it all is the Commerce Manager module, driving the purchasing procedure in the background.

The templates, fields and functions described in this documentation refers to a "standard installation" of

an EPiServer Commerce sample site. The standard functions and fields of EPiServer CMS are not

described here. Please refer to the EPiServer CMS documentation for editors and administrators available

on world.episerver.com.

The Page Tree Structure

When installing the EPiServer Commerce package with a sample site, a number of pages will be created and dis-

played in a specific structure in the page tree. Some of them will show editorial content. Other pages are used as

containers for other pages These will not display any content of their own and will be hidden in navigation menus.
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The Start page is built using the Home page type. The Start page

contains numerous settings affecting the entire website, for instance

top menus, search and login. This is also where you define pages to

be used for shopping carts, payments and checkout.

Editorial content pages are most often based on the page type

Standard Page. These are the pages where editors can create and

edit content the usual way in EPiServer CMS. Examples of editorial

content are the pages under the sections News, Get the Product

and More Support.

The pages under the Products section, are based on a page type

called Product Listing . These pages will provide the top menu of

the website, based on what is listed under the Products page. The

sort order of the Products page controls the order in which the

menu items will be displayed.

The [Function Pages] section of the tree holds the display template

for a number of typical functions such as My Account, My Cart, Wish

List, Payment and Checkout. These have their own specific page

types linking to functions in the Commerce Manager module.

The [Resources] section resides directly under the root page of the

site. This part is used for the actual linking to the product catalog in

Commerce Manager. The pages are based on the Product Listings

page type and do not display any content.

Start Page

The Start page is based on the Home page type and is normally defined when the website is installed. The page

holds a number of settings with references to other pages on the website. The start page will most likely not be

touched very often after the setup, but occasionally references pointing to pages defined here may need to be

changed.

When you open the Start page for editing in Edit mode, you will find that the Start page itself does not have an

editorial area, since the content displayed is made up of different types of listings. In addition to the standard tabs of

EPiServer CMS, the Start page has a tab containing specific site configuration property settings.

Content Tab

Below are the properties that can be changed in Edit mode under the Content tab of the Start page.

Name

The name of the page, as displayed in the page tree.
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Fetch News list from

Defines the container page for the news item listing to be displayed in the mid-left information area of the start

page.

Images

The start page has a top banner image. The image area has functionality for altering between a set of two images

which can be defined here. Define images in the fields Image 1/Image 2 to be displayed in the top banner area of

the start page. Select images in the EPiServer CMS file manager.

Links

In the fields Link 1/Link 2 you can define links for each of the altering top banner images on the start page using

the EPiServer CMS link dialog. The link will take the visitor to the specified URL when clicking on the top image of

the start page.

Site Configuration Tab

The settings that are available under the Site Configuration tab when you edit the Start page, are common web-

site configuration items that are defined as properties on the start page and will be inherited to the sub-pages. Most

often these settings are defined when the website is installed but it may be necessary to update them at some point.

Note that the function pages must be created first before defining them on the start page.
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Open the Start page for editing in Edit mode, to change the settings for the different properties. Save and publish

the page to update the settings.

Login page

Defines the login page to be used when visitors log in to the website. The login page itself has settings to define the

account register and password recovery pages. Select the login page in the page tree structure to define it for the

website.

Display top menus from

In this field you configure the menu at the very top of the website. In this example the menu contains functions My

Account, My Cart and Wish, as well as Log in/out and the language and currency selector.

Links to the login page and the language selector will be displayed by default, but the other options are listed from

the container page defined here. In this example, the container page is the page [Function Pages]. Under this page

you create the other function pages such as My Account, Wish list etc.

The order in which they are presented in the menu is set by the sort order of the [Function Pages] container page.

Pages that are set not to be visible in menus, will not appear. Select the page in the page tree structure to define it.
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Display menus from

Displays themain navigation menu of the website.

In this example, this information is collected from a container page named Products, which itself is not displayed in

menus. The sub-pages consists of a number of selected product pages based on page type Product Listing. The

order in which the pages are displayed in the menu is controlled by the sort order for the Product parent page,

which in this case is set to be sorted according to sort index. Select the page in the page tree structure to define it.

Display bottom menus from

The start page contains a bottom section listing pages in five columns. The Display bottom menus from field

defines from where the page listing will be fetched. In this example the listing will display pages and their one-level

sub-pages under the start page. All pages will be listed except those that are set not to be displayed in menus.
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In this example, the bottom menu listing will start with "Buyers guide", to be followed by "About us", "Our serv-

ices" etc. Note that the listing will go from left to right to fill the columns. The order is controlled by the sort

order of the start page, which is set to be sorted according to sort index in this case. The number of columns can

be changed programatically in the ColumnCount property, default and maximum value is five. For additional infor-

mation on this, please refer to the technical documentation for EPiServer Commerce available on world.epi-

server.com.

In the Display bottommenus from field, select the page in the page tree structure to define it.

Account page

This setting defines the Account Dashboard page to be used. This page displays a snapshot of recent account activ-

ities for a customer, and also provides possibility to update account information. Select the page in the page tree

structure.

Address book page

This setting defines the address book page to be used when displaying a customers address information. Select the

page in the page tree structure.

Account edit page

This setting defines the account edit page to be used when displaying a customers account details. Select the page in

the page tree structure.

Search page

This setting defines the search page to be used on the website. Select the page in the page tree structure.

Product page

This setting defines the product page to be used when displaying details for a particular product. Select the page in

the page tree structure to define it for the website. If you are using the EPiServer Commerce catalog page provider,

the property setting here can be ignored.

Wish list page

This setting defines the wish list page to be used when displaying a customers wish list. Select the page in the page

tree structure.

Shopping cart page

The page to be used when displaying a shopping cart. Select the page in the page tree structure.
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Check out page

The page to be used when displaying the check out page for a customer. Select the page in the page tree structure.

DIBS Payment page

The page to be used when displaying a DIBS payment page. The page will process a DIBS payment through the DIBS

payment gateway, which is used on the EPiServer Commerce sample site.There are many other payment gateways,

and you may have a different payment solution in your implementation. Select the page in the page tree structure to

set the payment page to be used.

Order history page

The page to be used when displaying the order history page for a customer. Select the page in the page tree struc-

ture.

Compare products page

This setting defines the page to be used when comparing products. This page provides functionality for displaying

selected products next to each other for comparison. Select the page in the page tree structure.

Product compare page: page to compare products.

Allow empty columns

Check this field to allow empty columns to be displayed in the footer menu, in case a menu item does not have any

sub-pages.

The different pages and page types are described in other sections of this documentation.

Standard Page

The page type Standard Page in EPiServer Commerce is used for creating ordinary information pages. It will also
function as container page for holding pages of other page types, used for instance in listings. The Standard Page in

EPiServer Commerce sample site has one additional field in comparison with a standard page in an ordinary EPiS-

erver CMS sample site. This is the Fetch left menu listing from field, which allows editors to define which pages

should be displayed in the left menu listing.

Select a page in the page tree from which to display the left side menu listing. If nothing is selected here, the left col-

umn will be empty.
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Product Listing

The page type Product Listing is used for listing product information from the product catalog in Commerce Man-

ager. The listing will be fetched from the selected product category (node) in the product catalog, for instance dig-

ital cameras as in this example. The listing will display a short product description with price as well as an image, for

each of the products. There are four products listed side by side in a row.

The page functionality will also include a product compare option as well as an Add to Cartbutton for each prod-

uct in the list. The product listings will appear when a visitor clicks on a product in the top menu. The listing will dis-

play 20 products at the time as default, and the listing can be sorted according to product name and price. The left

column will display related product information, depending on the selected product category.
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To define a product listing, create a page based on the page type Product Listing and select the desired product

category (node) in the Catalog node name field. The categories (nodes) available here are collected from the

[Resources] section in the page tree structure which is set up at installation. This in turn reflects what is defined in

the product catalog in Commerce Manager.

Products Compare

The Products Compare page type holds functionality for displaying selected products for comparison. The cus-
tomer selects the desired products by marking the check box next to each product, an then clicks

theCompareoption.

The selected products are listed next to each other together with related product features, for easy overview and

comparison. A product can be removed from the comparison list, or added to the shopping cart or the wish

list.The selected products will remain for display on the compared products page until they are removed or a new

product selection is done by the customer.
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The Products Compare page type holds no information of its own so it has no editor field. When the product

compare page has been created, it will be defined in the site configuration setting of the start page.

Function Pages

Function pages is a collection of pages holding typical e-commerce functionality such as account, shopping cart,

check out and payment information. These features are personal and connected to a specific customer account. The

function pages also include general features such as login, search and registration.

My Account Pages

In the sample site, the account information is gathered under the My Account page under the [Function Pages]
branch of the page tree. The My Account page is a container page holding a number of sub-pages.
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These sub-pages are based on specific page types with functionality for extracting personal customer information

from the customer management part of Commerce Manager. The page types hold no editorial information of thier

own. After they have been created they will be defined in the site configuration setting of the start page.

Account Dashboard

The Account Dashboard page type provides an overview of the personal account information collected from var-

ious parts of the system. Information about recent orders are displayed, together with billing and shipping address

information. Contact and password information can also be reached from here for editing. The left column dis-

playes the sub-pages under the My Account container page.

When created, the Account Dashboard page is defined in the site configuration setting of the start page.

Account Information

From the Account Information page type a customer can update the user name, e-mail address and password for
the account.
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When created, the Account Information page is defined in the site configuration setting of the start page.

Account My Orders

The purpose of the Account My Orders page type is to display the order history for an account. The information
is collected from the customer management part of Commerce Manager.
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When created, the Account My Orders page is defined in the site configuration setting of the start page.

Account Address Book

The Account Address Book page type holds functionality for displaying and updating address information for an
account. The information is collected from the customer management part of Commerce Manager.

When created, the Account Address Book page is defined in the site configuration setting of the start page.

Check Out

The purpose of the Check Outpage type is to display the steps of the check out procedure when a customers

wants to finalize a purchase.The check out procedure is initiated when the customer selects the Proceed to

checkout option for instance from the Shopping Cart view. The functionality of the page is linked to the payment

and shipping options defined in Commerce Manager.

The checkout procedure may look different depending on payment and shipping options defined in the system. In

this example the checkout procedure has four steps: Shipping Address, Shipping Options, Payment Options and

Order Confirmation.
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Step 1: Shipping Address

The customer enters name, address and contact details, if these are not already registered in the system. If they are,

there will be an option to update the existing information. Clicking on Proceed To Shipping Options will take

the customer to step two in the process.

Step 2: Shipping Options
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The customer selects the desired shipping options. The contact details from the previous step are displayed in the

left column, and there is a possibility to back to the previous step to update any information. Clicking on Proceed

To Payment will take the customer to step three in the process.

Step 3: Payment Options

The customer enters the billing address, if this is not already in the system. The desired payment option is selected.

Here there is a possibility to back to the previous steps. Clicking on Review & Place Order will take the cus-

tomer to step four in the process.
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Step 4: Order Confirmation

Step four provides a possibility to review the order details including pricing information before the order is sub-

mitted. Details from previous steps are displayed with the possibility to back to previous steps. Clicking on Place

Order will submit the order to the system and initiate the order management procedures.

The Check Out page is created in Edit mode and then defined in the site configuration setting of the start page.

DIBS Payment Services Function

The EPiServer Commerce sample site has an example function for managing payment services using the DIBS stand-

ard payment method with credit card. When the order is placed and confirmed, the procedure will continue

with the payment. If the selected payment option is "Payment By Card DIBS" in step 3 of the checkout procedure,

the DIBS payment function will be activated to carry out the payment procedure.
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Selecting the desired credit card brand will allow for entering the credit card details.

Selecting Validate Payment will validate the payment. If the card details validate properly the payment will be

accepted and the process will be completed.
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To find out more about the payment process and configuration of the DIBS and other payment methods for EPiS-

erver Commerce, please refer to the technical development documentation for EPiServer Commerce.

Shopping Cart

The purpose of the Shopping Cart page type is to display product items that a customer have added to the per-

sonal shopping cart. The page also provides functionality for changing the quantity of items as well as removing

items from the list or moving them to the wish list. The Apply coupon option will apply any discount from a selec-

tion of related discount options from the system.

When the shopping cart information has been changed, clicking the Update Cart option will cause the pricing

information to be recalculated based on the new information. Clicking the Continue Shopping option takes the

customer back to the product page last visited.

General information regarding store and privacy policies are also defined on the Shopping Cartpage type for this

sample site. This information will be displayed as default links on the Shopping Cart page, to be visible before the

customer proceeds to checkout.

Open the Shopping Cart page in Edit mode to define the following:

l The Review store page. Page describing the general store policy. Create the page (page type Standard

Page) and select it in the page tree.

l The Return and exchange policy page. Page describing the general return and exchange policy. Create

the page (page type Standard Page) and select it in the page tree.

l The Privacy page. Page describing the general privacy policy for personal information stored on the site.

Create the page (page type Standard Page) and select it in the page tree.
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When created, the Shopping Cart page is defined in the site configuration setting of the start page.

Wish List

TheWish Listpage functionality displays product items in a personal wish list for a customer. The items are added

to the list when the customer clicks on theWish List option for a product.

The wish list itself is accessed when clicking on theWish List option in the menu on the very top of the page.
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When created, theWish List page is defined in the site configuration setting of the start page.

Login

The purpose of the Login page is to provide a login possibility for registered customers of the e-commerce web-

site. The user provides a user name or e-mail address as well as a password, and then clicks Log in . When the

login details are accepted the user is taken to the Account Dashboard displaying an overview of the current

account information.

The Loginpage also has functionality for password recovery. When clicking on the Forgot your password?

option, the user will be taken to the Forgot Password page of the website.

The Login page is also the entrance for new registration of new customers to the site. Clicking on the Create a

New account will take the user to the Register page of the website, for creation of a new account.
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When opening the Login page in Edit mode, you can define the Password recovery page and the Register page

by selecting the appropriate pages in the page tree structure. Naturally these pages must be created before you can

configure them here.

When created, the Login page is defined in the site configuration setting of the start page.
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Register

The Register page type provides the possibility to create new customer accounts on the website. Personal and

login information such as name, e-mail and password is entered by the user, and by clicking Register the account is

created and the account details are saved in the customer database of Commerce Manager. Later on additional infor-

mation such as billing and shipping address can be added.

When created in Edit mode, the Register page is defined in the Login page of the website.

Search

The Search pagepage type is used for displaying the results of a product search performed on the website. The

matching search hits are shown in a listing with rows of four product items. Product details are displayed, with the

possibility to add items to the shopping cart, or select items for comparison. The number of matching hits listed on

a search result page can be customized. Clicking on an item will display the full product information page.
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In Edit mode, the following properties are set in the Search page page type:

l The Start page for the search. Select a page in the page tree to define where the search should begin,

often this will be the start page of the website.

l The Number of items in a search result page. Set a number to define the number of matching hits listed

on a search result page.

When created, the Search page is defined in the site configuration setting of the start page.



© EPiServer AB

EPiServer Commerce Sample Site | 233

Payment

The purpose of the Payment page is to link to the appropriate payment procedure when finalizing a purchase in

the checkout process. There are many different payment methods to use in different markets, and the payment gate-

ways of e-commerce websites are often parts that are highly customized. For this sample site, the commonly used

DIBS payment method is used here.

Paymentmethods are set up under application configuration for payment gateways in Commerce Manager. The Pay-
ment page functionality is linked to the corresponding payment method, for instance the payment by card (DIBS)
 method. Other payment methods may be payment by phone or by credit card.

The Payment page is created in Edit mode and then defined in the site configuration setting of the start page in the

DIBS Payment page field. Several payment methods may apply on an e-commerce website.

Forgot Password

The purpose of the Forgot Password page is to provide possibility for registered users to retrieve lost pass-

words. The user will enter the e-mail address that is registered in the system to recieve a new password set by the

system.

When created in Edit mode, the Forgot Password page is defined on the Login page of the website.

Product Page

The Product Page is a central page type on this type of site, since this is used for displaying product details and

related information. The page template will display selected product information such as display name and descrip-

tion and item number, from the product catalog of Commerce Manager. This information is shown in the central

part of the page.

The rest of the page is built up displaying other information related to the product. The information is selected

based on type of product and meta data available in the product catalog. Stock status information for the product

item is displayed. From here the customer has the option to add selected numbers of the item to the shopping cart,

or to the wish list.
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The Product Page page type is linked to the information stored about the product in the product database. For

instance, information such as name, code, catalog image, and display price is collected from the Commerce Manager

product catalog.
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When created, the Product page is defined in the site configuration setting of the start page.

Gadgets in EPiServer Commerce

A gadget is a small application which can be displayed on the OnlineCenter dashboard for quick access. The Online-

Center of EPiServer CMS comes with a number of predefined gadgets, and the EPiServer Commerce sample site is

also delivered with gadgets customized for e-commerce needs and solutions. In the user documentation for EPiS-

erver OnlineCenter you can read more about gadgets and how to use them. You can also develop and customize

your own gadgets to suit your needs and the tasks you are working with. Find out more about development of gadg-

ets in the technical documentation for OnlineCenter and EPiServer CMS on world.episerver.com.

Adding Gadgets

The EPiServer Commerce sample site comes with two predefined gadgets, Commerce Orders and Commerce

Overview, providing overviews of sales, orders and activities in the online store. These are intended as examples

of the type of information you can display as gadgets on the dashboard of OnlineCenter. The same information is

also displayed on the dashboard inside Commerce manager.

In the following we will describe how to add and configure the predefined gadgets of the EPiServer Commerce sam-

ple site.
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Commerce Orders Gadget

The Commerce Orders gadget displays orders statistics in the form of a sales graph and a list of purchase orders

in a time interval of your choice.

Do the following to add and configure the Commerce Orders gadget:

1. Log on to EPiServer Commerce and select Dashboard in the right-click menu.

2. Select the Dashboard tab under which you want the gadget to appear.

3. Select Add Gadgets in top left corner of the dashboard, and then select the Commerce Orders gadget

by clicking on it in the list. The gadget will be displayed on the dashboard. By default, it will be updated to

display new data every 30 seconds.

4. To update the refresh interval, select Edit in the drop-down menu of the gadget, and enter a new time

interval. Click OK to save you changes.
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Commerce Overview Gadget

The Commerce Overview gadget shows sales data from the e-commerce system. The data is grouped by prod-

ucts, categories, orders, customers and promotions.

Do the following to add and configure the Commerce Overview gadget:

1. Log on to EPiServer Commerce and select Dashboard in the right-click menu.

2. Select the Dashboard tab under which you want the gadget to appear.

3. Select Add Gadgets in top left corner of the dashboard, and then select the Commerce Overview

gadget by clicking on it in the list. The gadget will be displayed on the dashboard. By default, it will be

updated to display new data every 30 seconds.

4. To update the refresh interval, select Edit in the drop-down menu of the gadget, and enter a new time

interval. Click OK to save you changes.

Managing the Tag Cloud

"Tags" are words describing the content of a website. A "tag cloud" is a visual depiction of tags on the site. In a tag

cloud the importance of a word is shown with font size or color. Tags are also hyperlinks , and clicking on a tag

will display content marked with that particular tag.

The tag cloud in EPiServer Commerce is a search tag cloud generated by users when searching for an item on the

site. The more popular a search phrase is the more highlighted it will be in the search tag cloud. The search tag

cloud on the sample site is displayed under the "Popular searches" part of the mid-section of the start page.

The EPiServer Commerce sample site comes with a tag cloud plugin for managing the tag cloud. This is accessed

from the ActionWindow of EPiServer CMS. From the Tag Cloud Management section in the Action Window,

you can manage the tag cloud list items, and perform tasks such as updating the name and hit count for a tag, or

delete a tag.
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Listing tag cloud items

1. In EPiServer CMS Edit mode, open the ActionWindow.

2. In the Action Window, click Tag Cloud Management. A list of existing tag cloud items will be displayed.

As default, 20 tags will be displayed at the time in the list. Click on the paging section in the footer of the list to navi-

gate to between pages of the list.

Sorting the tag cloud list

The tag cloud list can be sorted by tag name or by hit count. Click column headers Name/Hits to sort in ascending

or descending order.

Searching for a tag

To search for an existing tag, enter part of or the full tag name, in the Search for a tag field at the top of the tag

list.

Updating a tag

To update a tag, click the Edit symbol next to the tag in the tag list. You can change the tag name and you can update

the hit count number for the tag. Click Save to update the changes. Note that each tag must have a unique name.

Deleting a tag

To delete a tag, click the Delete symbol next to the tag in the tag list. Click OK to confirm the deletion.


	Introduction
	EPiServer Commerce Platform
	Graphical Profile
	Functions and Page Templates
	Access Rights
	Editorial Content
	Store Administration
	Terminology
	Editorial Content
	Modes
	Roles
	Commerce Manager Glossary

	Prerequisites

	Getting Started
	Logging On
	Accessing the Different Modes
	Logging on to Commerce Manager

	Navigation
	Navigating in Commerce Manager
	Customizing the Dashboard and Navigating the Left Menu Frame

	Working Procedures
	Commerce Manager
	EPiServer CMS Edit mode
	EPiServer CMS Admin mode
	EPiServer OnlineCenter


	User Access and Roles
	Access Rights in Commerce Manager
	Access Rights in EPiServer CMS

	Globalization
	Specific Language Settings
	Languages for Product Catalogs

	File Management
	Commerce Manager
	Application Configuration
	System Configuration
	Adding a Left Menu Item from the Left Menu Page
	Editing, Ordering, or Deleting a Left Menu Item

	Commerce Configuration
	Using a Built-In Payment Gateway
	Setting up Payment Methods using nSoftware Provided Payment Gateways
	Editing Payment Methods
	Deleting Payment Methods
	Adding New Languages
	Adding New Countries
	Adding New Currencies
	Shipping Methods
	Customizing Shipping Methods
	Deleting Shipping Methods

	Shipping Providers
	Customizing Shipping Providers
	Deleting Shipping Providers

	Introduction
	Method 1: Configuring Taxes Manually
	Method 2: Configuring Taxes Using CSV Import
	Sample CSV Files and Example Scenarios



	Catalog Management
	Catalog and Catalog Entries
	Working with Catalogs
	Accessing the Import & Export Functions
	Importing Catalogs
	Exporting Catalogs
	Why Should I Use a CSV File?
	Import Overview
	Format for CSV Files
	Mapping Types
	Example: Importing and Setting up a New Catalog
	Prerequisite: Create a new catalog
	Step 1: Create CSV files containing data for your new entries
	Step 2: Create necessary meta fields for the new catalog entries
	Step 3: Upload the CSV data files to the CSV Import page
	Step 4: Create a mapping file for each CSV file
	Step 5. Import the CSV files and their corresponding mapping files into a spe...
	Step 6. Verify Your Import


	Categories and Nodes
	Menu Bar Functions
	Overview Fields
	SEO
	Assets

	Products, Variations and SKUs, Bundles, Packages, Dynamic Packages and Associ...
	Overview Tab
	Variations/SKU Tab
	SEO Tab
	Associations Tab

	Assets Tab
	Overview Tab
	Variations/SKU Tab
	SEO Tab
	Associations Tab
	Assets Tab
	Overview Tab
	Pricing/Inventory Tab
	SEO Tab
	Associations Tab
	Assets Tab
	Overview Tab
	Pricing/Inventory Tab
	Package Items Tab
	SEO Tab
	Associations Tab
	Assets Tab
	Overview Tab
	Bundle Items Tab
	SEO Tab
	Associations Tab
	Assets Tab
	Overview Tab
	Package Items Tab
	SEO Tab
	Associations Tab
	Assets Tab

	Managing Assets
	Searching for Entries in Your Catalog
	Updating Multiple Catalog Entries at Once

	Asset Management
	Browsing, Editing, and Deleting Folders and Assets
	Creating Folders and Uploading Files (Assets)

	Customer Management
	Organizations
	Viewing Organization Details
	Searching for Organizations
	Printing a List of Organizations
	Example View Filter Setups
	Example 1: Creating a View to Only Show Organizations that Match a Business C...
	Applying and Editing a View

	Example 2: Creating a View to Display Companies with Specific Business Catego...
	Example 3: Creating a View to Display Companies with Specific Business Catego...

	Contacts
	Viewing Detailed Contact Information
	Searching for Contacts
	Generating a Printer Friendly List of Contacts
	Creating a New View
	Applying and Editing a View
	Editing an Account, Changing an Account Password, and Removing Accounts

	Roles and Permissions
	Creating a Role
	Editing Existing Roles
	Deleting Roles


	Dashboard
	Customizing the Dashboard

	Marketing
	Campaigns
	Promotions
	Deleting a Promotion
	Example: Build Your Own Discount - 40% Off Canon PowerShot S5
	Buy catalog entry X, get catalog entry Y at a discount
	Buy X Get $ Off Discount
	Buy X, get N quantity of Y at a discount
	Order Sub Total Volume Discount
	Example: Build Your Own Discount - 20% Off for a Shopping Cart Subtotal of ...
	Buy X Get $ Off Shipment Discount
	Buy X Get Y Free

	Customer Segments
	Creating a Customer Segment Assigned to Contacts
	Creating a Customer Segment with Conditions

	Creating Expressions
	Creating Policies

	Order Management
	Searching for Orders
	Browsing and Creating Purchase Orders
	Managing Orders
	Creating a Recurring Payment Plan
	Viewing, Editing, and Creating Shopping Carts

	Reporting
	SQL Reporting Services
	Generating and Customizing Reports

	Business Foundation
	Customizing Existing Business Objects
	Adding Fields to Business Objects
	Editing Fields of Business Objects
	Adding a 1 to Many Relation
	Adding a Many to 1 Relation
	Adding a Many to Many Relation
	Customizing an Existing Form
	Editing the Layout of a Form
	Adding Sections and Fields
	Deleting Sections and Fields
	Recreating a Form
	Saving a Customized Form


	Creating a New Business Object
	Creating a New Contract Object
	Connecting a Contract to an Organization Using a Many to One Relationship
	Publishing a Contract
	Adding Contracts to an Organization


	Publishing Business Objects


	EPiServer Commerce Sample Site
	Importing the Display Templates
	Importing the Sample Catalog
	Import the Sample Catalogs
	Indexing the Sample Catalog

	Page Templates
	The Page Tree Structure
	Start Page
	Name
	Fetch News list from
	Images
	Links
	Login page
	Display top menus from
	Display menus from
	Display bottom menus from
	Account page
	Address book page
	Account edit page
	Search page
	Product page
	Wish list page
	Shopping cart page
	Check out page
	DIBS Payment page
	Order history page
	Compare products page
	Allow empty columns

	Standard Page
	Product Listing
	Products Compare
	Function Pages
	Account Dashboard
	Account Information
	Account My Orders
	Account Address Book
	DIBS Payment Services Function


	Gadgets in EPiServer Commerce
	Adding Gadgets

	Managing the Tag Cloud
	Listing tag cloud items
	Sorting the tag cloud list
	Searching for a tag
	Updating a tag
	Deleting a tag


	Bookmarks
	Payment Gateways
	Setting Your Default Language, Currency and Units
	Creating a Catalog
	Using CSV Files to Quickly Create Custom Catalogs
	Creating a Product (including Variations and SKUs, SEO, Associations, Assets)
	Creating a Variation or a SKU
	Creating a Package
	Creating a Bundle
	Creating a Dynamic Package
	Creating an Organization Unit
	Creating and Editing Dictionary Entries
	Creating an Account
	Definitions of Roles
	Creating, Editing, and Deleting Roles
	Creating a Marketing Campaign
	Permissions
	Check Out


